• Apple, Mac, Mac OS X, and MacBook are trademarks of Apple Inc. registered in the U.S. and other countries.
• Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
• MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.
• Adobe, Adobe PDF, Adobe Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
• Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
• Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.
• HDMI, the HDMI Logo and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI Licensing LLC.

![HDMI Logo](image)

• DisplayPort and DisplayPort Compliance Logo are trademarks owned by the Video Electronics Standards Association.

![DisplayPort Logo](image)

• HDBaseT™ is a trademark of HDBaseT Alliance.

![HDBaseT Logo](image)

• DLP is a trademark of Texas Instruments.
• Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other countries and areas.
• Blu-ray is a trademark of Blu-ray Disc Association
• CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other countries.
• Ethernet is either a registered trademark or trademark of Fuji Xerox Co., Ltd.
• Other products and company names mentioned in this user’s manual may be the trademarks or registered trademarks of their respective holders.
• TOPPERS Software Licenses
  The product includes software licensed under TOPPERS License.
  For more information on each software, see “readme_English.pdf” inside the “about TOPPERS” folder on the supplied CD-ROM.

NOTES
(1) The contents of this user’s manual may not be reprinted in part or whole without permission.
(2) The contents of this user’s manual are subject to change without notice.
(3) Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable points, errors or omissions, please contact us.
(4) Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed to result from using the Projector.
Important Information

Safety Cautions

Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

**CAUTION**

To turn off main power, be sure to remove the plug from power outlet. The power outlet socket should be installed as near to the equipment as possible, and should be easily accessible.

**CAUTION**

TO PREVENT SHOCK, DO NOT OPEN THE CABINET. THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this unit has been provided. The information should be read carefully to avoid problems.

**WARNING:** TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE. DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)

This Class A digital apparatus meets all requirements of the Canadian ICES-003 Standards.

**WARNING**

This is a Class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

**CAUTION**

• In order to reduce any interference with radio and television reception use a signal cable with ferrite core attached. Use of signal cables without a ferrite core attached may cause interference with radio and television reception.
• This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the installation manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them carefully and heed all warnings.

⚠️ Installation
- Consult your dealer for information about transporting and installing the projector. Do not attempt to transport and install the projector yourself. The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
- Do not place the projector in the following conditions:
  - on an unstable cart, stand, or table.
  - near water, baths, or damp rooms.
  - in direct sunlight, near heaters, or heat radiating appliances.
  - in a dusty, smoky or steamy environment.
  - on a sheet of paper or cloth, rugs or carpets.
- Do not install and store the projector in the below circumstances. Failure to do so may cause of malfunction.
  - In powerful magnetic fields
  - In corrosive gas environment
  - Outdoors
- If you wish to have the projector installed on the ceiling:
  - Do not attempt to install the projector yourself.
  - The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
  - In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes.
  - Please consult your dealer for more information.
**Important Information**

**WARNING**
- Do not cover the lens with the lens cap or equivalent while the projector is on. Doing so can lead to melting of the cap due to the heat emitted from the light output.
- Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead to the object melting from the heat that is emitted from the light output.

Do not use the projector with it leaning to the left and right. This may result in a malfunction, however, portrait installation* is possible. Please read the warnings concerning portrait orientation before setting the projector in portrait orientation. (→ page 140)

**Fire and Shock Precautions**
- Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your projector. Allow enough space between your projector and a wall. (→ page ix)
- Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately and have the object removed by a qualified service personnel.
- Do not place any objects on top of the projector.
- Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
- The projector is designed to operate on a power supply of 200-240V AC 50/60 Hz. Ensure that your power supply fits this requirement before attempting to use your projector.
- Do not look into the light source using optical instruments (such as magnifying glasses and mirrors). Visual impairment could result.
- Do not use the malfunctioned projector. It may cause of not only electric shock or fire but also serious damage to your eye sight.
- If damage or malfunction of the projector is found, immediately stop to use it and consult your dealer for repair.
- Never disassemble, repair, and remodel by end users. If these are performed by end users, it may cause of serious problem on users’ safety.
- Consult your dealer for disposing the projector. Never disassemble the projector before disposing it.
Important Information

- Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
  - Do not use any power cord other than the one supplied with the projector.
  - Do not bend or tug the power cord excessively.
  - Do not place the power cord under the projector, or any heavy object.
  - Do not cover the power cord with other soft materials such as rugs.
  - Do not heat the power cord.
  - Do not handle the power plug with wet hands.
- Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under the following conditions:
  - When the power cord or plug is damaged or frayed.
  - If liquid has been spilled into the projector, or if it has been exposed to rain or water.
  - If the projector does not operate normally when you follow the instructions described in this user’s manual.
  - If the projector has been dropped or the cabinet has been damaged.
  - If the projector exhibits a distinct change in performance, indicating a need for service.
- Disconnect the power cord and any other cables before carrying the projector.
- Moving the projector requires four people or more. Be sure to firmly grip the front and back handles, then move the projector.
- Turn off the projector and unplug the power cord before cleaning the cabinet.
- Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
- When using a LAN cable:
  
  For safety, do not connect to the terminal for peripheral device wiring that might have excessive voltage.

⚠️ CAUTION

- Keep hands away from the lens mounting portion while the lens shift is in operation. Failure to do so could result in fingers being pinched between the cabinet and lens cover.
- Do not use the level adjuster for purposes other than originally intended.
- If a safety cover (sold separately) is used, do not carry the projector by the cover. The safety cover can come off and the projector may be dropped, causing personal injury.
- Do not unplug the power cord from the wall outlet or projector when the projector is powered on. Doing so can cause damage to the AC IN terminal of the projector and (or) the prong plug of the power cord.

To turn off the AC power supply when the projector is powered on, use the projector’s main power switch, a power strip equipped with a switch, or a breaker.

Precautions when installing or replacing the lens unit sold separately (LENS CALIBRATION)

After installing or replacing the lens unit, press either the LENS CALIBRATION button on the main unit or the INFO/L-CALIB. button while pressing the CTL button on the remote control to carry out [LENS CALIBRATION]. (→ page 16, 106)

By carrying out [LENS CALIBRATION], the adjustment range of the zoom and focus of the [LENS MEMORY] is calibrated. Contact your dealer to install and replace the lens unit.

Caution on Handling the Optional Lens

When shipping the projector with the lens, remove the lens before shipping the projector. Always attach the dust cap to the lens whenever it is not mounted on the projector. The lens and the lens shift mechanism may encounter damage caused by improper handling during transportation. If you need to remove the lens unit, contact your dealer.
Remote Control Precautions

• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• Do not short, heat, or take apart batteries.
• Do not throw batteries into fire.
• If you will not be using the remote control for a long time, remove the batteries.
• Ensure that you have the batteries’ polarity (+/−) aligned correctly.
• Do not use new and old batteries together, or use different types of batteries together.
• Dispose of used batteries according to your local regulations.

Light Module

1. A light module containing multiple laser diodes is equipped in the product as the light source.
2. These laser diodes are sealed in the light module. No maintenance or service is required for the performance of the light module.
3. End user is not allowed to replace the light module.
4. Contact qualified distributor for light module replacement and further information.

Laser Safety Caution

This product is classified as Class 3R of IEC60825-1

⚠️ CAUTION

• Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.

⚠️ CAUTION – CLASS 3R LASER PRODUCT

LASER LIGHT – AVOID DIRECT EYE EXPOSURE

• Do not look into the lens while the projector is on. Serious damage to your eyes could result.

• Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause unpredictable outcome such as fire or injury to the eyes.
• When turning on the projector, ensure that nobody is facing towards the lens in the path of the light emitted from the laser.
Laser aperture and warning labels on the projector

**Important Information**

**Laser aperture and warning labels on the projector**

**Non accessible Internal Laser Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wavelength</td>
<td>462 nm</td>
</tr>
<tr>
<td>Laser power for classification</td>
<td>&lt;220 mW</td>
</tr>
<tr>
<td>Total internal laser power</td>
<td>&lt;56 W</td>
</tr>
<tr>
<td>Divergence</td>
<td>±12 - 35°</td>
</tr>
<tr>
<td>Mode of operation</td>
<td>CW</td>
</tr>
<tr>
<td>Negative modulation, due to frame rate</td>
<td>23 - 192Hz</td>
</tr>
</tbody>
</table>
About High Altitude mode

• Using the projector at highlands can shorten the life of optical components such as the light module.

About Copyright of original projected pictures:

Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and employing compression or expansion of the screen image with the following functions may raise concern about the infringement of copyrights which are protected by copyright law. [ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.
Health precautions to users viewing 3D images

Before viewing, be sure to read health care precautions that may be found in the user’s manual included with your 3D eyeglasses or your 3D compatible content such as Blu-ray Discs, video games, computer’s video files and the like. To avoid any adverse symptoms, heed the following:

• Do not use 3D eyeglasses for viewing any material other than 3D images.
• Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a distance can strain your eyes.
• Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour of viewing.
• If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D images.
• While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor.
• View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain.

Power management function

In order to keep power consumption low, the following power management functions (1) and (2) have been set when shipped from the factory. Please display the on-screen menu and change the settings (1) and (2) according to the aim of using the projector.

1. STANDBY MODE (Factory preset: NORMAL)
   • When [NORMAL] is selected for [STANDBY MODE], the following terminals and functions will not work:
     HDMI OUT terminal, Ethernet/HDBaseT Port, USB Port, LAN functions, Mail Alert function
     (→ page 122)

2. AUTO POWER OFF (Factory preset: 1 hour)
   • When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 1 hour if there is no signal received by any input or if no operation is performed.
     (→ page 123)
**Clearance for Installing the Projector**

Allow ample clearance between the projector and its surroundings as shown below. The high temperature exhaust coming out of the device may be sucked into the device again. Avoid installing the projector in a place where air movement from the HVAC is directed at the projector. Heated air from the HVAC can be taken in by the projector's intake vent. If this happens, the temperature inside the projector will rise too high causing the over-temperature protector to automatically turn off the projectors power.

- Before setting the projector in portrait orientation, please read page 140, Portrait projection (vertical orientation).

**Example 1 – If there are walls on both sides of the projector.**

![Diagram showing clearance for installing the projector with walls on both sides.](image)  

**NOTE:**
The drawing shows the proper clearance required for the front, back, and top of the projector.

**Example 2 – If there is a wall behind the projector.**

1. For floor installation:

![Diagram showing clearance for floor installation.](image)

**NOTE:**
The drawing shows the proper clearance required for the back, right, left, and top of the projector.

2. For ceiling mounting:

![Diagram showing clearance for ceiling mounting.](image)

**NOTE:**
1. The drawing shows the proper clearance required for the front, right, left, back, and bottom of the projector.
2. If suspending the projector within the range of 30 cm/12 inches away from the ceiling, allow ample clearance for all four sides and the under the projector.
# Table of Contents

## Important Information

1. Introduction ........................................................................................................................................... 1
   1 What's in the Box? ................................................................................................................................. 1
   2 Introduction to the Projector ................................................................................................................. 2
      Congratulations on Your Purchase of the Projector ............................................................................... 2
      General ................................................................................................................................................ 2
      Light source · Brightness ...................................................................................................................... 2
      Installation .......................................................................................................................................... 2
      Videos .................................................................................................................................................. 3
      Network ............................................................................................................................................... 3
      Energy-saving ....................................................................................................................................... 3
      About this user's manual ....................................................................................................................... 4

3 Part Names of the Projector ................................................................................................................... 5
   Front/Top ................................................................................................................................................ 5
   Rear ......................................................................................................................................................... 6
   Controls/Indicator Panel .......................................................................................................................... 7
   Terminals Features ................................................................................................................................ 8

4 Part Names of the Remote Control ........................................................................................................ 9
   Battery Installation ................................................................................................................................ 10
   Remote Control Precautions .................................................................................................................. 10
   Operating Range for Wireless Remote Control ..................................................................................... 11
   Using the Remote Control in Wired Operation ...................................................................................... 11

## 2. Projecting an Image (Basic Operation)

1 Flow of Projecting an Image .................................................................................................................. 12
2 Connecting Your Computer/Connecting the Power Cord .................................................................... 13
   Using the Power Cord Fixing Metal ....................................................................................................... 14
3 Turning on the Projector ........................................................................................................................ 15
   Performing Lens Calibration ................................................................................................................. 16
   Note on Startup screen (Menu Language Select screen) ..................................................................... 17
4 Selecting a Source ................................................................................................................................ 18
   Selecting the computer or video source ................................................................................................. 18
5 Adjusting the Picture Size and Position .................................................................................................. 20
   Adjustment of the projector's settings (Level adjusters) ....................................................................... 21
   Adjusting the vertical position of a projected image (Lens shift) ......................................................... 22
   Focus ..................................................................................................................................................... 24
   Zoom ..................................................................................................................................................... 24
6 Optimizing Computer Signal Automatically ........................................................................................... 25
   Adjusting the Image Using Auto Adjust .................................................................................................. 25
7 Turning off the Projector ........................................................................................................................ 26

## 3. Convenient Features

1 Stopping projection ................................................................................................................................. 28
2 Turning off the light source .................................................................................................................... 28
3 Locking the projector so it cannot be operated ....................................................................................... 28
4 Muting the Image (AV Mute) .................................................................................................................. 29
5 Turning Off the On-Screen Menu (On-Screen Mute) ............................................................................. 29
4. Multi-Screen Projection ........................................................................................................... 54

1 Things that can be done using multi-screen projection ......................................................... 54
   Case 1. Using a single projector to project two types of videos [PIP/PICTURE BY PICTURE] ................................................................. 54
   Case 2. Using four projectors (resolution: FULL HD) to project videos with a resolution of 3840 × 2160 pixels [TILING] .......................... 55
   Things to note when installing projectors ........................................................................... 57

2 Displaying Two Pictures at the Same Time .......................................................................... 58
   Projecting two screens ........................................................................................................ 59
   Switching the main display with the sub-display and vice versa .................................... 60
   Restrictions ....................................................................................................................... 61

3 Displaying a Picture Using [EDGE BLENDING] ................................................................. 62
   Setting the overlap of projection screens ........................................................................ 63
   Black Level Adjustment .................................................................................................... 66

5. Using On-Screen Menu ........................................................................................................... 68

1 Using the Menus .................................................................................................................. 68
   Menu Elements ................................................................................................................ 69

2 List of Menu Items ............................................................................................................ 70

3 Menu Descriptions & Functions [INPUT] .......................................................................... 76
   HDMI ............................................................................................................................... 76
   DisplayPort ..................................................................................................................... 76
   BNC ................................................................................................................................. 76
   BNC(CV) ......................................................................................................................... 76
   BNC(Y/C) ....................................................................................................................... 76
   COMPUTER .................................................................................................................. 76
   HDBaseT ....................................................................................................................... 76
   SLOT .............................................................................................................................. 76
   ENTRY LIST ................................................................................................................. 76
   TEST PATTERN ............................................................................................................ 76

4 Menu Descriptions & Functions [ADJUST] ........................................................................ 80
   [PICTURE] ...................................................................................................................... 80
   [IMAGE OPTIONS] ........................................................................................................ 84
5 Menu Descriptions & Functions [DISPLAY]........................................................................92
   [PIP/PICTURE BY PICTURE]......................................................................................92
   [GEOMETRIC CORRECTION]......................................................................................94
   [EDGE BLENDING]....................................................................................................98
   [MULTI SCREEN]......................................................................................................99

6 Menu Descriptions & Functions [SETUP]......................................................................101
   [MENU] ....................................................................................................................101
   [INSTALLATION]......................................................................................................103
   [CONTROL] ............................................................................................................107
   [NETWORK SETTINGS] ............................................................................................115
   [SOURCE OPTIONS] ...............................................................................................120
   [POWER OPTIONS] ..................................................................................................122
   Returning to Factory Default [RESET] ........................................................................124

7 Menu Descriptions & Functions [INFO.] .....................................................................125
   [USAGE TIME] ..........................................................................................................125
   [SOURCE(1)] ...........................................................................................................125
   [SOURCE(2)] ...........................................................................................................126
   [SOURCE(3)] ...........................................................................................................126
   [SOURCE(4)] ...........................................................................................................126
   [WIRED LAN] ..........................................................................................................127
   [VERSION(1)] ..........................................................................................................127
   [VERSION(2)] ..........................................................................................................127
   [OTHERS] ................................................................................................................128
   [CONDITIONS] ........................................................................................................128
   [HDBaseT] .................................................................................................................128

6. Connecting to Other Equipment .................................................................................129
   1 Connecting a computer ..........................................................................................129
      Analog RGB signal connection ............................................................................129
      Digital RGB signal connection ............................................................................130
   2 Connecting an External Monitor ............................................................................133
   3 Connecting Your Blu-ray Player or Other AV Equipment .....................................134
      Connecting Component Input .............................................................................135
      Connecting HDMI Input ......................................................................................136
   4 Connecting a document camera .............................................................................137
   5 Connecting to a Wired LAN ...................................................................................138
   6 Connecting to a HDBaseT transmission device (sold commercially) .....................139
   7 Portrait projection (vertical orientation) .................................................................140

7. Maintenance ..............................................................................................................142
   1 Cleaning the Filters ...............................................................................................142
   2 Cleaning the Protection glass ................................................................................146
   3 Cleaning the Cabinet .............................................................................................146

8. User Supportware ....................................................................................................147
   1 Operating Environment for User Supportware ....................................................147
## Table of Contents

- Download service ............................................................................................................. 147
- Operating Environment .................................................................................................. 147
- 2 Installing Software Program .......................................................................................... 148
  - Installation for Windows software ............................................................................... 148
- 3 Operating the Projector Via the LAN (Virtual Remote Tool) ............................................. 150
  - Connect the projector to a LAN .................................................................................... 151
- 4 Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5) .............................. 153

### 9. Appendix .................................................................................................................. 156

1. Throw distance and screen size ....................................................................................... 156
   - Lens types and throw distance ................................................................................... 156
   - Tables of screen sizes and dimensions ...................................................................... 157
   - Lens shifting range ..................................................................................................... 158
2. Mounting the Optional Board (sold separately) ............................................................. 159
3. Compatible Input Signal List ........................................................................................... 161
4. Specifications .................................................................................................................. 164
5. Cabinet Dimensions ....................................................................................................... 167
6. Pin assignments and signal names of main terminals ....................................................... 169
7. Troubleshooting .............................................................................................................. 175
   - Indicator Messages .................................................................................................... 175
   - Common Problems & Solutions .................................................................................. 177
   - If there is no picture, or the picture is not displayed correctly ..................................... 179
8. PC Control Codes and Cable Connection ......................................................................... 180
9. Troubleshooting Check List ............................................................................................. 181
1. Introduction

What’s in the Box?

Make sure your box contains everything listed. If any pieces are missing, contact your dealer. Please save the original box and packing materials if you ever need to ship your projector.

Projector

* The projector is shipped without a lens. For the types of lens and throw distances, see page 156.

Remote control (7N901041)

AA alkaline batteries (x2)

Power cord (US: 7N080244)

Service keys (2) (24C09081)

WARNING:
Used by the service technician.
Do not attempt to use by yourself as this is dangerous.

Glass protector cap

• Important Information (7N8N6771)
• Quick Setup Guide (For North America: 7N8N6781)
• Security Sticker (Use this sticker when security password is set on.)
• Limited warranty

NEC Projector CD-ROM
User’s manual (PDF) (7N952401)
1. Introduction

Introduction to the Projector

This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector

This projector is one of the very best projectors available today. The projector enables you to project precise images up to 500 inches across (measured diagonally) from your PC or Mac computer (desktop or notebook), VCR, Blu-ray player, or document camera. You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen, and the projector can be permanently mounted on a ceiling*. The remote control can be used wirelessly.

* Do not attempt to mount the projector on a ceiling yourself.

The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.

In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes. Please consult your dealer for more information.

General

- Three-chips DLP projector with high resolution and high brightness

Realized to project the image in the resolution 1920 × 1080 pixels (Full HD), the aspect ratio in 16:9, and the brightness in 12000 lm. Able to project Full HD image in Native resolution.

- Superior dust-proof structure

Adapted the cycle cooling system for cooling down the optical parts. By this system, air in the light source is cooled down and circulated. As the result, the optical parts are not exposed to the open air and enable to keep brightness without contamination by dust.

* Can not prevent contamination by dust completely.

Light source · Brightness

- A long-life laser diode is equipped in the light module

The product can be operated at low cost because the laser light source can be used for a long time without requiring replacement or maintenance.

Moreover, if the light module life optimizing [LONG LIFE] mode is selected, light module life can be extended.

- Brightness can be adjusted within a wide range

Unlike with ordinary light sources, the brightness can be adjusted from 30 to 100% in 1% increments.

- [CONSTANT BRIGHTNESS] mode

Brightness normally decreases with use, but by selecting [CONSTANT BRIGHTNESS] mode, sensors inside the projector detect and automatically adjust the output, thereby maintaining constant brightness throughout the life of the light module.

However, if brightness output is set at the maximum, brightness will decrease with use.

Installation

- Wide range of optional lenses selectable according to the place of installation

This projector supports 4 types of optional lenses, providing a selection of lenses adapted to a variety of places of installation and projection methods. No lens is mounted at shipping from the factory. Contact your dealer for purchasing and replacing these optional lenses sold separately.

- Tilt-free, portrait projection

This projector can be set to any angle within a vertical 360° range.

It can also rotate the picture 90° into portrait orientation, however, it cannot be installed with right or left slant besides the portrait projection.

- Power lens control for quick and easy adjustment

By using buttons on the projector or the remote control, zoom, focus, and position (lens shift) can be adjusted.
1. Introduction

**Videos**

- **Wide range of input/output terminals (HDMI, DisplayPort, HDBaseT, BNC, etc.)**
  The projector is equipped with a variety of input/output terminals: HDMI, DisplayPort, HDBaseT, BNC (5-core), computer (analog), etc.
  The projector’s HDMI input/output terminals and DisplayPort input terminal support HDCP.
  HDBaseT, promoted and advanced by the HDBaseT Alliance, is a connection standard for home appliances.

- **Slot for optional board**
  This projector has a slot for optional boards (sold separately).

- **Simultaneous display of 2 images (PIP/PICTURE BY PICTURE)**
  Two images can be projected simultaneously with a single projector.
  There are two types of layouts for the two images: “picture-in-picture” (PIP) in which a sub-picture is displayed on the main picture, and “picture-by-picture” (PICTURE BY PICTURE) in which the main and sub pictures are displayed next to each other.

- **Multi-screen projection using multiple projectors**
  This projector is equipped with multiple HDMI input & output terminals that can connect multiple projectors in a daisy chain. A high quality picture is achieved by dividing and projecting high resolution videos among the various projectors.
  Furthermore, the boundaries of the screens are smoothed using an edge blending function.

- **Seamless switch function for smoother screen changes when switching the signal**
  When the input connector is switched, the image displayed before switching is held so that that the new image can be switched to without a break due to absence of a signal.

- **Supports HDMI 3D format**
  This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear and 3D emitters that support Xpand 3D.

**Network**

- **Supported by wired LAN**
  HDBaseT/Ethernet Port Video can be transmitted from a computer equipped with a RF-45 port that is connected to a wired LAN to the projector, and the projector can also be controlled from the computer.

- **CRESTRON ROOMVIEW compatible**
  This projector supports CRESTRON ROOMVIEW, allowing multiple devices connected to the network to be managed from a computer or controller.

**Energy-saving**

- **“LIGHT MODE” for low power consumption and “Carbon Meter” display**
  The projector is equipped with an “LIGHT MODE” for reducing power consumption during use. Furthermore, the power-saving effect when the LIGHT MODE is set is converted into the amount of reductions of CO₂ emissions and this is indicated on the confirmation message displayed when the power is turned off and at “Information” on the on-screen menu (CARBON METER).
About this user's manual

The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find an overview. If the section doesn’t apply, you can skip it.
**Part Names of the Projector**

**Front/Top**

The lens is sold separately. The description below is for when the NP-9LS16ZM1 lens is mounted.

- **Terminals**
  - Connect the supplied power cord’s three-pin plug here, and plug the other end into an active wall outlet.
  - (→ page 8)

- **Remote Sensor**
  - (located on the front and the rear)
  - (→ page 11)

- **Intake vent**
  - Takes in outside air to cool the unit.
  - There are air intake and ventilation holes on the bottom.
  - (→ page ix, 57, 142)

- **Lens**

- **AC IN terminal**
  - While AC power is being supplied, set the main power switch to ON position (|), then your projector will enter a standby state.
  - (→ page 13)

- **Handle**

- **Level Adjuster**
  - (→ page 21)
Rear

- **Intake vent**
  Takes in outside air to cool the unit.
  (→ page ix, 57, 142)

- **Level Adjuster**
  (→ page 21)

- **Remote Sensor** (located on the front and the rear)
  (→ page 11)

- **Rear LED**
  (→ page 112)

- **Exhaust vent**
  Heated air is exhausted from here.

- **Handle**

- **Model name**
  Model name of your projector is indicated here on the label.
1. Light button
   Illuminates the control panel and the indicator panel. Available when the Power is ON and the HDBaseT standby is selected as standby mode. (→ page 16)

2. (POWER) Button
   (→ page 16, 26)

3. POWER Indicator
   (→ page 15, 16, 26, 175)

4. STATUS Indicator
   (→ page 175)

5. LIGHT Indicator
   (→ page 28, 176)

6. TEMP. Indicator
   (→ page 176)

7. SHUTTER Indicator
   (→ page 28, 176)

8. Liquid crystal indicator panel
   The projector displays its status, input signal info, and error info whenever connected to a power source. Information displayed
   Projector status: stand-by (sleep), power on/off

9. SHUTTER Button
   (→ page 28, 105)

10. (light source) button
    (→ page 28)

11. MENU Button
    (→ page 68)

12. ▲▼ ◄► Buttons
    (→ page 68)

13. ENTER Button
    (→ page 68)

14. EXIT Button
    (→ page 68)

15. KEY LOCK Button/KEY LOCK Indicator
    (→ page 28)

16. LIGHT Button
    (→ page 31)

17. SOURCE Button
    (→ page 18)

18. AUTO ADJ. Button
    (→ page 25)

19. 3D REFORM Button
    (→ page 34, 94)

20. LENS SHIFT/HOME POSITION Button
    (→ page 22, 158)

21. LENS CALIBRATION Button
    (→ page 16, 106)

22. FOCUS +/- Button
    (→ page 24)

23. ZOOM +/- Button
    (→ page 24)

Input signal info: input terminal, entry list number, source name, horizontal frequency, vertical frequency
Error info: error code, error description
1. **COMPUTER IN/ Component Input Terminal (Mini D-Sub 15 Pin)**  
   (→ page 13, 129, 135, 169)

2. **DisplayPort IN Terminal (DisplayPort 20 Pin)**  
   (→ page 130, 169)

3. **HDMI IN Terminal (Type A)**  
   (→ page 130, 132, 136, 169)

   (→ page 129, 135)

5. **BNC (Y/C) Input Terminal (BNC × 2)**  
   (→ page 134)

6. **BNC (CV) Input Terminal (BNC × 1)**  
   (→ page 134)

7. **USB Port (Type A)**  
   (→ page 170)  
   (For future expansion. This port allows for power supply.)

8. **HDMI OUT Terminal (Type A)**  
   (→ page 133)

9. **Ethernet/HDBaseT Port (RJ-45)**  
   (→ page 138, 139, 170)

10. **3D SYNC Terminal (Mini DIN 4 Pin)**  
    (→ page 41)

11. **3D terminal (3D) (D-sub 15P)**  
    The terminal for connecting a 3D image system to the projector.

12. **REMOTE Terminal (Stereo Mini)**  
    Use this jack for wired remote control of the projector using a commercially available remote cable with ø3.5 stereo mini-plug (without resistance).

13. **SLOT**  
    (→ page 159)

---

**NOTE:**

- When a remote control cable is connected to the REMOTE terminal, infrared remote control operations cannot be performed.
- Power cannot be supplied from the REMOTE terminal to the remote control.
- When [HDBaseT] is selected in the [REMOTE SENSOR] and the projector is connected to a commercially-available transmission device that supports HDBaseT, remote control operations in infra-red cannot be carried out if transmission of remote control signals has been set up in the transmission device. However, remote control using infrared rays can be carried out when the power supply of the transmission device is switched off.

---

13. **Ethernet port (LAN) (RJ-45)**  
This terminal is used for service purpose only.

14. **USB port (USB) (type A)**  
This terminal is used for service purpose only.

15. **PC control terminal (RS-232) (D-sub 9P)**  
The terminal for operating the projector from a PC via an RS-232C or for service personnel to set data for the projector.
    Connect the projector and the PC with a commercially available RS-232C straight cable.

16. **External control terminal (GP I/O) (D-sub 37P)**  
The terminal for externally controlling the projector or for controlling external devices by the projector.
1. Introduction

Part Names of the Remote Control

1. Infrared Transmitter
   (→ page 11)

2. Remote Jack
   Connect a commercially available remote cable here for wired operation. (→ page 11)

3. POWER ON Button
   (→ page 16)

4. POWER OFF Button
   (→ page 26)

5. INFO/L-CALIB. Button
   Display the [SOURCE(1)] screen of the on-screen menu. (→ page 125)

6. VOL./FOCUS +/- Buttons
   (→ page 24)

7. D-ZOOM/ZOOM +/- Buttons
   (→ page 24, 30)

8. TEST Button
   (→ page 20, 76)

9. ECO/L-SHIFT Button
   (→ page 23, 31)

10. MENU Button
    (→ page 68)

11. EXIT Button
    (→ page 68)

12. ENTER Button
    (→ page 68)

13. ▲▼◀▶ Button
    (→ page 68)

14. ON-SCREEN Button
    (→ page 29)

15. SHUTTER Button
    (→ page 28, 105)

16. AV-MUTE Button
    (→ page 29)

17. PICTURE Button
    (→ page 80)

18. SOURCE Button
    (→ page 18)

19. 3D REFORM Button
    (→ page 34, 94)

20. PIP/FREEZE Button
    (→ page 29, 58)

21. AUTO ADJ. Button
    (→ page 25)

22, 23, 24. COMPUTER 1/2/3 Button
   (23 & 24 are not available on this series of the projector)
   (→ page 18)

25. VIDEO Button
    (→ page 18)

26. S-VIDEO Button
    (→ page 18)

27. HDMI Button
    (→ page 18)

28. DisplayPort Button
    (→ page 18)

29. VIEWER Button
    (The VIEWER button will not work on this series of projectors.)

30. NETWORK Button
    (→ page 18)

31. SLOT Button
    (→ page 18, 160)

32. ID SET Button
    (→ page 101, 113)

33. Numeric (0 to 9/CLEAR) Buttons
    (→ page 113)
    (The AUX button will not work on this series of projectors.)

34. CTL Button
    This button is used in conjunction with other buttons, similar to a CTRL key on a computer.

35. LIGHT Button
    This button is used to turn on the backlight for the remote control buttons.
    The backlight will turn off if no button operation is made for 10 seconds.

36. HELP Button
    (→ page 125)
Battery Installation

1. Press the catch and remove the battery cover.
2. Install new ones (AA). Ensure that you have the batteries’ polarity (+/-) aligned correctly.
3. Slip the cover back over the batteries until it snaps into place.

NOTE: Do not mix different types of batteries or new and old batteries.

Remote Control Precautions

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries’ polarity (+/-) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.
Operating Range for Wireless Remote Control

- The infrared signal operates by line-of-sight up to a distance of above meters and within a 60-degree angle of the remote sensor on the projector cabinet.
- The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

Using the Remote Control in Wired Operation

Connect one end of the remote cable to the REMOTE terminal and the other end to the remote jack on the remote control.

**NOTE:**
- When a remote cable is inserted into the REMOTE terminal, the remote control does not work for infrared wireless communication.
- Power will not be supplied to the remote control by the projector via the REMOTE jack. Battery is needed when the remote control is used in wired operation.
2. Projecting an Image (Basic Operation)

This section describes how to turn on the projector and to project a picture onto the screen.

1. Flow of Projecting an Image

Step 1
• Connecting your computer / Connecting the power cord (→ page 13)

Step 2
• Turning on the projector (→ page 15)

Step 3
• Selecting a source (→ page 18)

Step 4
• Adjusting the picture size and position (→ page 20)
• Correcting keystone distortion [CORNERSTONE] (→ page 34)

Step 5
• Adjusting a picture
  - Optimizing a computer signal automatically (→ page 25)

Step 6
• Making a presentation

Step 7
• Turning off the projector (→ page 26)
2. Connecting Your Computer/Connecting the Power Cord

1. Connect your computer to the projector.
   This section will show you a basic connection to a computer. For information about other connections, see “1. Connecting a computer” on page 129.
   Connect the display output terminal (mini D-sub 15 pin) on the computer to the COMPUTER IN terminal on the projector with a commercially-available computer cable (with ferrite core) and then turn the knobs of the terminals to secure them.

2. Connect the supplied power cord to the projector.
   First connect the supplied power cord’s three-pin plug to the AC IN terminal of the projector, and then connect the other plug of the supplied power cord in the wall outlet.

**WARNING:** TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE. DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.

**Important Information:**
- When plugging in or unplugging the supplied power cord, make sure that the main power switch is pushed to the off [O] position. Failure to do so may cause damage to the projector.
- Do not use a three-phase power supply. Doing so may cause malfunction.

**CAUTION:**
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation. Use caution when picking up the projector.
2. Projecting an Image (Basic Operation)

Using the Power Cord Fixing Metal
To prevent the power cord from accidently removing from the AC IN of the projector, attach the power cord fixing metal.

⚠️ CAUTION

- To prevent the power cord from coming loose, make sure that all the prongs of the power cord are fully inserted into the AC IN terminal of the projector before using the power cord fixing metal. A loose contact of the power cord may cause a fire or electric shock.

Attaching the power cord fixing metal

1. Pinch and pull out the power cord fixing metal flap that is housed over the AC IN terminal.

2. Pull down the fixing metal flap over the power code until the fixing metal fits into the bottom stopper.

For releasing the fixing metal flap, pull it up until the fixing metal fits into the upper stopper.
3 Turning on the Projector

NOTE:
• The projector has two power switches: A main power switch and a POWER button (POWER ON and OFF on the remote control)

• Turning on the projector:
1. **Press the main power switch to the ON position (I).**
   The projector will go into standby mode.

2. **Press the POWER button.**
   The projector will become ready to use.

• Turning off the projector:
1. **Press the POWER button.**
   The confirmation message will be displayed.

2. **Press the POWER button again.**
   The projector will go into standby mode.

3. **Press the main power switch to the OFF position (O).**
   The projector will be turned off.

1. **Press the main power switch to the ON position (I).**
   The POWER indicator lights up red.*
   * This indicates that the STANDBY mode is in [NORMAL] setting.

(→ page 122, 175)
• The buzzer sound is released when [NOTIFICATION SETTING] for [BUZZER] is ON.

![WARNING]

The projector produces a strong light. When turning on the power, make sure no one within projection range is looking at the lens.

NOTE:
• The [STANDBY MODE] setting will be disabled and the projector will go into the sleep mode when the network service is utilized or the projector receives HDBaseT signal. In the sleep mode, the fans in the projector sometimes rotate for the purpose of interior parts protection. Please refer to page 122 about the sleep mode.
2. Projecting an Image (Basic Operation)

2. Press the (POWER) button on the projector cabinet or the POWER ON button on the remote control.

The POWER indicator goes from a steady red light to a flashing blue light, and the picture is projected on the screen.

- If using the remote control, press the POWER ON button.
- When there is no signal the unit will project a blue screen (factory default menu settings).
- If the picture is blurry, adjust the screen focus. (→ page 24)
- When it is dark press the (lights) button. The indicator panel backlight and the LED lamp on the right side of the projector will turn on. (→ page 7)

TIP:
- The unit has a Power On Shutter function that allows the light source to turn off even when connected to a power source. (→ page 105)
- Pressing the button will not activate the unit when the KEY LOCK indicator is flashing orange. (→ page 28)
- When the message “PROJECTOR IS LOCKED! ENTER YOUR PASSWORD.” is displayed, it means that the [SECURITY] feature is turned on. (→ page 38)

After you turn on your projector, ensure that the computer or video source is turned on.

NOTE: The blue screen ([BLUE] background) is displayed when no signal is being input (by factory default menu settings).

Performing Lens Calibration

- After installing or replacing the lens unit (below *) sold separately, press the LENS CALIBRATION button on the projector, or hold down the CTL button on the remote control then press the INFO/L-CALIB. button to carry out [LENS CALIBRATION].

By carrying out [LENS CALIBRATION], the adjustment range of the zoom and focus of the [LENS MEMORY] is calibrated.

If you need to install or replace the lens unit, contact your dealer and have them do it for you.
2. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one of the 29 menu languages.

To select a menu language, follow these steps:

1. Use the ▲, ▼, ◀ or ▶ button to select one of the 29 languages from the menu.

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu operation. If you want, you can select the menu language later. (→ [LANGUAGE] on page 72 and 101)

---

NOTE:
- When the KEY LOCK indicator is flashing, that means [CONTROL PANEL LOCK] has been set and pressing the button will not cause the unit to power-on. Release [CONTROL PANEL LOCK]. (→ page 28)
- While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button. (While the POWER indicator is blinking blue in long cycles, the OFF TIMER is functioned and the power can be turned off.)
Selecting a Source

Selecting the computer or video source

NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically

Press the SOURCE button for 1 second or longer. The projector will search for the available input source and display it. The input source will change as follows:

HDMI → DisplayPort → BNC → BNC(CV) → BNC(Y/C) → COMPUTER
→ HDBaseT → SLOT → …

• Press it briefly to display the [INPUT] screen.

Press the ▼/▲ buttons to match the target input terminal and then press the ENTER button to switch the input. To delete the menu display in the [INPUT] screen, press the MENU or EXIT button.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control

Press any one of the HDMI, DisplayPort, COMPUTER 2, VIDEO, S-VIDEO, COMPUTER 1, NETWORK, or SLOT buttons.

• COMPUTER 2 button selects the BNC input terminal.
• VIDEO button selects the BNC (CV) input terminal (Composite Video).
• S-VIDEO button selects the BNC (Y/C) input terminal (S-Video).
Selecting Default Source
You can set a source as the default source so that it will be displayed each time the projector is turned on.

1. Press the MENU button.
The menu will be displayed.
2. Press the ► button to select [SETUP] and press the ▼ button or the ENTER button to select [BASIC].
3. Press the ► button to select [SOURCE OPTIONS].
4. Press the ▼ button four times to select [DEFAULT INPUT SELECT] and press the ENTER button.

The [DEFAULT INPUT SELECT] screen will be displayed.
(→ page 120)

5. Select a source as the default source, and press the ENTER button.
6. Press the EXIT button three times to close the menu.
7. Restart the projector.
The source you selected in step 5 will be projected.

NOTE: Even when [AUTO] is turned on, the [HDBaseT] will not be automatically selected. To set your network as the default source, select [HDBaseT].

TIP:
• When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER IN input will power on the projector and simultaneously project the computer’s image.
  ([AUTO POWER ON SELECT] → page 123)
• On the Windows 7 keyboard, a combination of the Windows and P keys allows you to set up external display easily and quickly.
5 Adjusting the Picture Size and Position

Use the lens shift dial, the level adjuster lever, the zoom lever/zoom ring and the focus ring to adjust the picture size and position.

_in this chapter drawings and cables are omitted for clarity._

Adjusting the projector’s settings
[Level adjuster]
(→ page 21)

Adjusting the projected image’s vertical and horizontal position
[Lens shift]
(→ page 22)

Adjusting the focus
[Focus]
(→ page 24)

Finely adjusting the size of an image
[Zoom]
(→ page 24)

TIP:
- Built-in test patterns can be conveniently used for adjusting the picture size and position. (→ page 76)

A press of the TEST button will display the test pattern. The ◀ or ▶ button can select one test pattern. To close the test pattern, change the source to another.
### Adjustment of the projector's settings (Level adjusters)

The projector must be placed square to the screen otherwise keystone distortion may appear on the screen. For setting the projector perpendicular to the screen when viewed from the side, utilizing the level adjusters equipped at each corner of the projector bottom. Maximum Adjustable length of the level adjuster is 10 mm/0.39".

#### Example for adjustment

**NOTE:**
- Do not lengthen each of the level adjusters any more than 10 mm/0.39". The force of doing so may cause the level adjuster to come off, resulting in damage to the projector.
- Pay attention to lengthen or shorten two level adjusters at front at the same time. Same for the rear adjusters, otherwise, the weight of the projector is loaded on one level adjuster and it may cause of damage to it.

| CAUTION | • Perform the adjustment from behind or from the side of the projector. Adjusting from the front could expose your eyes to strong light which could injure them.  
| | • Keep hands away from the lens mounting portion while the lens shift is in operation. Failure to do so could result in hands being pinched by the moving lens. |

---

![Diagram of Level Adjusters]

**Level adjuster**

Raise  Lower

Raise  Lower
2. Projecting an Image (Basic Operation)

Adjusting the vertical position of a projected image (Lens shift)

**NOTE:**
- Shifting the lens to the maximum in two directions combined will cause the edges of the image to become dark or will cause some shadows.

Adjusting with buttons on the cabinet

1. **Press the LENS SHIFT/HOME POSITION button.**
   The [LENS SHIFT] screen will be displayed.

2. **Press the ▼▲◀▶ button.**
   Use the ▼▲◀▶ buttons to move the projected image.

- **Returning the lens shift position to the home position**
  Press and hold the LENS SHIFT/HOME POSITION button for 2 seconds to return the lens shift position to the home position (nearly center position)
2. Projecting an Image (Basic Operation)

Adjusting with the remote control

1. **Hold the CTL button and press the ECO/L-SHIFT button.**
   
   The [LENS SHIFT] screen will be displayed.

   ![Remote Control with LENS SHIFT Screen]

2. **Press the ▼▲◄► button.**
   
   Use the ▼▲◄► buttons to move the projected image.

   ![Remote Control with Arrows]

**TIP:**

- The figure below shows the lens shift ranges (projection mode: desktop/front) of lens units NP-9LS08ZM1, NP-9LS12ZM1, NP-9LS13ZM1, and NP-9LS16ZM1.

![Lens Shift Ranges Diagram]

Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the projected image).
Focus

NOTE:
• For lens unit NP-9LS08ZM1, both central and peripheral focus must be adjusted. Use the FOCUS +/- buttons to adjust the central focus. If the peripheral focus is off, contact your dealer to have them adjust it.

1. Press the FOCUS +/- button.
   • On the remote control, while pressing on the CTL button, press on VOL/FOCUS (+) or (−) button. The focus is adjusted.

   Tip: To obtain the best focus, perform the following (for fixed installation)
   Preparation: Warm up the projector for one hour.
   1. Use the FOCUS +/- buttons to make sure you obtain the best focus. If you do not, move the projector back and forth.
   2. Select the [TEST PATTERN] from the menu and display the test pattern. (→ page 76)
      • You can also use the TEST button on the remote control to display the test pattern.
   3. Keep pressing the FOCUS – button until the grid of the text pattern is made invisible.
   4. Keep pressing the FOCUS + button until you obtain the best focus.
      If you adjust beyond the best focal point, go back to step 3 and repeat the procedures.

Zoom

1. Press the ZOOM +/- button.
   • On the remote control, while pressing on the CTL button, press the D-ZOOM/ZOOM (+) or (−) button. The zoom is adjusted.
Optimizing Computer Signal Automatically

Adjusting the Image Using Auto Adjust

When an image from HDMI IN, DisplayPort IN, BNC input terminal (analog RGB), COMPUTER IN, or HDBaseT is being projected, and the edge is cut off or the image quality is poor, this button can be used to automatically optimize the projection image on the screen.

Press the AUTO ADJ. button to optimize a computer image automatically. This adjustment may be necessary when you connect your computer for the first time.

![Poor picture]  ![Normal picture]

**NOTE:**
Some signals may take time to display or may not be displayed correctly.
- If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] manually. (→ page 84, 85)
Turning off the Projector

To turn off the projector:

1. First, press the (POWER) button on the projector cabinet or the POWER OFF button on the remote control.
   The [POWER OFF / ARE YOU SURE ? / CARBON SAVINGS-SESSION 0.000[g-CO2]] message will appear.

2. Second, press the ENTER button or press the (POWER) or the POWER OFF button again.
   When the projector is in STANDBY MODE, the POWER indicator lights up red. (When [STANDBY MODE] is in [NORMAL] setting)
   • Before the POWER indicator lights up red, the buzzer sound is released when [NOTIFICATION SETTING] for [BUZZER] is ON.

3. Make sure the projector is in STANDBY MODE, then turn off the main power switch (○ OFF)
   The POWER indicator will go off and the main power will turn off.
   • While the POWER indicator is blinking blue in short cycles, the power cannot be turned off.

CAUTION:
Parts of the projector may temporarily overheat if the projector is turned off with the main power switch or the AC power supply is disconnected while the projector is in operation or the cooling fan is running. Handle with care.
NOTE:
• Do not unplug the power cord from the projector or from the power outlet while an image is being projected. Doing so could deteriorate the projector's AC IN terminal or the power plug’s contact. To turn off the AC power supply when the projector is powered on, use the projector's main power switch, a power strip equipped with a switch, or a breaker.
• Do not turn off the main power switch or disconnect the AC power supply within 10 seconds of making adjustments or setting changes and closing the menu. Doing so can cause loss of adjustments and settings.
3. Convenient Features

1 Stopping projection

1. Press the SHUTTER button on the projector or on the remote control.

   The light source will turn off and the light of the projector will temporarily go dark. The SHUTTER indicator will turn on in green.
   
   Press the button again and projection will resume. The SHUTTER indicator will turn off.
   
   You can set the projection light to gradually fade in or fade out.

2 Turning off the light source

1. Press the (light source) button on the projector.

   Hold the button for three seconds when the power is on to turn off the light source directly (the cooling fan will also stop). The LIGHT indicator will turn off.
   
   • If the (light source) button will be held down for three seconds again, the LIGHT indicator will flash in green.

3 Locking the projector so it cannot be operated

1. Press the KEY LOCK button for over 1 second on the projector.

   The KEY LOCK indicator will turn on in orange and all the projector’s operating buttons will be locked.
   
   • Press the KEY LOCK button for over 1 second again to turn off the KEY LOCK indicator and unlock the buttons.

TIP:

• When [CONTROL PANEL LOCK] is engaged a icon appears in the lower right-hand corner of the menu screen.
• The projector can still be operated using the remote control even when the buttons on the unit are locked.
4 Muting the Image (AV Mute)
Press the AV-MUTE button to turn off the image for a short period of time. Press again to restore the image.

TIP:
• The image will disappear but not the menu display.

5 Turning Off the On-Screen Menu (On-Screen Mute)
A press of the ON-SCREEN button on the remote control will hide the on-screen menu, the source display and other messages. Press again to restore them.

TIP:
• To confirm that the on-screen mute is turned on, press the MENU button. If the on-screen menu is not displayed even though you press the MENU button, it means the on-screen mute is turned on.
• The on-screen mute is maintained even when the projector is turned off.
• Holding down the MENU button for at least 10 seconds will turn off the on-screen mute.

6 Freezing a Picture
Hold the CTL button and press the PIP/FREEZE button to freeze a picture. Press again to resume motion.

NOTE: The image is frozen but the original video is still playing ahead.
Magnifying a Picture
You can magnify the picture up to four times.

NOTE:
• Depending on an input signal, the maximum magnification may be less than four times, or the function may be restricted.

To do so:

1. Press the D-ZOOM (+) button to magnify the picture.

2. Press the ▲▼◀▶ button.
   The area of the magnified image will be moved

3. Press the D-ZOOM (−) button.
   Each time the D-ZOOM (−) button is pressed, the image is demagnified.

NOTE:
• The image will be magnified or demagnified at the center of the screen.
• Displaying the menu will cancel the current magnification.
3. Convenient Features

8 Changing LIGHT MODE/Checking Energy-Saving Effect Using LIGHT MODE [LIGHT MODE]

When either [ECO1] or [ECO2] in [LIGHT MODE] is selected, motion noise of the projector is cut down by lowering brightness of its light source. By saving energy consumption, the CO₂ emission from this projector can be reduced.

<table>
<thead>
<tr>
<th>LIGHT MODE</th>
<th>Icon at the bottom of the menu</th>
<th>Description</th>
</tr>
</thead>
</table>
| NORMAL     |                                | 100% brightness  
The screen will be brightly lit. |
| ECO1       | ![Icon](icon1.png)            | Brightness will be at about 80%.  
The cooling fan will also slow down accordingly.  
Lower power consumption |
| ECO2       | ![Icon](icon2.png)            | Brightness will be at about 50%.  
The cooling fan will also slow down accordingly.  
Lower power consumption considerably |
| LONG LIFE  | ![Icon](icon3.png)            | Brightness is about 90%.  
This setting speeds up the cooling fan and optimizes the service life of the light source. |

* When the brightness is lowered, the cooling fan speed will be reduced accordingly.

To turn on the [LIGHT MODE], do the following:

1. Press LIGHT button on the cabinet.
   - In another way, press ECO/L-SHIFT button on the remote control.

   ![Remote Control](remote.png)

   The [LIGHT MODE] screen will be displayed.

2. Press the ENTER button.

   ![Menu Screen](menu.png)

   The [LIGHT MODE] selection screen will be displayed.

3. Use the ▼▲ buttons to make a selection, and press the ENTER button.

   The display will return to the [LIGHT MODE] screen and the selected option will be applied.

   Press the MENU button to return to the original screen.
3. Convenient Features

NOTE:

• The [LIGHT MODE] can be changed by using the menu. Select [SETUP] → [INSTALLATION] → [LIGHT MODE] → [LIGHT MODE].

• The light module used hours can be checked in [USAGE TIME]. Select [INFO.] → [USAGE TIME].

• After a lapse of 1 minute from when the projector displays a blue, black or logo screen, [LIGHT MODE] will automatically switch to [ECO]. By the automatic setting to [ECO], the projector will be automatically reset to the previous setting when it detects input signal.

• If the projector is overheated in [NORMAL] mode, there may be a case the projector automatically lowers the brightness as a protective function. This is called “Forced ECO MODE”. When the projector is in the Forced ECO MODE, the picture brightness decreases slightly and the TEMP. indicator lights orange. At the same time the Thermometer symbol [™] is displayed at the bottom right of the screen.

When the projector comes back to normal temperature, the Forced ECO MODE is cancelled and the [LIGHT MODE] returns to [NORMAL] mode.
3. Convenient Features

Checking Energy-Saving Effect [CARBON METER]

This feature will show energy-saving effect in terms of CO₂ emission reduction (kg) when the projector’s [LIGHT MODE] is set to either [ECO1], [ECO2], or [LONG LIFE]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON SAVINGS] message shows the total amount of CO₂ emission reduction from the time of shipment up to now. You can check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 125)

The [CARBON SAVINGS-SESSION] message shows the amount of CO₂ emission reduction between the time of changing to LIGHT MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:
- The formula shown below is used to calculate the amount of CO₂ emission reduction. Amount of CO₂ emission reduction = (Power consumption in [NORMAL] LIGHT MODE – Power consumption in current setting) × CO₂ conversion factor. * Setting the [LIGHT MODE] to [ECO1], [ECO2], or [LONG LIFE] increases CO₂ emissions savings.
  * Calculation for amount of CO₂ emission reduction is based on an OECD publication “CO₂ Emissions from Fuel Combustion, 2008 Edition”.
- The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
- This formula will not apply to the power consumption which is not affected by whether [LIGHT MODE] is turned on or off.
3. Convenient Features

9 Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE]

Use the [CORNERSTONE] feature to correct keystone (trapezoidal) distortion to make the top or bottom and the left or right side of the screen longer or shorter so that the projected image is rectangular.

1. Press and hold the 3D REFORM button for 2 seconds at least to reset current adjustments.
   Current adjustments for [GEOMETRIC CORRECTION] will be cleared.

2. Project an image so that the screen is smaller than the area of the raster.

   ![Projected image]
   The drawing shows the upper right corner.

3. Pick up any one of the corners and align the corner of the image with a corner of the screen.

4. Press the 3D REFORM button.

   ![On-screen menu]
   Display the [GEOMETRIC CORRECTION] screen of the on-screen menu.
3. Convenient Features

5. Press the ▼ button to align with the [CORNERSTONE] and then press the ENTER button.

The drawing shows the upper left icon (▼) is selected.

The screen will switch to the [CORNERSTONE] screen.

NOTE:
• When a [GEOMETRIC CORRECTION] function other than [CORNERSTONE] has been set up, the [CORNERSTONE] screen will not be displayed. When the screen is not displayed, either press the 3D REFORM button for 2 or more seconds, or run [RESET] in [GEOMETRIC CORRECTION] to clear the adjustment value of [GEOMETRIC CORRECTION].

6. Use the ▲▼◀▶ button to select one icon (▲) which points in the direction you wish to move the projected image frame.

7. Press the ENTER button.

8. Use the ▲▼◀▶ button to move the projected image frame as shown on the example.

9. Press the ENTER button.

10. Use the ▲▼◀▶ button to select another icon which points in the direction.

11. Repeat steps from 7 to 10 to complete the cornerstone adjustment.

12. On the [CORNERSTONE] screen, select [EXIT] or press the EXIT button on the remote control.

The confirmation screen is displayed.
13. Press the ◀ or ▶ button to highlight the [OK] and press the ENTER button.
   This completes the [CORNERSTONE] correction.
   • Returning to the [CORNERSTONE] screen, select [CANCEL] and press the ENTER button.

NOTE:
• Even when the projector is turned on, the last used correction values are applied.
• Carry out either one of the following actions to clear the adjustment value of [CORNERSTONE].
  • In Step 12, select [RESET] and then press the ENTER button.
  • Press the 3D REFORM button for 2 or more seconds.
  • Run [DISPLAY] → [GEOMETRIC CORRECTION] → [RESET] in the on-screen menu.
• Using CORNERSTONE correction can cause the image to be slightly blurred because the correction is made electronically.
3. Convenient Features

Preventing the Unauthorized Use of the Projector [SECURITY]

A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the projector cannot project an image.

- The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1. **Press the MENU button.**
   
The menu will be displayed.

2. **Press the ▶ button twice to select [SETUP] and press the ▼ button or the ENTER button to select [MENU].**

3. **Press the ▶ button to select [CONTROL].**

4. **Press the ▼ button three times to select [SECURITY] and press the ENTER button.**

   ![Menu Settings](image)

   The OFF/ON menu will be displayed.

5. **Press the ▼ button to select [ON] and press the ENTER button.**

   ![Security Setting](image)

   The [SECURITY KEYWORD] screen will be displayed.

6. **Type in a combination of the four ▲▼◀▶ buttons and press the ENTER button.**

   **NOTE:** A keyword must be 4 to 10 digits in length.

   ![Keyword Entry](image)

   The [CONFIRM KEYWORD] screen will be displayed.

   **NOTE:** Make a note of your password and store it in a safe place.
3. Convenient Features

7. Type in the same combination of ▲▼◄► buttons and press the ENTER button.

![CONFIRM KEYWORD](image)

The confirmation screen will be displayed.

8. Select [YES] and press the ENTER button.

![SECURITY FUNCTION WILL BE ENABLED, ARE YOU SURE?](image)

The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1. Press the □ button.
   - If using the remote control, press the POWER ON button.
   The projector will be turned on and display a message to the effect that the projector is locked.

2. Press the MENU button.

![SECURITY MENU](image)

3. Type in the correct keyword and press the ENTER button. The projector will display an image.

![SECURITY KEYWORD](image)

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
To disable the SECURITY function:

1. **Press the MENU button.**
   The menu will be displayed.

2. **Select [SETUP] → [CONTROL] → [SECURITY] and press the ENTER button.**

   ![Menu](image)

   The OFF/ON menu will be displayed.

3. **Select [OFF] and press the ENTER button.**

   ![Security Menu](image)

   The SECURITY KEYWORD screen will be displayed.

4. **Type in your keyword and press the ENTER button.**
   When the correct keyword is entered, the SECURITY function will be disabled.

   **NOTE:** If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] is a request code.
3. Convenient Features

Projecting 3D videos
This projector supports DLP-Link glasses and 3D emitter.

⚠️ CAUTION

Health precautions
Before use, please make sure to read any health precautions that may be stated in the operating manuals enclosed with the 3D eyewear and 3D video software (Blu-ray player, games, computer animation files, etc.). Please take note of the following in order to avoid adverse health effects.

- Please do not use the 3D eyewear for purposes other than to watch 3D videos.
- Please keep a distance of at least 2 m away from the screen when watching videos. Watching a video too close to the screen will increase eye fatigue.
- Please do not watch videos continuously for a long period of time. Please take a 15 minutes' break after every hour of watching.
- Please consult a doctor before watching if you or any of your family members have a history of suffering from seizures caused by light sensitivity.
- Please stop watching immediately and take a rest when you feel physically unwell while watching (vomiting, giddiness, nausea, headaches, sore eyes, blurred vision, cramps and numbness in the limbs, etc.). Please consult a doctor if the symptoms persist.
- Please watch a 3D video directly in front of the screen. If you watch a 3D video obliquely from the sides, this may result in physical and eye fatigue.

Procedure to watch 3D videos using this projector

3D eyewear and 3D emitter preparations
Use an active shutter system 3D glasses conformed with VESA. Recommend to use RF type glasses produced by Xpand
- 3D Glasses: Xpand X105-RF
- 3D Emitter: Xpand AD025-RF-X1

1. Connect the video device to the projector.
2. Switch on the projector.
3. Run the 3D video software and project the video using the projector.
   [AUTOMATIC] is set as the factory default setting. When a 3D video cannot be projected, it may cause on no 3D signal or the projector can not detect the 3D signal. In this case, select the format manually.
4. Select the 3D video format.
   (1) Press the MENU button.

   ![MENU button](image)

   The MENU will be displayed.
   (2) Press the ▶ button, select [ADJUST], then press ENTER.
   [PICTURE] will be highlighted.
3. Convenient Features

(3) Use the ► button to select [3D SETTINGS].

The [3D SETTINGS] screen will be displayed.

(4) Use the ▼ button to align the cursor with [FORMAT], then press ENTER.

The [FORMAT] screen will be displayed.

(5) Use the ▼/▲ buttons to align the cursor at one among format options, then press ENTER for setting it up.

The display will return to the [3D SETTINGS] screen.

Press the MENU button to return to the original screen.

- The 3D caution message screen will be displayed when switching to a 3D video (default factory setting when shipped). Please read the “Health Precautions” on the previous page to watch videos in the correct manner. The screen will disappear after 60 seconds or when the ENTER button is pressed. (→ page 102)

5. Turn on the power supply of the 3D eyewear and wear the eyewear to watch the video.

A normal video will be shown when a 2D video is input.

To watch a 3D video in 2D, select [OFF(2D)] in the [FORMAT] screen mentioned above in (5).

NOTE:
- Upon switching to 3D image, the following functions will be cancelled and disabled. [BLANKING], [PIP/PICTURE BY PICTURE], [GEOMETRIC CORRECTION], [EDGE BLENDING] ([GEOMETRIC CORRECTION] and [EDGE BLENDING] adjustment values will be maintained.)
- The output may not automatically switch to a 3D video depending on the 3D input signal.
- Check the operating conditions described in the user manual of the Blu-ray player.
- Please connect the DIN terminal of the 3D emitter to the 3D SYNC of the main projector.
- The 3D eyewear allows videos to be viewed in 3D by receiving synchronized optical signals output from the 3D emitter. As a result, the 3D image quality may be affected by conditions such as the brightness of the surroundings, screen size, viewing distance, etc.
- When playing a 3D video software on a computer, the 3D image quality may be affected if the computer CPU and graphics chip performance are low. Please check the required operating environment of the computer that is stated in the operating manual attached to the 3D video software.
- Depending on the signal, [FORMAT] and [L/R INVERT] may not be able to be selected. Please change the signal in that case.
**3. Convenient Features**

**When videos cannot be viewed in 3D**

Please check the following points when videos cannot be viewed in 3D. Please also read the operating manual attached to the 3D eyewear.

<table>
<thead>
<tr>
<th>Possible reasons</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The selected signal does not support 3D output.</td>
<td>Please change the video signal input to one that supports 3D.</td>
</tr>
<tr>
<td>The format for the selected signal is turned to [OFF(2D)].</td>
<td>Please change the format in the on-screen menu to [AUTO] or a format that supports 3D.</td>
</tr>
<tr>
<td>A eyewear that is not supported by the projector is being used.</td>
<td>Please purchase a commercially-available 3D eyewear or 3D emitter (recommended). (→ page 40)</td>
</tr>
<tr>
<td>Please check the following points when a video cannot be viewed in 3D using a 3D eyewear that is supported by the projector.</td>
<td></td>
</tr>
<tr>
<td>The power supply of the 3D eyewear is turned off.</td>
<td>Please turn on the power supply of the 3D eyewear.</td>
</tr>
<tr>
<td>The internal battery of the 3D eyewear is flat.</td>
<td>Please charge or replace the battery.</td>
</tr>
<tr>
<td>The viewer is located too far away from the screen.</td>
<td>Please get closer to the screen until the video can be seen in 3D.</td>
</tr>
<tr>
<td>Please turn the L/R INVERT in the on-screen menu to [OFF].</td>
<td></td>
</tr>
<tr>
<td>Due to multiple 3D projectors working at the same time in the vicinity, the projectors may interfere with one another. Alternatively, there may be a bright light source near the screen.</td>
<td>Please maintain sufficient distance between the projectors.</td>
</tr>
<tr>
<td>Please keep the light source away from the screen.</td>
<td></td>
</tr>
<tr>
<td>Please turn the L/R INVERT in the on-screen menu to [OFF].</td>
<td></td>
</tr>
<tr>
<td>There is an obstacle between the optical receiver of the 3D eyewear and the 3D emitter.</td>
<td>Please remove the obstacle.</td>
</tr>
<tr>
<td>The 3D format of the 3D video contents is not supported.</td>
<td>Please check with the company selling the 3D video contents.</td>
</tr>
</tbody>
</table>
Con trolling the Projector by Using an HTTP Browser

Overview
The HTTP Server function provides settings and operations for:

1. Setting for wired network (NETWORK SETTINGS)
   To use wired LAN connection, connect the projector to the computer with a commercially available LAN cable. (→ page 138)

2. Setting Alert Mail (ALERT MAIL)
   When the projector is connected to a wired network, error messages will be sent via e-mail.

3. Operating the projector
   Power on/off, selecting input, and picture adjustments are possible.

4. Setting PJLink PASSWORD and AMX BEACON

Access to the HTTP server function is available:

- Start the Web browser on the computer via the network connected to the projector and enter the following URL:
  http://<the projector’s IP address>/index.html

TIP: The factory setting IP address is [DHCP ON].

NOTE:
- To use the projector in a network, consult with your network administrator about network settings.
- The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your network. Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projector.
- If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web browser (or clear the cache).
- This projector uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting method will vary depending on the version of browser. Please refer to the help files and the other information provided in your software.

Preparation before Use
Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 138)

Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
Handling of the Address for Operation via a Browser

Regarding the actual address that is entered for the address or entered to the URL column when operation of the projector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the projector has been registered to the domain name server by a network administrator, or the host name corresponding to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network setting by specifying
http://pj.nec.co.jp/index.html
for the address or the entry column of the URL.

Example 2: When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by specifying
http://192.168.73.1/index.html
for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.
- ON ................... Power is switched on.
- OFF .................. Power is switched off.

VOLUME: Can not be used for this device.

AV-MUTE: This controls the mute function of the projector.
- PICTURE ON ....... Mutes the video.
- PICTURE OFF ...... Cancels the video muting.
- SOUND ON .......... Cannot be used for this device.
- SOUND OFF ......... Cannot be used for this device.
- ALL ON ............. Mutes the video functions.
- ALL OFF ............ Cancels the muting of the video functions.
3. Convenient Features

PICTURE: Controls the video adjustment of the projector.
   BRIGHTNESS ▲ .... Increases the brightness adjustment value.
   BRIGHTNESS ▼ .... Decreases the brightness adjustment value.
   CONTRAST ▲ .... Increases the contrast adjustment value.
   CONTRAST ▼ .... Decreases the contrast adjustment value.
   COLOR ▲ .......... Increases the color adjustment value.
   COLOR ▼ .......... Decreases the color adjustment value.
   HUE ▲ ............. Increases the hue adjustment value.
   HUE ▼ ............. Decreases the hue adjustment value.
   SHARPNESS ▲ .... Increases the sharpness adjustment value.
   SHARPNESS ▼ .... Decreases the sharpness adjustment value.
   • The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 82, 83)

SOURCE SELECT: This switches the input terminal of the projector.
   HDMI ...................... Switches to the HDMI IN terminal.
   DisplayPort .......... Switches to the DisplayPort IN.
   BNC ....................... Switch to BNC video input.
   BNC(CV) ................. Switch to BNC (CV) video input.
   BNC(Y/C) ............... Switch to BNC (Y/C) video input.
   COMPUTER ............. Switches to the COMPUTER IN terminal.
   HDBaseT ............... Switch to image input sent from a transmission device that supports HDBaseT.
   SLOT ..................... The projector switches to video input from the optional board when an optional board (sold separately) is equipped on.

PROJECTOR STATUS: This displays the condition of the projector.
   LIGHT HOURS USED ...... Displays how many hours the light module has been used.
   FILTER HOURS USED ...... The number of filter hours used is displayed.
   ERROR STATUS ........... Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).
### NETWORK SETTINGS

#### WIRED

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SETTING</td>
<td>Set for wired LAN.</td>
</tr>
<tr>
<td>APPLY</td>
<td>Apply your settings to wired LAN.</td>
</tr>
<tr>
<td>PROFILE 1/PROFILE 2</td>
<td>Two settings can be set for wired LAN connection. Select PROFILE 1 or PROFILE 2.</td>
</tr>
<tr>
<td>DISABLE</td>
<td>Turn off wired LAN connection</td>
</tr>
<tr>
<td>DHCP ON</td>
<td>Automatically assign IP address, subnet mask, and gateway to the projector from your DHCP server.</td>
</tr>
<tr>
<td>DHCP OFF</td>
<td>Set IP address, subnet mask, and gateway to the projector assigned by your network administrator.</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of the network connected to the projector.</td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>Set your subnet mask number of the network connected to the projector.</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>Set the default gateway of the network connected to the projector.</td>
</tr>
<tr>
<td>AUTO DNS ON</td>
<td>DHCP server will automatically assign IP address of DNS server connected to the projector.</td>
</tr>
<tr>
<td>AUTO DNS OFF</td>
<td>Set your IP address of DNS server connected to the projector.</td>
</tr>
</tbody>
</table>
3. Convenient Features

### NAME

| PROJECOR NAME | Enter a name for your projector so that your computer can identify the projector. A projector name must be 16 characters or less.  
TIP: Projector name will not be affected even when [RESET] is done from the menu. |
| HOST NAME | Enter the hostname of the network connected to the projector. A host name must be 15 or less. |
| DOMAIN NAME | Enter the domain name of the network connected to the projector. A domain name must be 60 characters or less. |

### ALERT MAIL

| ALERT MAIL | This option will notify your computer of error messages via e-mail when using wired LAN.  
Placing a checkmark will turn on the Alert Mail feature.  
Clearing a checkmark will turn off the Alert Mail feature.  
Sample of a message to be sent from the projector:  
Subject: [Projector] Projector Information  
THE COOLING FAN HAS STOPPED.  
[INFORMATION]  
PROJECTOR NAME: PH1202HL Series  
LIGHT HOURS USED: 0000[H]  
FILTER HOURS USED: 0000[H] |
| SENDER'S ADDRESS | Enter sender's address. |
| SMTP SERVER NAME | Enter the SMTP server name to be connected to the projector. |
| RECIPIENT'S ADDRESS 1, 2, 3 | Enter your recipient's address. Up to three addresses can be entered. |
| TEST MAIL | Send a test mail to check whether your settings are correct or not  
**NOTE:**  
* If you execute a test, you may not receive an Alert mail. Should this happen, check if network settings are correct.  
* If you entered an incorrect address in a test, you may not receive an Alert mail. Should this happen, check if the Recipient's Address is correct. |
| SAVE | Click this button to save your settings to the projector's memory. |
3. Convenient Features

**NETWORK SERVICE**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PJLink PASSWORD</td>
<td>Set a password for PJLink*. A password must be 32 characters or less. Do not forget your password. However, if you forget your password, consult with your dealer.</td>
</tr>
<tr>
<td>HTTP PASSWORD</td>
<td>Set a password for HTTP server. A password must be 10 characters or less. When a password is set up, you will be prompted for your user name (arbitrary) and password during LOGON.</td>
</tr>
<tr>
<td>AMX BEACON</td>
<td>Turn on or off for detection from AMX Device Discovery when connecting to the network supported by AMX's NetLinx control system. <strong>TIP:</strong> When using a device that supports AMX Device Discovery, all AMX NetLinx control system will recognize the device and download the appropriate Device Discovery Module from an AMX server. Placing a checkmark will enable detecting the projector from AMX Device Discovery. Clearing a checkmark will disable detecting the projector from AMX Device Discovery.</td>
</tr>
</tbody>
</table>

**NOTE:** If you forget your password, contact your dealer.

*What is PJLink?*
PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005. The projector supports all the commands of PJLink Class 1. Setting of PJLink will not be affected even when [RESET] is done from the menu.

**CRESTRON**

• **ROOMVIEW** for managing from the computer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLE</td>
<td>Disables ROOMVIEW.</td>
</tr>
<tr>
<td>ENABLE</td>
<td>Enables ROOMVIEW.</td>
</tr>
</tbody>
</table>

• **CRESTRON CONTROL** for managing from the controller.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLE</td>
<td>Disables CRESTRON CONTROL.</td>
</tr>
<tr>
<td>ENABLE</td>
<td>Enables CRESTRON CONTROL.</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of CRESTRON SERVER.</td>
</tr>
<tr>
<td>IP ID</td>
<td>Set your IP ID of CRESTRON SERVER.</td>
</tr>
</tbody>
</table>

• **INFORMATION**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRED LAN</td>
<td>Display a list of settings of wired LAN connection.</td>
</tr>
<tr>
<td>UPDATE</td>
<td>Reflect settings when they are changed.</td>
</tr>
</tbody>
</table>

**TIP:** The CRESTRON settings are required only for use with CRESTRON ROOMVIEW. For more information, visit [http://www.crestron.com](http://www.crestron.com)
3. Convenient Features

3. Storing Changes for Lens Shift, Zoom, and Focus [LENS MEMORY]

The adjusted values can be stored in projector memory when using the LENS SHIFT, ZOOM and FOCUS buttons of the projector. Adjusted values can be applied to the signal you selected. This will eliminate the need to adjust lens shift, focus, and zoom at the time of source selection. There are two ways to save adjusted values for lens shift, zoom, and focus.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Description</th>
<th>page</th>
</tr>
</thead>
<tbody>
<tr>
<td>REF. LENS MEMORY</td>
<td>Adjusted values common to all input signals. At the time of installation, two kinds of adjusted values can be recorded. If no adjusted values are stored in [LENS MEMORY], adjusted values from the selected profile ([REF. LENS MEMORY]) will be applied for lens adjustment.</td>
<td>→ page 106</td>
</tr>
<tr>
<td>LENS MEMORY</td>
<td>Adjusted values for each input signal. Use the adjusted values for the signal with a different aspect ratio or resolution. The adjusted values can be applied at the time of source selection.</td>
<td>→ page 91</td>
</tr>
</tbody>
</table>

**NOTE:**
- Be sure to carry out [LENS CALIBRATION] after replacing the lens unit. (→ page 16, 106)
  
If you need to replace the lens unit, contact your dealer and have them do it for you.

**Usage Example**

When you wish to display on a screen having a 4:3 aspect ratio an NTSC or other 4:3 aspect ratio signal and an SXGA or other 5:4 aspect ratio signal:

Perform shift, focus, and zoom adjustments to set the vertical screen size of the vertically tall 5:4 aspect ratio signal to standard.

Both 4:3 aspect ratio signals and 5:4 aspect ratio signals can now be displayed.

Note that with these shift, focus, and zoom adjustments, the 4:3 aspect ratio signal will become smaller on the screen.

To eliminate this size reduction, adjust the shift, focus and zoom to the optimum condition for each of the 4:3 aspect ratio signal and the 5:4 aspect ratio signal.

Memory (storage) of each of these values will permit projection at an optimum condition upon signal switching.

To store your adjusted values in [REF. LENS MEMORY]:

1. Press the **MENU** button.

The menu will be displayed.

2. Press the ▶ button to select [SETUP] and press the ENTER button.
3. Press the ▶ button to select [INSTALLATION].
4. Press the ▼ button to select [REF. LENS MEMORY] and press the ENTER button.
3. Convenient Features

The [REF. LENS MEMORY] screen will be displayed.

5. Make sure [PROFILE] is highlighted, then press the ENTER button.

The [PROFILE] selection screen appears.

6. Press the ▼/▲ buttons to select the [PROFILE] number, then press the ENTER button.

Return to the [REF. LENS MEMORY] settings screen.

7. Select [STORE] and press the ENTER button.

The confirmation screen will be displayed.

8. Press the ◄ button to select and [YES] and press the ENTER button.

Select a [PROFILE] number and save the adjusted [LENS SHIFT], [ZOOM], and [FOCUS] values to it.

- The [FORCED MUTE] setting stops projection during lens shift. (→ page 105)
9. Press the MENU button.
   The menu will be closed.

TIP:
• To store adjusted values for each input source, use the Lens Memory function. (→ page 91)

To call up your adjusted values from [REF. LENS MEMORY]:
1. Press the MENU button.

   The menu will be displayed.

2. Press the ► button to select [SETUP] and press the ENTER button.
3. Press the ► button to select [INSTALLATION].
4. Press the ▼ button to select [REF. LENS MEMORY] and press the ENTER button.

   The [REF. LENS MEMORY] screen will be displayed.

5. Make sure [PROFILE] is highlighted, then press the ENTER button.

   The [PROFILE] selection screen appears.

6. Press the ▼/▲ buttons to select the [PROFILE] number, then press the ENTER button.
Return to the [REF. LENS MEMORY] settings screen.

7. Select [MOVE] and press the ENTER button.

The lens will shift based on the adjusted values stored in the selected [PROFILE].

8. Press the ▼ button to select and [YES] and press the ENTER button.

The adjusted values will be applied to the current signal.

9. Press the MENU button.

The menu will be closed.
TIP:

To call up the adjusted values from [LENS MEMORY]:

1. From the menu, select [ADJUST] → [LENS MEMORY] → [MOVE] and press the ENTER button.

   ![Adjustment Screen]

   The confirmation screen will be displayed.

2. Press the ▲ button to select and [YES] and press the ENTER button.

   During projection, if the adjusted values for an input signal have been saved, the lens will shift. If not, the lens will shift according to the adjusted values stored in the selected [REF. LENS MEMORY] [PROFILE] number.

To automatically apply the adjusted values at the time of source selection:

1. From the menu, select [SETUP] → [REF. LENS MEMORY] → [LOAD BY SIGNAL] and press the ENTER button.

   ![Ref. Lens Memory Menu]

2. Press the ▼ button to select and [ON] and press the ENTER button.

   This will move the lens automatically to the position at the time of source selection according to the adjusted values.

![Load by Signal Menu]

NOTE: The Lens Memory function may not produce a completely aligned image (due to tolerances in the lenses) using the adjusted values stored in the projector. After calling up and applying the adjusted values from the Lens Memory function, finely adjust the lens shift, zoom and focus to produce the best possible image.
4. Multi-Screen Projection

Things that can be done using multi-screen projection

This projector can be used singly or arranged in multiple units for multi-screen projection. We will introduce an example using two projection screens here.

Case 1
Using a single projector to project two types of videos at the same time [PIP/PICTURE BY PICTURE]

Case 2
Using four projectors (resolution: FULL HD) to project video with a resolution of 3840 × 2160 pixels [TILING]

Case 1. Using a single projector to project two types of videos [PIP/PICTURE BY PICTURE]

Connection example and projection image

On-screen menu operations
Display [DISPLAY] → [PIP/PICTURE BY PICTURE] → [MODE] screen in the on-screen menu and select [PIP] or [PICTURE BY PICTURE].
For details, please refer to “4-2 Displaying Two Pictures at the Same Time”. (→ page 58)
Case 2. Using four projectors (resolution: FULL HD) to project videos with a resolution of 3840 × 2160 pixels [TILING]

Connection example and projection image

On-screen menu operations

1. Four similar videos are displayed when four projectors are projected.

Please request the dealer to adjust the projection position of each projector.
4. Multi-Screen Projection

2  **Operate the on-screen menu using the four respective projectors to divide the image into four portions.**
Display [DISPLAY] → [MULTI SCREEN] → [PICTURE SETTING] Screen in the on-screen menu and select [TILING].

(1) In the screen for setting the number of horizontal units, select [2 UNITS]. (number of units in the horizontal direction)

(2) In the screen for setting the number of vertical units, select [2 UNITS]. (number of units in the vertical direction)

(3) In the screen for setting the horizontal order, select [1st UNIT] or [2nd UNIT].
   (look at the screens, the one on the left is the [1st UNIT] while the one on the right is the [2nd UNIT])

(4) In the screen for setting the vertical order, select the [1st UNIT] or the [2nd UNIT].
   (look at the screens, the one at the top is the [1st UNIT] while the one at the bottom is the [2nd UNIT])

3  **Adjust the lens shift of each projector to fine-tune the boundaries of the screen.**
For further fine-tuning, adjust using [DISPLAY] → [EDGE BLENDING] in the on-screen menu for each projector.
For details, please refer to “4-3 Displaying a Picture Using [EDGE BLENDING]”.

(→ page 62)
Things to note when installing projectors

- Leave 60 cm/23.6” or over space between the projectors when projectors are installed side by side, so that the intake vents of the projectors are not obstructed. In addition, leave a space of at least 30 cm/11.8” between the intake vent and the wall and at least 70 cm/27.6” between the exhaust vent and the wall. When the air intake and discharge outlet are obstructed, the temperature inside the projector will rise and this may result in a malfunction.

- Do not directly stack projector units.

![WARNING]

**WARNING**

Projectors stacked directly could fall and cause injury. The projector(s) could also become damaged or broken.

- Example of multiple projectors installed together

When using multiple projectors together for multi screen projection, be sure to set them up in a specialized projector cabinet like the one that follows.

[Installation example]

![Diagram of multi-screen projection setup]

**WARNING**

Please request the dealer for special installation services such as when mounting the projector to the ceiling. Never carry out the installation by yourself. The projector may fall down and result in injury. Please use a sturdy cabinet that can withstand the weight of the projector for the installation. Please do not pile up the projectors directly on top of one another.

---

**NOTE:**

- For the range of the projection distance, please refer to the Appendix “Throw distance and screen size”. (→ page 156)
Displaying Two Pictures at the Same Time

The projector has a feature that allows you to view two different signals simultaneously. You have two modes: picture in picture (PIP) mode and picture by picture (PICTURE BY PICTURE) mode.

The projection video in the first screen display is known as the main display while the projection video that is called out subsequently is known as the sub-display.

Select the projection function under [DISPLAY] → [PIP/PICTURE BY PICTURE] → [MODE] in the on-screen menu (the default factory setting when shipped is PIP). (→ page 92)

- A single screen is projected when power is turned on.

**Picture in Picture function (PIP)**

A small sub-display is displayed inside the main display.

The sub-display can be set up and adjusted as follows. (→ page 93)

- Select whether to display the sub-display at the top right, top left, bottom right or bottom left of the screen (the size of the sub-display can be selected and the position can be fine-tuned)
- Switch the main display with the sub-display

**Picture by picture function (PICTURE BY PICTURE)**

Display the main display and sub-display side by side.

The main display and sub-display can be set up and adjusted as follows. (→ page 93)

- Selecting the display boundary (ratio) of the main display and sub-display
- Switch the main display and sub-display

**Input terminals that can be used for the main screen and sub-screen.**

The main screen and sub-screen can provide the following input terminals.

- The main display and sub-display support computer signals up to WUXGA@60HzRB.

<table>
<thead>
<tr>
<th>Main Display</th>
<th>Sub-Display or additional display</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI</td>
<td>DisplayPort</td>
</tr>
<tr>
<td>HDMI</td>
<td>No</td>
</tr>
<tr>
<td>DisplayPort</td>
<td>Yes</td>
</tr>
<tr>
<td>BNC</td>
<td>Yes</td>
</tr>
<tr>
<td>BNC(CV)</td>
<td>Yes</td>
</tr>
<tr>
<td>BNC(Y/C)</td>
<td>Yes</td>
</tr>
<tr>
<td>COMPUTER</td>
<td>Yes</td>
</tr>
<tr>
<td>HDBaseT</td>
<td>No</td>
</tr>
<tr>
<td>SLOT</td>
<td>No</td>
</tr>
</tbody>
</table>

**NOTE:**

- Some signals may not appear depending on the resolution.
4. Multi-Screen Projection

Projecting two screens

1. Press the MENU button to display the on-screen menu and select [DISPLAY] → [PIP/PICTURE BY PICTURE].

This displays the [PIP/PICTURE BY PICTURE] screen in the on-screen menu.

2. Select [SUB INPUT] using the ▼/▲ buttons, and press the ENTER button.

This displays the [SUB INPUT] screen.

3. Select the input signal using the ▼/▲ buttons, and press the ENTER button.

The [PIP] (PICTURE IN PICTURE) or [PICTURE BY PICTURE] screen set up under [MODE] is projected. (→ page 92)

• When the signal name is displayed in grey, this means that it cannot be selected.
• The signal can also be selected by pressing the PIP/FREEZE button on the remote control.

4. Press the MENU button.

The on-screen menu will disappear.

5. When returning to single screen, display the [PIP/PICTURE BY PICTUE] screen one more time and select [OFF] in the [SUB INPUT] screen of the Step 3.

TIP:
• During dual-screen projection, if the selected input is not supported by the sub-screen, the sub-screen will appear as a black screen.
Switching the main display with the sub-display and vice versa

1. Press the MENU button to display the on-screen menu and select [DISPLAY] → [PIP/PICTURE BY PICTURE].

   ![PIP/PICTURE BY PICTURE menu]

   This displays the [PIP/PICTURE BY PICTURE] screen in the on-screen menu.

2. Select [PICTURE SWAP] using the ▼/▲ buttons and then press the ENTER button.

   Display the screen for switching the display positions.

3. Select [ON] using the ▼ button and then press the ENTER button.

   ![PICTURE SWAP menu]

   The video of the main display will switch with that of the sub-display.

   ![Switching display positions]

   The signal output from the HDMI OUT terminal does not change even if the display positions are switched.

4. Press the menu button.

   The on-screen menu will disappear.
4. Multi-Screen Projection

Restrictions

- The following operations are enabled only for the main display.
  - Visual adjustments
  - Video magnification / demaginification using the partial D-ZOOM/ZOOM +/- buttons.
    However, magnification / demaginification is up to the boundary set in [PICTURE BY PICTURE].
- TEST PATTERN
- The following operations are enabled for both the main display and sub-display. These operations cannot be applied individually.
  - Momentary deletion of video
  - Video pause
- [PIP/PICTURE BY PICTURE] cannot be used when a 3D video is being displayed.
- When using the [PIP/PICTURE BY PICTURE] function, [CLOSED CAPTION] and [DYNAMIC CONTRAST] can be used.
- [PIP/PICTURE BY PICTURE] cannot be used when the signal input has a resolution of 1920 × 1080 or more.
- The HDMI OUT terminal has a repeater function. The output resolution is limited by the maximum resolution of the connected monitor and projector.
4. Multi-Screen Projection

Displaying a Picture Using [EDGE BLENDING]

A high resolution video can be projected on an even bigger screen by combining multiple projectors on the left, right, top and bottom. This projector is equipped with an “EDGE BLENDING Function” that makes the edges (boundaries) of the projection screen indistinguishable.

NOTE:
- For projector throw distances, refer to “Throw distance and screen size” on page 156.
- Before performing the Edge Blending function, place the projector in the correct position so that the image becomes square in the appropriate size, and then make optical adjustments (lens shift, focus, and zoom).
- Adjust the brightness of each projector using [ADJUST] under [LIGHT MODE]. After adjusting the brightness, you can keep the set brightness level by turning ON the [CONSTANT BRIGHTNESS] mode. In addition, use [REF. WHITE BALANCE] to adjust the [CONTRAST] and [BRIGHTNESS].

Before explaining use of the Edge Blending function

This section explains the case for “Example: Placing two projectors side by side”. As shown, the projected image on the left is referred to as “Projector A” and the projected image on the right is referred to “Projector B”. Unless otherwise specified hereinafter, the “projector” is used to mean both A and B.

Example: Placing two projectors side by side
4. Multi-Screen Projection

Preparation:
• Turn on the projector and display a signal.
• When performing settings or adjustments using the remote control, enable the [CONTROL ID] so as not to activate the other projectors. (→ page 113)

Setting the overlap of projection screens

1. **Enable [EDGE BLENDING].**
   
   1. **Press the MENU button.**
      
      The menu will be displayed.
   2. **Select [EDGE BLENDING].**
      
      The [EDGE BLENDING] screen will be displayed. Align the cursor with [MODE] and then press the ENTER button. The mode screen will be displayed.

   ![Input Adjust Display Setup Info. Screen](image)

3. **Select [MODE] → [ON] and press the ENTER button.**

   ![Mode Screen](image)

   This enables the Edge Blending function. The following menu items are available:
   [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL]

4. **Select [RIGHT] for Projector A and [LEFT] for Projector B.**

   Press the ENTER button.

   ![Input Adjust Display Setup Info. Screen](image)

   The following items are available:
   [CONTROL], [MARKER], [RANGE], and [POSITION]
5. Select [CONTROL] → [ON] and press the ENTER button.

Each [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL] has its own [CONTROL], [MARKER], [RANGE], and [POSITION].

- For Projector A, set the [CONTROL] for the [TOP], [LEFT] and [BOTTOM] to [OFF]. Similarly for Projector B, set the [CONTROL] for the [TOP], [RIGHT] and [BOTTOM] to [OFF].

② Adjust [RANGE] and [POSITION] to determine an area of overlapped edges of images projected from each projector.

Turning on [MARKER] will display markers in magenta and green. The magenta marker is used for [RANGE] and green one for [POSITION].

* The 2 screens are separated in the diagram for explanatory purposes.
4. Multi-Screen Projection

1 Adjust [RANGE].
   Use the ◀ or ▶ button to adjust the overlapped area.

   ![RANGE Adjustment](image)

   **TIP:**
   - Adjust to overlap one projector’s marker with the other projector’s marker.

2 Adjust [POSITION].
   Use the ◀ or ▶ button to align one edge with the other edge of overlapped images.

   ![POSITION Adjustment](image)

   **TIP:**
   - When displaying a signal with a different resolution, perform the Edge Blending function from the start.
   - Setting of [MARKER] will not be saved and return to [OFF] when the projector is turned off.
   - To display or hide the marker while the projector is running, turn on or off [MARKER] from the menu.
4. Multi-Screen Projection

Black Level Adjustment
This adjusts the black level of the overlapping area and the non-overlapping area of the multi-screen (EDGE BLENDING). Adjust the brightness level if you feel the difference is too large.

NOTE:
This function is enabled only when [MODE] is turned on. Adjustable area varies depending on what combination of [TOP], [BOTTOM], [LEFT] and [RIGHT] are turned on.

Example: Adjusting the Black Level when placing two projectors side by side

1. Turn on [MODE]
2. Select [BLACK LEVEL] and press the ENTER button.

   The screen will switch to the black level adjustment screen.

3. Use the ▼ or ▲ button to select an item and use the ◀ or ► to adjust the black level.
   Do this for the other projector if necessary.
9-segmented portions for Black Level adjustment

The center projector

This function adjusts the brightness level of 9-segmented portions for the center projector and 4-segmented portions for the left bottom projector as shown below.

TIP:
- The number of black level division screens (maximum of nine divisions) changes depending on the number of edge blending positions selected (top, bottom, right, left). In addition, when the top / bottom and left / right ends are selected, the corner division screen appears.
- The edge blending width is the width set in the range and the corner is formed by the intersecting area of the top / bottom ends or left / right ends.
- The [BLACK LEVEL] can be adjusted to make it brighter only.
5. Using On-Screen Menu

1 Using the Menus

NOTE: The on-screen menu may not be displayed correctly depending on input signal and the projector setting.

1. Press the MENU button on the remote control or the projector cabinet to display the menu.

   ![On-Screen Menu]

   NOTE: The commands such as ENTER, EXIT, ▲▼, ◀▶ in the bottom show available buttons for your operation.

2. Press the ◀▶ buttons on the remote control or the projector cabinet to display the submenu.

3. Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first tab.

4. Use the ▲▼ buttons on the remote control or the projector cabinet to select the item you want to adjust or set.
   You can use the ◀▶ buttons on the remote control or the projector cabinet to select the tab you want.

5. Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6. Adjust the level or turn the selected item on or off by using the ▲▼◀▶ buttons on the remote control or the projector cabinet.
   Changes are stored until adjusted again.

7. Repeat steps 2-6 to adjust an additional item, or press the EXIT button on the remote control or the projector cabinet to quit the menu display.

   NOTE: When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

8. Press the MENU button to close the menu.
   To return to the previous menu, press the EXIT button.
Menu Elements

Menu windows or dialog boxes typically have the following elements:

- **Highlight**............................Indicates the selected menu or item.
- **Solid triangle**......................Indicates further choices are available. A highlighted triangle indicates the item is active.
- **Tab**......................................Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
- **Radio button**.......................Use this round button to select an option in a dialog box.
- **Source**.............................Indicates the currently selected source.
- **Menu mode**..........................Indicates the current menu mode: BASIC or ADVANCED.
- **Off Timer remaining time**.....Indicates the remaining countdown time when the [OFF TIMER] is preset.
- **Slide bar**............................Indicates settings or the direction of adjustment.
- **LIGHT MODE symbol**..........Indicates [LIGHT MODE] is set.
- **Key Lock symbol**...............Indicates the [CONTROL PANEL LOCK] is enabled.
- **Thermometer symbol**.........Indicates the [LIGHT MODE] is forcibly set to [ECO] mode because the internal temperature is too high.
- **HIGH symbol**.....................Indicates the [FAN MODE] is set to [HIGH] mode.
### List of Menu Items

Some menu items are not available depending on the input source.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INPUT</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDMI</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>DisplayPort</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>BNC</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>BNC(Y/C)</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>COMPUTER</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>HDBaseT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SLOT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENTRY LIST</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MODE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PRESET</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>GENERAL</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>REFERENCE</strong></td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td><strong>GAMMA CORRECTION</strong></td>
<td>*1</td>
<td>SELECT [DYNAMIC, NATURAL, BLACK DETAIL]</td>
</tr>
<tr>
<td><strong>SCREEN SIZE</strong></td>
<td>*2</td>
<td>LARGE, MEDIUM, SMALL</td>
</tr>
<tr>
<td><strong>COLOR TEMPERATURE</strong></td>
<td>*3</td>
<td>*</td>
</tr>
<tr>
<td><strong>DYNAMIC CONTRAST</strong></td>
<td>*</td>
<td>OFF, MOTION IMAGE, STILL IMAGE</td>
</tr>
<tr>
<td><strong>ADJUST</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PICTURE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WHITE BALANCE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CONTRAST</strong></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>BRIGHTNESS</strong></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>SHARPNESS</strong></td>
<td>10</td>
<td></td>
</tr>
<tr>
<td><strong>COLOR</strong></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>HUE</strong></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td><strong>RESET</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CLOCK</strong></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td><strong>PHASE</strong></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td><strong>HORIZONTAL</strong></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td><strong>VERTICAL</strong></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td><strong>BLANKING</strong></td>
<td>*</td>
<td>TOP, BOTTOM, LEFT, RIGHT</td>
</tr>
<tr>
<td><strong>OVERSCAN</strong></td>
<td>AUTO</td>
<td>AUTO, 0[%], 5[%], 10[%]</td>
</tr>
<tr>
<td><strong>ASPECT RATIO</strong></td>
<td>AUTO</td>
<td>(COMPONENT/VIDEO/S-VIDEO) AUTO, 4:3, LETTERBOX, WIDE SCREEN, ZOOM</td>
</tr>
<tr>
<td><strong>INPUT RESOLUTION</strong></td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td><strong>VIDEO</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NOISE REDUCTION</strong></td>
<td>RANDOM NR</td>
<td>OFF, OFF, LOW, MEDIUM, HIGH</td>
</tr>
<tr>
<td><strong>DEINTERLACE</strong></td>
<td>NORMAL</td>
<td>NORMAL, NORMAL, MOVIE, STILL</td>
</tr>
<tr>
<td><strong>CONTRAST ENHANCEMENT</strong></td>
<td>MODE</td>
<td>AUTO OFF, AUTO, NORMAL</td>
</tr>
<tr>
<td><strong>SIGNAL TYPE</strong></td>
<td>AUTO</td>
<td>AUTO R, G, B, COMPONENT</td>
</tr>
<tr>
<td><strong>VIDEO LEVEL</strong></td>
<td>AUTO</td>
<td>AUTO AUTO, NORMAL, ENHANCED, SUPER WHITE</td>
</tr>
<tr>
<td><strong>STEREO VIEWER</strong></td>
<td>SINGLE</td>
<td>SINGLE, DUAL LEFT, DUAL RIGHT</td>
</tr>
<tr>
<td><strong>FORMAT</strong></td>
<td>AUTO</td>
<td>AUTO OFF(2D), FRAME PACKING, SIDE BY SIDE(HALF), SIDE BY SIDE(FULL), TOP AND BOTTOM, FRAME ALTERNATIVE, LINE ALTERNATIVE</td>
</tr>
<tr>
<td><strong>L/R INVERT</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>LENS MEMORY</strong></td>
<td>STORE</td>
<td>MOVE, RESET</td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.

1. The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].

2. The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].

3. When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], the [COLOR TEMPERATURE] is not available.
### Menu Item | Default | Options
---|---|---
**SUB INPUT** | OFF | OFF, HDMI, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, HDBaseT, SLOT
**MODE** | PIP | PIP, PICTURE BY PICTURE
**PICTURE SWAP** | OFF | OFF, ON
**PIP SETTING** | START POSITION TOP-LEFT TOP-LEFT, TOP-RIGHT, BOTTOM-LEFT, BOTTOM-RIGHT | HORIZONTAL POSITION VERTICAL POSITION
**BORDER** | SIZE | MEDIUM, LARGE, MEDIUM, SMALL
**DISPLAY** | KEYSTONE | HORIZONTAL, VERTICAL, TILT, THROW RATIO
**GEOMETRIC CORRECTION** | CORNERSTONE | TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER-RIGHT, BOTTOM-LEFT, BOTTOM-CENTER, BOTTOM-RIGHT
**HORIZONTAL CORNER** | TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER-RIGHT, BOTTOM-LEFT, BOTTOM-CENTER, BOTTOM-RIGHT
**VERTICAL CORNER** | TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER-RIGHT, BOTTOM-LEFT, BOTTOM-CENTER, BOTTOM-RIGHT
**PIN CUSHION** | PC TOOL | OFF, 1, 2, 3
**RESET** | OFF | OFF
**EDGE BLENDING** | MODE | OFF OFF, ON
**TOP** | CONTROL | OFF OFF, ON
**MARKER** | OFF OFF, ON
**RANGE** | POSITION |
**BOTTOM** | CONTROL | OFF OFF, ON
**MARKER** | OFF OFF, ON
**RANGE** | POSITION |
**LEFT** | CONTROL | OFF OFF, ON
**MARKER** | OFF OFF, ON
**RANGE** | POSITION |
**RIGHT** | CONTROL | OFF OFF, ON
**MARKER** | OFF OFF, ON
**RANGE** | POSITION |
**BLACK LEVEL** | TOP-LEFT | TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER-RIGHT, BOTTOM-LEFT, BOTTOM-CENTER, BOTTOM-RIGHT
**WHITE BALANCE** | MODE | OFF OFF, ON
**CONTRAST W** | CONTRAST R | CONTRAST G
**CONTRAST B** | BRIGHTNESS W | BRIGHTNESS R
**BRIGHTNESS G** | BRIGHTNESS B |
**MULTI SCREEN** | PICTURE SETTING | MODE | OFF OFF, ZOOM, TILING
**ZOOM** | HORIZONTAL ZOOM | VERTICAL ZOOM
**HORIZONTAL POSITION** | VERTICAL POSITION |
**TILING** | WIDTH | 1 UNIT, 2 UNITS, 3 UNITS, 4 UNITS
**HEIGHT** | 1 UNIT, 2 UNITS, 3 UNITS, 4 UNITS
**HORIZONTAL POSITION** | 1st UNIT, 2nd UNIT, 3rd UNIT, 4th UNIT
**VERTICAL POSITION** | 1st UNIT, 2nd UNIT, 3rd UNIT, 4th UNIT
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LANGUAGE</strong></td>
<td>ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, SVENSKA, 日本語, DANSK, PORTUGUÊS, ČEŠTINA, MAGYAR, POLSKI, NEDERLANDS, SUOMI, NORSK, TÜRKÇE, ROMANA, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, 繁體中文, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी,-printed characters, 日本語, DANSK, PORTUGUÊS, ČEŠTINA, MAGYAR, POLSKI, NEDERLANDS, SUOMI, NORSK, TÜRKÇE, ROMANA, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, 繁體中文, HRVATSKA, БЪЛГАРСКИ, INDONESIA, हिन्दी, 繁體中文</td>
</tr>
<tr>
<td><strong>COLOR SELECT</strong></td>
<td>COLOR, MONOCHROME</td>
</tr>
<tr>
<td><strong>INPUT DISPLAY</strong></td>
<td>ON, OFF, ON</td>
</tr>
<tr>
<td><strong>MESSAGE DISPLAY</strong></td>
<td>ON, OFF, ON</td>
</tr>
<tr>
<td><strong>ID DISPLAY</strong></td>
<td>ON, OFF, ON</td>
</tr>
<tr>
<td><strong>3D CAUTION MESSAGE</strong></td>
<td>AUTO 45 SEC, MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC</td>
</tr>
<tr>
<td><strong>DISPLAY TIME</strong></td>
<td>AUTO 45 SEC, MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC</td>
</tr>
<tr>
<td><strong>FILTER MESSAGE</strong></td>
<td>OFF, 100[H], 500[H], 1000[H], 2000[H], 5000[H], 10000[H], 20000[H]</td>
</tr>
<tr>
<td><strong>ORIENTATION</strong></td>
<td>DESKTOP FRONT, CEILING REAR, DESKTOP REAR, CEILING REAR</td>
</tr>
<tr>
<td><strong>SCREEN TYPE</strong></td>
<td>FREE, 4:3 SCREEN, 16:9 SCREEN, 16:10 SCREEN</td>
</tr>
<tr>
<td><strong>WALL COLOR</strong></td>
<td>OFF, WHITEBOARD, BLACKBOARD, BLACKBOARD (GRAY), LIGHT YELLOW, LIGHT GREEN, LIGHT BLUE, SKY BLUE, LIGHT ROSE, PINK</td>
</tr>
<tr>
<td><strong>FAN MODE</strong></td>
<td>AUTO, HIGH</td>
</tr>
<tr>
<td><strong>LIGHT MODE</strong></td>
<td>NORMAL, ECO1, ECO2, LONG LIFE</td>
</tr>
<tr>
<td><strong>ADJUST</strong></td>
<td>30–100%</td>
</tr>
<tr>
<td><strong>SHUTTER SETTINGS</strong></td>
<td>POWER ON SHUTTER OPEN, CLOSE, PICTURE MUTE SHUTTER OPEN, CLOSE, FADE IN TIME 0–10 SEC, FADE OUT TIME 0–10 SEC</td>
</tr>
<tr>
<td><strong>REF. WHITE BALANCE</strong></td>
<td>CONTRAST R, CONTRAST G, BRIGHTNESS R, BRIGHTNESS G, UNIFORMITY R, UNIFORMITY B</td>
</tr>
<tr>
<td><strong>REF. LENS MEMORY</strong></td>
<td>PROFILE 1, 1.2, STORE, MOVE, RESET, LOAD BY SIGNAL OFF, ON, FORCED MUTE OFF, ON</td>
</tr>
<tr>
<td><strong>LENS CALIBRATION</strong></td>
<td></td>
</tr>
</tbody>
</table>

---

**Note:** The table above lists the default options for each menu item. The options provided may vary depending on the specific model of the projector.
### 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ADMINISTRATOR MODE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu Mode</td>
<td>ADVANCED</td>
<td>ADVANCED, BASIC</td>
</tr>
<tr>
<td>Not Save Setting Values</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>New Password</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Confirm Password</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PROGRAM TIMER</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>TOOLS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Zone Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date And Time Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>MM/DD/YYYY</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>HH:MM</td>
<td></td>
</tr>
<tr>
<td>Internet Time Server</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Ip Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SETUP</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date And Time Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summer Time Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Mon (Start)</td>
<td>1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12</td>
<td></td>
</tr>
<tr>
<td>Day (Start)</td>
<td>First Week, Second Week, Third Week, Fourth Week, Last Week</td>
<td></td>
</tr>
<tr>
<td>Time (Start)</td>
<td>Sun, Mon, Tue, Wed, Thu, Fri, Sat</td>
<td></td>
</tr>
<tr>
<td>Mon (Exit)</td>
<td>1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12</td>
<td></td>
</tr>
<tr>
<td>Day (Exit)</td>
<td>First Week, Second Week, Third Week, Fourth Week, Last Week</td>
<td></td>
</tr>
<tr>
<td>Time (Exit)</td>
<td>Sun, Mon, Tue, Wed, Thu, Fri, Sat</td>
<td></td>
</tr>
<tr>
<td>Time Difference +01:00</td>
<td>+00:30, -00:30, -01:00</td>
<td></td>
</tr>
<tr>
<td><strong>CONTROL</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Panel Lock</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Notification Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rear Led</td>
<td>ON</td>
<td>ON, OFF</td>
</tr>
<tr>
<td>Buzzer</td>
<td>ON</td>
<td>ON, OFF</td>
</tr>
<tr>
<td>Security</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Communication Speed</td>
<td>38400bps</td>
<td>48000bps, 96000bps, 192000bps, 384000bps, 1152000bps</td>
</tr>
<tr>
<td>Control Id</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Id Number</td>
<td>1</td>
<td>1–254</td>
</tr>
<tr>
<td>Remote Sensor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensor</td>
<td>FRONT/BACK, FRONT, BACK, HDBaseT</td>
<td></td>
</tr>
<tr>
<td>Lens Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensor</td>
<td>WITH SENSOR</td>
<td>WITH SENSOR, WITHOUT SENSOR</td>
</tr>
</tbody>
</table>
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WIRED LAN</strong></td>
<td></td>
</tr>
<tr>
<td>Profiles</td>
<td>DISABLE, PROFILE 1, PROFILE 2</td>
</tr>
<tr>
<td>DHCP</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>IP Address</td>
<td>192.168.0.10</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Gateway</td>
<td>192.168.0.1</td>
</tr>
<tr>
<td>Auto DNS</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>DNS Configuration</td>
<td></td>
</tr>
<tr>
<td>Reconnect</td>
<td></td>
</tr>
<tr>
<td>Projector Name</td>
<td>PH1202HL Series</td>
</tr>
<tr>
<td>Domain</td>
<td></td>
</tr>
<tr>
<td>Host Name</td>
<td>necpj</td>
</tr>
<tr>
<td>Domain Name</td>
<td></td>
</tr>
<tr>
<td><strong>NETWORK SETTINGS</strong></td>
<td></td>
</tr>
<tr>
<td>Alert Mail</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Host Name</td>
<td></td>
</tr>
<tr>
<td>Domain Name</td>
<td></td>
</tr>
<tr>
<td>Sender’s Address</td>
<td></td>
</tr>
<tr>
<td>SMTP Server Name</td>
<td></td>
</tr>
<tr>
<td>Recipient’s Address 1</td>
<td></td>
</tr>
<tr>
<td>Recipient’s Address 2</td>
<td></td>
</tr>
<tr>
<td>Recipient’s Address 3</td>
<td></td>
</tr>
<tr>
<td>Test Mail</td>
<td></td>
</tr>
<tr>
<td><strong>NETWORK SERVICE</strong></td>
<td></td>
</tr>
<tr>
<td>HTTP Server</td>
<td>NEW PASSWORD</td>
</tr>
<tr>
<td>PJLink</td>
<td>CONFIRM PASSWORD</td>
</tr>
<tr>
<td>AMX</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Crestron</td>
<td>ROOMVIEW OFF, ON</td>
</tr>
<tr>
<td>Crestron Control (Enable, Controller IP Address, IP ID)</td>
<td></td>
</tr>
<tr>
<td><strong>SOURCE OPTIONS</strong></td>
<td></td>
</tr>
<tr>
<td>AUTO Adjust</td>
<td>NORMAL, OFF, NORMAL, FINE</td>
</tr>
<tr>
<td>Color System</td>
<td>AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SEACAM</td>
</tr>
<tr>
<td>BNC (Y/C)</td>
<td>AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SEACAM</td>
</tr>
<tr>
<td>Default Input Select</td>
<td>LAST, AUTO, HDMI, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, HDBaseT, SLOT</td>
</tr>
<tr>
<td>Seamless Switching</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Closed Caption</td>
<td>OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, TEXT1, TEXT2, TEXT3, TEXT4</td>
</tr>
<tr>
<td>Background</td>
<td>BLUE, BLACK, LOGO</td>
</tr>
<tr>
<td><strong>POWER OPTIONS</strong></td>
<td></td>
</tr>
<tr>
<td>Standby Mode</td>
<td>NORMAL, OFF, NORMAL, HDBaseT STANDBY</td>
</tr>
<tr>
<td>Direct Power On</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Auto Power On Select</td>
<td>OFF, OFF, HDMI, DisplayPort, COMPUTER, HDBaseT, SLOT</td>
</tr>
<tr>
<td>Auto Power Off</td>
<td>1:00, 0:05, 0:10, 0:15, 0:20, 0:30, 1:00</td>
</tr>
<tr>
<td>Off Timer</td>
<td>OFF, 0:30, 1:30, 2:30, 4:30, 8:30, 12:30, 16:30</td>
</tr>
<tr>
<td>Slot Power</td>
<td>PROJECTOR ON, OFF, ON</td>
</tr>
<tr>
<td>PROJECTOR STANDBY</td>
<td>ENABLE, DISABLE, ENABLE</td>
</tr>
<tr>
<td><strong>RESET</strong></td>
<td></td>
</tr>
<tr>
<td>Current Signal</td>
<td></td>
</tr>
<tr>
<td>All Data</td>
<td></td>
</tr>
<tr>
<td>All Data (Including Entry List)</td>
<td></td>
</tr>
<tr>
<td>Clear Filter Hours</td>
<td></td>
</tr>
<tr>
<td>Menu Item</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>USAGE TIME</td>
<td>LIGHT HOURS USED</td>
</tr>
<tr>
<td></td>
<td>FILTER HOURS USED</td>
</tr>
<tr>
<td></td>
<td>TOTAL CARBON SAVINGS</td>
</tr>
<tr>
<td>SOURCE(1)</td>
<td>INPUT TERMINAL</td>
</tr>
<tr>
<td></td>
<td>RESOLUTION</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL FREQUENCY</td>
</tr>
<tr>
<td></td>
<td>VERTICAL FREQUENCY</td>
</tr>
<tr>
<td></td>
<td>SYNC TYPE</td>
</tr>
<tr>
<td></td>
<td>SYNC POLARITY</td>
</tr>
<tr>
<td></td>
<td>SCAN TYPE</td>
</tr>
<tr>
<td></td>
<td>SOURCE NAME</td>
</tr>
<tr>
<td></td>
<td>ENTRY NO.</td>
</tr>
<tr>
<td>SOURCE(2)</td>
<td>SIGNAL TYPE</td>
</tr>
<tr>
<td></td>
<td>VIDEO TYPE</td>
</tr>
<tr>
<td></td>
<td>BIT DEPTH</td>
</tr>
<tr>
<td></td>
<td>VIDEO LEVEL</td>
</tr>
<tr>
<td></td>
<td>LINK RATE</td>
</tr>
<tr>
<td></td>
<td>LINK LANE</td>
</tr>
<tr>
<td>SOURCE(3)</td>
<td>INPUT TERMINAL</td>
</tr>
<tr>
<td></td>
<td>RESOLUTION</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL FREQUENCY</td>
</tr>
<tr>
<td></td>
<td>VERTICAL FREQUENCY</td>
</tr>
<tr>
<td></td>
<td>SYNC TYPE</td>
</tr>
<tr>
<td></td>
<td>SYNC POLARITY</td>
</tr>
<tr>
<td></td>
<td>SCAN TYPE</td>
</tr>
<tr>
<td></td>
<td>SOURCE NAME</td>
</tr>
<tr>
<td></td>
<td>ENTRY NO.</td>
</tr>
<tr>
<td>SOURCE(4)</td>
<td>SIGNAL TYPE</td>
</tr>
<tr>
<td></td>
<td>VIDEO TYPE</td>
</tr>
<tr>
<td></td>
<td>BIT DEPTH</td>
</tr>
<tr>
<td></td>
<td>VIDEO LEVEL</td>
</tr>
<tr>
<td></td>
<td>LINK RATE</td>
</tr>
<tr>
<td></td>
<td>LINK LANE</td>
</tr>
<tr>
<td>WIRED LAN</td>
<td>IP ADDRESS</td>
</tr>
<tr>
<td></td>
<td>SUBNET MASK</td>
</tr>
<tr>
<td></td>
<td>GATEWAY</td>
</tr>
<tr>
<td></td>
<td>MAC ADDRESS</td>
</tr>
<tr>
<td>VERSION(1)</td>
<td>FIRMWARE</td>
</tr>
<tr>
<td></td>
<td>DATA</td>
</tr>
<tr>
<td>VERSION(2)</td>
<td>FIRMWARE3</td>
</tr>
<tr>
<td>OTHERS</td>
<td>DATE TIME</td>
</tr>
<tr>
<td></td>
<td>PROJECTOR NAME</td>
</tr>
<tr>
<td></td>
<td>MODEL NO</td>
</tr>
<tr>
<td></td>
<td>SERIAL NUMBER</td>
</tr>
<tr>
<td></td>
<td>CONTROL ID (when [CONTROL ID] is set)</td>
</tr>
<tr>
<td>CONDITIONS</td>
<td>INTAKE TEMPERATURE</td>
</tr>
<tr>
<td></td>
<td>EXHAUST TEMPERATURE</td>
</tr>
<tr>
<td></td>
<td>ATMOSPHERIC PRESSURE</td>
</tr>
<tr>
<td>HDBaseT</td>
<td>SIGNAL QUALITY</td>
</tr>
<tr>
<td></td>
<td>OPERATION MODE</td>
</tr>
<tr>
<td></td>
<td>LINK STATUS</td>
</tr>
<tr>
<td></td>
<td>HDMI STATUS</td>
</tr>
</tbody>
</table>
HDMI
This projects the video of the device connected to the HDMI IN terminal.

DisplayPort
This projects the video of the device connected to the Display Port IN terminal.

BNC
This projects the video of the device connected to the video input terminal.
(This projects the analog RGB signal or component signal.)

BNC(CV)
This projects the video of the device connected to the BNC (CV) video input terminal.
(This projects the composite video signal.)

BNC(Y/C)
This projects the video of the device connected to the BNC (Y/C) video input terminal.
(This projects the S-video signal.)

COMPUTER
This projects the video of the device connected to the COMPUTER IN terminal.
(This projects the analog RGB signal or component signal.)

HDBaseT
Projecting the HDBaseT or WIRED LAN signal.

SLOT
Projects the picture via the optional board (sold separately) inserted into the SLOT.

ENTRY LIST
Displays a list of signals. See the following pages.

TEST PATTERN
Closes the menu and switches to the test pattern screen.
Select the pattern using the ◀▶ buttons.
Using the Entry List

When you save [IMAGE OPTIONS] and [LENS MEMORY], the adjusted values of the signal are automatically saved to the projector’s [ENTRY LIST]. When needed, the stored signal adjusted values can be accessed from the [ENTRY LIST]. However, only up to 100 patterns can be registered in the Entry List. When 100 patterns have been registered in the Entry List, an error message is then displayed and no additional patterns can be registered. You should thus delete (adjustment values of) signals that are no longer needed.

Displaying the Entry List

1. **Press the MENU button.**
   The menu will be displayed.

2. **Press the ◄ or ► button to select [INPUT].**
   The INPUT list will be displayed.

3. **Use the ◄, ►, ▲, or ▼ to select [ENTRY LIST] and press the ENTER button.**
   The ENTRY LIST windows will be displayed.
   If the ENTRY LIST window is not displayed, switch the menu to [ADVANCED].
   To switch the menu between [ADVANCED] and [BASIC], select [SETUP] → [CONTROL] → [TOOLS] → [ADMINISTRATOR MODE] → [MENU MODE]. (→ page 107)
5. Using On-Screen Menu

Entering the currently projected signal into the Entry List [STORE]

1. **Press the ▲ or▼ button to select any number.**
2. **Press the ◀ or▶ button to select [STORE] and press the ENTER button.**

### ENTRY LIST

<table>
<thead>
<tr>
<th>NO.</th>
<th>SOURCE NAME</th>
<th>RESOLUTION</th>
<th>INPUT</th>
<th>LOCK</th>
<th>SKIP</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>1280×1024 60Hz</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>002</td>
<td>NTSC358</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>003</td>
<td>AAA</td>
<td>1024 x 768</td>
<td>HDMI</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>004</td>
<td>004</td>
<td>1024 x 768</td>
<td>HDBaseT</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>005</td>
<td>005</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>006</td>
<td>006</td>
<td>1024 x 768</td>
<td>SLOT</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>007</td>
<td>007</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>008</td>
<td>008</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>009</td>
<td>009</td>
<td>1024 x 768</td>
<td>HDMI</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>010</td>
<td>010</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>011</td>
<td>011</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>012</td>
<td>012</td>
<td>1024 x 768</td>
<td>HDMI</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>013</td>
<td>013</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

**Calling up a signal from the Entry List [LOAD]**

Press the ▲ or▼ button to select a signal and press the ENTER button.

**Editing a signal from the Entry List [EDIT]**

1. **Press the ▲ or▼ button to select a signal you wish to edit.**
2. **Press the ◀,▶,▲, or▼ button to select [EDIT] and press the ENTER button.**

   The Edit window will be displayed.

   **SOURCE NAME**
   Enter a signal name. Up to 18 alphanumeric characters can be used.

   **INPUT**
   The input terminal can be changed. Switching between HDMI/DisplayPort/BNC/BNC (CV)/BNC (Y/C)/Computer/HDBaseT/SLOT is possible.

   **LOCK**
   Set so that the selected signal cannot be deleted when [ALL DELETE] is executed. The changes made after LOCK execution cannot be saved.

   **SKIP**
   Set so that the selected signal will be skipped during auto search.

3. **Set the above items and select [OK] and press the ENTER button.**

   **NOTE:** The input terminal cannot be changed to the currently projected signal.
5. Using On-Screen Menu

Cutting a signal from the Entry List [CUT]

1. Press the ▲ or ▼ button to select a signal you wish to delete.
2. Press the ◀, ▶, ▲, or ▼ button to select [CUT] and press the ENTER button.
   The signal will be deleted from the Entry List and the deleted signal will be displayed on the clipboard at the bottom of the Entry List.

NOTE:
- The currently projected signal cannot be deleted.
- When the locked signal is selected, it will be displayed in gray which indicates it is not available.

TIP:
- Data on the clipboard can be passed onto the Entry List.
- Data on the clipboard will not be lost after the Entry List is closed.

Copying and pasting a signal from the Entry List [COPY] / [PASTE]

1. Press the ▲ or ▼ button to select a signal you wish to copy.
2. Press the ◀, ▶, ▲, or ▼ button to select [COPY] and press the ENTER button.
   The copied signal will be displayed on the clipboard at the bottom of the Entry List.
3. Press the ◀ or ▶ button to move to the list.
4. Press the ▲ or ▼ button to select a signal.
5. Press the ◀, ▶, ▲, or ▼ button to select [PASTE] and press the ENTER button.
   Data on the clipboard will be pasted to the signal.

Deleting all the signals from the Entry List [ALL DELETE]

1. Press the ◀, ▶, ▲, or ▼ button to select [ALL DELETE] and press the ENTER button.
   The confirmation message will be displayed.
2. Press the ◀ or ▶ button to select [YES] and press the ENTER button.

NOTE: The locked signal cannot be deleted.
5. Using On-Screen Menu

4 Menu Descriptions & Functions [ADJUST]

[PICTURE]

This function allows you to determine how to save settings for [DETAIL SETTINGS] of [PRESET] for each input.

STANDARD............. Saves settings for each item of [PRESET] (Preset 1 through 7)
PROFESSIONAL....... Saves all the settings of [PICTURE] for each input.

NOTE:
• When [TEST PATTERN] is displayed, [MODE] cannot be selected.

[MODE]

This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta.
There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set
user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 7].

HIGH-BRIGHT......... Recommended for use in a brightly lit room.
PRESENTATION ...... Recommended for making a presentation using a PowerPoint file.
VIDEO.................. Recommended for typical TV program viewing.
MOVIE.................. Recommended for movies.
GRAPHIC............... Recommended for graphics.
sRGB.................. Standard color values
DICOM SIM........... Recommended for DICOM simulation format.

NOTE:
• The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
• DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiology (ACR) and the National Electrical Manufacturers Association (NEMA).
  The standard specifies how digital image data can be moved from system to system.
• Adjustment may not work depending on input signal.
5. Using On-Screen Menu

[DETAIL SETTINGS]

[GENERAL]

Storing Your Customized Settings [REFERENCE]

This function allows you to store your customized settings in [PRESET 1] to [PRESET 7]. First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE].

- HIGH-BRIGHT....... Recommended for use in a brightly lit room.
- PRESENTATION ..... Recommended for making a presentation using a PowerPoint file.
- VIDEO.................. Recommended for typical TV program viewing.
- MOVIE ................. Recommended for movies.
- GRAPHIC............... Recommended for graphics.
- sRGB .................. Standard color values.
- DICOM SIM. .......... Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]

Each mode is recommended for:

<table>
<thead>
<tr>
<th>SELECT</th>
<th>DYNAMIC</th>
<th>Creates a high-contrast picture.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NATURAL</td>
<td>Standard settings. Settings can be adjusted to suit the picture being projected.</td>
</tr>
<tr>
<td></td>
<td>BLACK DETAIL</td>
<td>Emphasizes detail in dark areas of the picture.</td>
</tr>
</tbody>
</table>

NATURAL SETTING: After selecting [NATURAL] you can adjust the settings. Adjust them using the ▼/▼ buttons.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]

This function will perform gamma correction appropriate for the screen size.

- LARGE ............... For screen size of 150”
- MEDIUM ............. For screen size of 100”
- SMALL............... For screen size of 50”

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].
5. Using On-Screen Menu

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice. A value between 5000 K and 10500 K can be set in 100 K units.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
Select [MOTION IMAGE] or [STILL IMAGE] depending on the picture you wish to project, and the contrast ration will be adjusted to the optimum value.

NOTE: Depending on the conditions, projector settings such as [DYNAMIC CONTRAST] may not be able to be selected.

Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; Brightness for each color (RGB) is used to adjust the black level of the screen.

[COLOR CORRECTION]
Corrects the color for all signals. Adjusts the tone for the colors red, green, blue, yellow, magenta and cyan.

<table>
<thead>
<tr>
<th></th>
<th>RED</th>
<th>GREEN</th>
<th>BLUE</th>
<th>YELLOW</th>
<th>MAGENTA</th>
<th>CYAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>HUE</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
</tr>
<tr>
<td></td>
<td>− Direction</td>
<td>− Direction</td>
<td>− Direction</td>
<td>− Direction</td>
<td>− Direction</td>
<td>− Direction</td>
</tr>
<tr>
<td>SATURATION</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
<td>+ Direction</td>
</tr>
<tr>
<td></td>
<td>Magenta direction</td>
<td>Yellow direction</td>
<td>Cyan direction</td>
<td>Magenta direction</td>
<td>Blue direction</td>
<td>Green direction</td>
</tr>
<tr>
<td></td>
<td>Yellow direction</td>
<td>Magenta direction</td>
<td>Cyan direction</td>
<td>Red direction</td>
<td>Blue direction</td>
<td>Green direction</td>
</tr>
<tr>
<td></td>
<td>Vivid</td>
<td>Weak</td>
<td>Weak</td>
<td>Vivid</td>
<td>Weak</td>
<td>Vivid</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

(COLOR]
Increases or decreases the color saturation level.
5. Using On-Screen Menu

[HUE]
Varies the color level from +/- green to +/- blue. The red level is used as reference.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>CONTRAST</th>
<th>BRIGHTNESS</th>
<th>SHARPNESS</th>
<th>COLOR</th>
<th>HUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB system of “COMPUTER/DisplayPort/HDMI/HDBaseT”</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>COMPONENT system of “COMPUTER/DisplayPort/HDMI/HDBaseT”</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Composite Video/S-Video</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Yes = Adjustable, No = Not adjustable

**NOTE:**
- When [TEST PATTERN] is displayed, [CONTRAST], [BRIGHTNESS], [SHARPNESS], [COLOR] and [HUE] cannot be adjusted.

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected will not be reset.
Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK ................. Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be necessary when you connect your computer for the first time.

PHASE ................. Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident when part of your image appears to be shimmering.) Use [PHASE] only after the [CLOCK] is complete.

NOTE: The [CLOCK] and [PHASE] items are available for RGB signals only.
Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]

Adjusts the image location horizontally and vertically.

- An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.
- The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, its adjustments will be called up and applied.
  To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] and reset the adjustments.

[BLANKING]

Adjusts the display range (blanking) at the top, bottom, left and right edges of the input signal.

Selecting Overscan Percentage [OVERSCAN]

Select overscan percentage (Auto, 0%, 5% and 10%) for signal.

NOTE:

- The [OVERSCAN] item is not available:
  - when [NATIVE] is selected for [ASPECT RATIO].
5. Using On-Screen Menu

Selecting the Aspect Ratio [ASPECT RATIO]

Use this function to select the screen's vertical:horizontal aspect ratio. Select the screen type (4:3 screen, 16:9 screen or 16:10 screen) at the screen setting before setting the aspect ratio. (→ page 104)

The projector automatically identifies the signal being input and sets the optimum aspect ratio.

For Computer signal

![ASPECT RATIO](image)

For Component/Video/S-Video signals

When the screen type is set to 4:3

![ASPECT RATIO](image)

When the screen type is set to 16:9 or 16:10

![ASPECT RATIO](image)

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 x 480</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 x 600</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 x 768</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1280 x 800</td>
</tr>
<tr>
<td>HD(FWXGA)</td>
<td>1366 x 768</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 x 900</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 x 1024</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 x 1050</td>
</tr>
<tr>
<td>WXGA+++</td>
<td>1600 x 900</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 x 1200</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 x 1050</td>
</tr>
<tr>
<td>FHD(1080P)</td>
<td>1920 x 1080</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 x 1200</td>
</tr>
<tr>
<td>WQXGA</td>
<td>2560 x 1600</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>The projector will automatically determine the incoming signal and display it in its aspect ratio. The projector may erroneously determine the aspect ratio depending on its signal. If this occurs, select the appropriate aspect ratio from the following.</td>
</tr>
<tr>
<td>4:3</td>
<td>The image is displayed in 4:3 aspect ratio.</td>
</tr>
<tr>
<td>5:4</td>
<td>The image is displayed in 5:4 aspect ratio</td>
</tr>
<tr>
<td>16:9</td>
<td>The image is displayed in 16:9 aspect ratio</td>
</tr>
<tr>
<td>15:9</td>
<td>The image is displayed in 15:9 aspect ratio</td>
</tr>
<tr>
<td>16:10</td>
<td>The image is displayed in 16:10 aspect ratio</td>
</tr>
</tbody>
</table>
### Table: Options and Function

<table>
<thead>
<tr>
<th>Options</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>NATIVE</td>
<td>The projector displays the current image in its true resolution when the incoming computer signal has a lower or higher resolution than the projector's native resolution. (→ page 164) When the incoming computer signal has a higher resolution than the projector's native resolution, the center of an image will be displayed.</td>
</tr>
<tr>
<td>LETTER BOX</td>
<td>The image of a letterbox signal (16:9) is stretched equally in the horizontal and vertical directions to fit the screen.</td>
</tr>
<tr>
<td>WIDE SCREEN</td>
<td>The image of a squeeze signal (16:9) is stretched left and right in 16:9.</td>
</tr>
<tr>
<td>ZOOM</td>
<td>The image of a squeeze signal (16:9) is stretched left and right in 4:3. Parts of the displayed image are cropped at the left and right edges and therefore not visible.</td>
</tr>
<tr>
<td>FULL</td>
<td>Project to full screen size.</td>
</tr>
</tbody>
</table>

**Tip:**
- Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
- The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect ratio for a video source.
  - The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
- The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

**[INPUT RESOLUTION]**
The resolution is assigned automatically when the resolution of the input signal from the computer video input terminal or BNC video input terminal (analog RGB) cannot be distinguished.
Using Noise Reduction [NOISE REDUCTION]
When projecting a video image, you can use the [NOISE REDUCTION] function to reduce the screen noise (roughness and distortion). This device is equipped with three types of noise reduction functions. Select the function according to the type of noise. Depending on the noise level, the noise reduction effect can be set to [OFF], [LOW], [MEDIUM] or [HIGH]. [NOISE REDUCTION] can be selected for SDTV, HDTV signal and component signal input.

- RANDOM NR ............ Reduces flickering random noise in an image.
- MOSQUITO NR .......... Reduces mosquito noise that appears around the edges of an image during Blu-ray playback.
- BLOCK NR ............... Reduces block noise or mosaic-like patterns by selecting ON.

Selecting Interlaced Progressive Conversion Process Mode [DEINTERLACE]
This function allows you to select an interlaced-to-progressive conversion process for video signals.

- NORMAL ................ Automatically distinguishes a moving image from a static image to create a distinct image. Please select [MOVIE] if there are any obvious jitter and noises.
- MOVIE .................. Select when projecting moving images. This is suitable for signals with a lot of jitter and noise.
- STILL .................... Select when projecting static images. The video will flicker when a moving image is projected.

**NOTE:** This function is not available with RGB signals.

[CONTRAST ENHANCEMENT]
Using the characteristics of the human eye, a picture quality with a sense of contrast and resolution is achieved.

- OFF ..................... Suite vision is switched off.
- AUTO .................... Contrast and picture quality are automatically improved using the suite vision function.
- NORMAL ............... Adjust the gain manually.
5. Using On-Screen Menu

[SIGNAL TYPE]
Selection of RGB and component signals. Normally, this is set to [AUTO]. Please change the setting if the color of the image remains unnatural.

- AUTO .................. Automatically distinguishes RGB and component signals.
- RGB ................... Switches to the RGB input.
- COMPONENT .......... Switches to the component signal input.

[VIDEO LEVEL]
Selection of the video signal level when connecting an external device to the HDMI IN terminal, DisplayPort input terminal, and HDBaseT input terminal of the projector.

- AUTO .................. The video level is switched automatically based on the information from the device outputting the signal.
  Depending on the connected device, this setting may not be made properly. In this case, switch to [NORMAL” or “ENHANCED” from the menu and view with the optimum setting.
- NORMAL............... This disables the enhanced mode.
- ENHANCED .......... This improves the image’s contrast, expressing the dark and light sections more dynamically.
- SUPER WHITE ....... The video contrast is improved and the dark areas appear more dynamic.
Please refer to “3-11 Projecting 3D videos” (→ page 40) for the operation.

**STEREO VIEWER**

Adjusting the settings for projecting a 3D picture with one or multiple projectors. For 3D glasses right-eye and left-eye settings, select [STEREO VIEWER].

- **SINGLE** ................. Use a single projector to project 3D videos.
- **DUAL LEFT** .............. Use a dedicated projector for displaying videos on the left.
- **DUAL RIGHT** ............ Use a dedicated projector for displaying videos on the right.

**FORMAT**

Select the 3D video format (recording / transmission format). Select to match the 3D broadcast and 3D media. Normally, [AUTO] is selected. Please select the 3D input signal format when the 3D detection signal of the format cannot be distinguished.

**L/R INVERT**

Invert the display order of the left and right videos.
Select [ON] if you feel uncomfortable with the 3D display when [OFF] is selected.
Using the Lens Memory Function [LENS MEMORY]

This function serves to store the adjusted values for each input signal when using the LENS SHIFT, ZOOM and FOCUS buttons of the projector. Adjusted values can be applied to the signal you selected. This will eliminate the need to adjust lens shift, focus, and zoom at the time of source selection.

STORE .................. Stores the current adjusted values in memory for each input signal.
MOVE ................... Applies the adjusted values to the current signal.
RESET ................... Returns the adjusted values to the last condition.

NOTE:
• The lens shift, zoom, and focus adjustments can be performed with the remote control. (→ page 23, 24)
• To store adjusted values common to all the input sources, use the REF. LENS MEMORY function. See page 49, 106.
• Lens memory adjustments will be automatically registered the ENTRY LIST. These lens memory adjustments can be loaded from the ENTRY LIST. (→ page 78)

Note that performing [CUT] or [ALL DELETE] in the ENTRY LIST will delete lens memory adjustments as well as source adjustments. This deletion will not take effect until other adjustments is loaded.
5. Using On-Screen Menu

5. Menu Descriptions & Functions [DISPLAY]

[PIP/PICTURE BY PICTURE]

SUB INPUT
Select the input signal to be displayed in the sub-display. Please refer to “4-2 Displaying Two Pictures at the Same Time” (→ page 58) for details on the operation.

MODE
Select either PIP or PICTURE BY PICTURE when switching to 2-screen display.

PICTURE SWAP
The videos in the main display and sub-display will be switched. Please refer to “4-2 Displaying Two Pictures at the Same Time” (→ page 58) for details.

PIP SETTING
Select the display position, position adjustment and size of the sub-display in the PIP screen.

START POSITION... Selection of the display position of the sub-display when switching to the PIP screen.
HORIZONTAL POSITION
.............................. Adjust the display position of the sub-display in the horizontal direction. The respective corners will serve as reference points.

VERTICAL POSITION
.............................. Adjust the display position of the sub-display in the vertical direction. The respective corners will serve as reference points.

SIZE....................... Select the display size of the sub-display.
TIP:
The horizontal position and vertical position are the amount of movement from the reference points. For example, when TOP-LEFT is adjusted, the position is displayed with the same amount of movement even if displayed with other starting positions. The maximum amount of movement is half the resolution of the projector.

BORDER
Select the display boundary of the main display and sub-display of the [PICTURE BY PICTURE] screen.

TIP:
• 6 steps can be selected on this projector.
5. Using On-Screen Menu

[GEOMETRIC CORRECTION]

Display the trapezoid correction screen and adjust the trapezoidal distortion of the projection screen.

To display the [KEYSTONE] screen, select [DISPLAY] → [GEOMETRIC CORRECTION] → [KEYSTONE] in the on-screen menu. The [GEOMETRIC CORRECTION] screen can also be displayed by pressing the 3D REFORM button on the projector or on the remote control.

HORIZONTAL. Adjustments when projecting from a diagonal direction to the screen.

VERTICAL. Adjustments when projecting from the top or bottom direction to the screen.

TILT. Adjusts the distortion when performing trapezoidal correction with the screen moved in the vertical direction using the lens shift.

THROW RATIO. Adjusts according to the projection ratio of the optional lens used.

<table>
<thead>
<tr>
<th>Model name of lens unit</th>
<th>Adjustment range</th>
</tr>
</thead>
<tbody>
<tr>
<td>NP-9LS12ZM1</td>
<td>12–19</td>
</tr>
<tr>
<td>NP-9LS13ZM1</td>
<td>14–23</td>
</tr>
<tr>
<td>NP-9LS16ZM1</td>
<td>17–29</td>
</tr>
<tr>
<td>NP-9LS08ZM1</td>
<td>8–14</td>
</tr>
</tbody>
</table>

NOTE:

- When power is supplied to the device, the adjustment value of the [KEYSTONE] used previously is retained even if the gradient of the device is changed.
- When clearing the adjustment value of [KEYSTONE], press the 3D REFORM button for 2 or more seconds.
- When setting other [GEOMETRIC CORRECTION] functions, the [KEYSTONE] menu cannot be selected. When performing trapezoidal correction, press the 3D REFORM button for 2 or more seconds to clear the adjustment value of [GEOMETRIC CORRECTION].
- As electrical correction is carried out by [KEYSTONE], the brightness may be reduced or the screen quality may deteriorate sometimes.
CORNERSTONE
Display the 4-point correction screen and adjust the trapezoidal distortion of the projection screen. Please refer to “Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE]” (→ page 34) for details on the operation.

HORIZONTAL CORNER/VERTICAL CORNER
Distortion correction for corner projection such as wall surfaces.

HORIZONTAL CORNER
.............................. Performs correction for projection onto a wall lying at an angle to the horizontal direction.

* Reverse angle correction is also possible.

VERTICAL CORNER
.............................. Performs correction for projection onto a wall lying at an angle to the vertical direction.

* Reverse angle correction is also possible.

NOTE:
• When the maximum adjustment range is exceeded, distortion adjustment is disabled. Set up the projector at an optimal angle as the deterioration in the image quality increases as the distortion adjustment volume gets larger.
• Please note that the image will go out of focus due to the difference in the distance between the upper and lower or left and right sides and the center of the screen for projections cutting across corners. Lenses with short focal points are also not recommended for projections cutting across corners as the image will go out of focus.
5. Using On-Screen Menu

Adjustment method
1. Align the cursor with the [HORIZONTAL CORNER] or [VERTICAL CORNER] of the [GEOMETRIC CORRECTION] menu and then press the ENTER button.
   • The adjustment screen will be displayed.
2. Press the ▼▲ ◀▶ buttons to align the cursor (yellow box) with the target adjustment point and then press the ENTER button.
   • The cursor will change into an adjustment point (yellow in color).
3. Press the ▼▲ ◀▶ buttons to adjust the corners or sides of the screen and then press the ENTER button.
   • The adjustment point will go back to being a cursor (yellow box).

Explanations of screen transition
• The adjustment points of the four corners (a, c, f and h in the drawing) will move independently.
• The following adjustment points differ at the [HORIZONTAL CORNER] and [VERTICAL CORNER].
   HORIZONTAL CORNER: When Point b in the drawing is moved, and the upper side and Point g are moved, the lower side will move in a parallel manner.
   VERTICAL CORNER: When Point d in the drawing is moved, and the left side and Point e are moved, the right side will move in a parallel manner.

[Adjustment points of the [HORIZONTAL CORNER] screen and movement points of the projection screen]

Point b will be displaced in a parallel manner at the same time as Points a, b, c

Point g will be displaced in a parallel manner at the same time as Points f, g, h

[Adjustment points of the [VERTICAL CORNER] screen and movement points of the projection screen]

Point d will be displaced in a parallel manner at the same time as Points a, d, f

Point e will be displaced in a parallel manner at the same time as Points f, g, h

4. Start from Step 2 onwards to adjust the other points.
5. When the adjustment is completed, press the ▼▲ ◀▶ buttons to align the cursor with the [EXIT] in the adjustment screen and then press the ENTER button.
   • Switch to the [GEOMETRIC CORRECTION] menu screen.
5. Using On-Screen Menu

PINCUSHION
Adjust the curve distortion of the projection screen.

- TOP ......................... Adjust the curve distortion of the upper edge of the projection screen.
- BOTTOM ................... Adjust the curve distortion of the lower edge of the projection screen.
- LEFT ...................... Adjust the curve distortion of the left edge of the projection screen.
- RIGHT ..................... Adjust the curve distortion of the right edge of the projection screen.

PC TOOL (For future support)
Recall the geometric correction data that is registered in the projector beforehand.
There are three types of registered data.

NOTE:
• KEYSTONE, CORNERSTONE, and PINCUSHION cannot be selected when setting the geometric correction using a PC tool.
• To clear the [GEOMETRIC CORRECTION] data that has been set up, press the 3D REFORM button for 2 or more seconds.
• As electrical correction is carried out in geometric correction, the brightness may be affected and the picture quality may be degraded.

RESET
Reset the adjustment value that has been set up in GEOMETRIC CORRECTION (return to the initial value).
This adjusts the edges (boundaries) of the projection screen when projecting high resolution videos using a combination of several projectors in the up, down, left and right positions.

**MODE**
This enables or disables the EDGE BLENDING function.
When MODE is set to ON, the TOP, BOTTOM, LEFT, RIGHT and BLACK LEVEL settings can be adjusted.

**TOP/BOTTOM/LEFT/RIGHT**
This selects the EDGE BLENDING locations on the left, right, top and bottom on the screen.
The following settings can be adjusted when an item is selected. (→ page 63)

- **CONTROL**............. Enable TOP, BOTTOM, LEFT and RIGHT functions.
- **MARKER**............. Set whether to display marker or not when adjusting the range and display position. When turned on, a magenta marker for adjusting the range adjustment and a green marker for adjusting the display position will be displayed.
- **RANGE**............... Adjust the range (width) of the edge blending.
- **POSITION** ........... Adjust the display position of the edge blending.

**BLACK LEVEL**
Divide the screen into nine parts and keep the black level uniform for each projector.
The nine divisions screens are TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER, CENTER-RIGHT, BOTTOM-LEFT, BOTTOM-CENTER and BOTTOM-RIGHT. (→ page 66)
5. Using On-Screen Menu

[MULTI SCREEN]

WHITE BALANCE
This adjusts the white balance for each projector when projecting using a combination of several projectors. This can be adjusted when [MODE] is set to [ON].

BRIGHTNESS W, BRIGHTNESS R, BRIGHTNESS G, BRIGHTNESS B
........................................ Adjusting the black color of the video.
CONTRAST W, CONTRAST R, CONTRAST G, CONTRAST B
........................................ Adjusting the white color of the video.

PICTURE SETTING
This sets the division condition when projecting using a combination of several projectors. Please refer to “4. Multi-Screen Projection” (→ page 54) for details.

<table>
<thead>
<tr>
<th>MODE</th>
<th>OFF</th>
<th>Use the projector in a standalone state.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZOOM</td>
<td></td>
<td>This adjusts the position and width of the video area that you wish to divide. The edge blending width will also be automatically set to that width.</td>
</tr>
<tr>
<td>TILING</td>
<td></td>
<td>This assigns the divided screens to the projectors. The edge blending function will also be set automatically.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ZOOM</th>
<th>HORIZONTAL ZOOM</th>
<th>This magnifies the video area in the horizontal direction.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>VERTICAL ZOOM</td>
<td>This magnifies the video area in the vertical direction.</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL POSITION</td>
<td>This shifts the video area in the horizontal direction.</td>
</tr>
<tr>
<td></td>
<td>VERTICAL POSITION</td>
<td>This shifts the video area in the vertical direction.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TILING</th>
<th>WIDTH</th>
<th>This selects the number of projectors to be arranged horizontally.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HEIGHT</td>
<td>This selects the number of projectors to be arranged vertically.</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL POSITION</td>
<td>This selects the position of the projector starting from the left among those arranged horizontally.</td>
</tr>
<tr>
<td></td>
<td>VERTICAL POSITION</td>
<td>This selects the position of the projector starting from the top among those arranged vertically.</td>
</tr>
</tbody>
</table>
Conditions for using tiling

- All the projectors need to fulfil the following conditions.
  - The panel size must be the same
  - The projection screen size must be the same
  - The left and right ends or top and bottom ends of the projection screen must be consistent.
  - The settings for the left and right edges of the edge blending are the same
  - The settings for the top and bottom edges of the edge blending are the same

If the tiling conditions are satisfied, the video screen of the projector at each installation position will be automatically extracted and projected.

If the tiling conditions are not satisfied, adjust the video screen of the projector at each installation position using the zoom function.

- Assign a unique control ID to each projector.
- Set the “Color Setting” and “DeepColor Setting” on your Blu-ray player or computer to “Auto”. Refer to the owner’s manual accompanying your Blu-ray player or computer for more information.
- Connect the HDMI output of your Blu-ray player or computer to the first projector. Then connect to the HDMI IN input terminal of the second and subsequent tiled projectors.

Tiling setting example) Number of horizontal units = 2, Number of vertical units = 2
5. Using On-Screen Menu

Menu Descriptions & Functions [SETUP]

[SETUP]

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Selecting Menu Language [LANGUAGE]
You can choose one of 29 languages for on-screen instructions.

**NOTE:** Your setting will not be affected even when [RESET] is done from the menu.

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [INPUT DISPLAY]
This option turns on or off input name display such as HDMI, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, HDBaseT to be displayed on the top right of the screen.

Turning messages on and off [MESSAGE DISPLAY]
This option selects whether or not to display projector messages at the bottom of the projected image. Even when “OFF” is selected, the security lock warning is displayed. The security lock warning turns off when the security lock is canceled.

Turning ON/OFF Control ID [ID DISPLAY]
  ID DISPLAY ........... This option turns on or off the ID number which is displayed when the ID SET button on the remote control is pressed. (→ page 113)
[3D CAUTION MESSAGE]
This selects whether to display a caution message or not when switching to a 3D video.
The default condition when shipped from the factory is ON.

OFF ....................... The 3D caution message screen will not be displayed.
ON ......................... The 3D caution message screen will be displayed when switching to a 3D video. Press the ENTER button
to cancel the message.

• The message will disappear automatically after 60 seconds or when other buttons are pressed. If it disapp-
ppears automatically, the 3D caution message will be displayed again when switching to a 3D video.

Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The
preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the fac-
tory preset.

Selecting Interval Time for Filter Message [FILTER MESSAGE]
This option allows you to select the time preference between displaying the message for cleaning the filters. Clean
the filter when you get the message “PLEASE CLEAN FILTER.” (→ page 142)
Eight options are available: OFF, 100[H], 500[H], 1000[H], 2000[H], 5000[H], 10000[H], 20000[H]
The default setting is [OFF].

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
[INSTALLATION]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

Note:
- Please consult the dealer if you require special installation services e.g. when mounting the projector to a ceiling. Never install the projector on your own. This may result in the projector falling down and causing injury to people.
5. Using On-Screen Menu

Selecting Aspect Ratio and Position for Screen [SCREEN TYPE]

<table>
<thead>
<tr>
<th>Screen type</th>
<th>Sets the aspect ratio of the projection screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREE</td>
<td>The ratio of panel is selected. Select this when projecting multi-screen and 17:9 screen (2K).</td>
</tr>
<tr>
<td>4:3 screen</td>
<td>For a screen with a 4:3 aspect ratio</td>
</tr>
<tr>
<td>16:9 screen</td>
<td>For a screen with a 16:9 aspect ratio</td>
</tr>
<tr>
<td>16:10 screen</td>
<td>For a screen with a 16:10 aspect ratio</td>
</tr>
</tbody>
</table>

**NOTE:**
- After changing the screen type, check the setting of [ASPECT RATIO] in the menu. (→ page 86)

Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.

Selecting Fan Mode [FAN MODE]

Fan Mode is used to set the speed of the internal cooling fan.

**MODE** ............. Select either AUTO or HIGH.

- AUTO: The built-in fans automatically run at a variable speed according to the internal temperature.
- HIGH: The built-in fans run at a high speed.

**NOTE:**
- Make sure the speed is set to [HIGH] when you are using this device continuously for several days.
- Your setting will not be affected even when [RESET] is done from the menu.
5. Using On-Screen Menu

[LIGHT MODE]

Adjusting the energy savings settings and the brightness of each projector in multi-screen projection. For energy savings settings, see page 31 “3-8. Changing LIGHT MODE/Checking Energy-Saving Effect Using LIGHT MODE [LIGHT MODE].”

<table>
<thead>
<tr>
<th>LIGHT MODE</th>
<th>NORMAL</th>
<th>The light module luminance (brightness) will become 100% and the screen will turn bright.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECO1</td>
<td></td>
<td>By controlling the brightness and fan speed according to the selected setting, energy can be saved and motion noise and the power consumption can be lowered.</td>
</tr>
<tr>
<td>ECO2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LONG LIFE</td>
<td></td>
<td>Light module life is the priority in this mode. The light module luminance (brightness) is lowered around 90%.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CONSTANT BRIGHTNESS</th>
<th>OFF</th>
<th>[CONSTANT BRIGHTNESS] mode will be canceled.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ON</td>
<td>Maintains the brightness that is in effect at the time [ON] is selected. Unless [OFF] is selected, the same settings will remain in effect even when the projector is turned off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To re-adjust the brightness, first turn this setting OFF before making further adjustments.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• [CONSTANT BRIGHTNESS] mode is a function used to maintain the brightness at a constant level. Color will not be fixed.</td>
</tr>
</tbody>
</table>

| ADJUST | Brightness can be adjusted in 1% increments from 30 to 100%. When several projectors are used for multi-screen projection, the brightness can be adjusted individually on each projector. |

NOTE:
- When [CONSTANT BRIGHTNESS] mode is set [ON], [LIGHT MODE] and [ADJUST] are not effective.

TIP:
- Brightness normally decreases with use, but by selecting [CONSTANT BRIGHTNESS] mode, sensors inside the projector detect brightness and automatically adjust the output, thereby maintaining a constant brightness throughout the life of the light module. However, if output is already at its maximum, brightness will decrease with use. For this reason, when using multi-screen projection, it is recommended to adjust the brightness to a slightly lower level, then setting the [CONSTANT BRIGHTNESS] mode to [ON].

[SHUTTER SETTINGS]

Enabling and disabling the lens shutter function. You can also set how long the light will take to fade in and fade out when the SHUTTER button is pressed.

<table>
<thead>
<tr>
<th>POWER ON SHUTTER</th>
<th>OPEN</th>
<th>When the power is turned on, the light source comes on and the picture is projected.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CLOSE</td>
<td>The light source does not come on when the power is turned on. When the SHUTTER button is pressed, the shutter is released and the light source is turned on.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PICTURE MUTE SHUTTER</th>
<th>OPEN</th>
<th>The light source is still on when the picture is turned off for switching the input terminals.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CLOSE</td>
<td>The light source turns off when the picture is turned off for switching the input terminals.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FADE IN TIME</th>
<th>Set how long the light will take to fade in after the SHUTTER button is pressed. The time can be set from 0 to 10 seconds in increments of 1 second.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FADE OUT TIME</td>
<td>Set how long the light will take to fade out after the SHUTTER button is pressed. The time can be set from 0 to 10 seconds in increments of 1 second.</td>
</tr>
</tbody>
</table>
[REF. WHITE BALANCE]
This feature allows you to adjust the white balance for all signals.
The white and black levels of the signal are adjusted for optimum color reproduction.
Uniformity is also adjusted when the redness (R) and blueness (B) of the white color in the screen’s horizontal (left/ right) direction are uneven.

CONTRAST R/CONTRAST G/CONTRAST B
........................................ These adjust the picture’s white color.
BRIGHTNESS R/BRIGHTNESS G/BRIGHTNESS B
........................................ These adjust the picture’s black color.
UNIFORMITY R...... The further this is set to the + side, the stronger the redness on the left side of the picture (increasing towards the left edge) and the weaker the redness on the right side of the picture (decreasing towards the right edge).
This is reversed when set to the – side.
UNIFORMITY B...... The further this is set to the + side, the stronger the blueness on the left side of the picture (increasing towards the left edge) and the weaker the blueness on the right side of the picture (decreasing towards the right edge).
This is reversed when set to the – side.

Using the Reference Lens Memory Function [REF. LENS MEMORY]
This function serves to store the adjusted values common to all input sources when using the LENS SHIFT, ZOOM and FOCUS buttons of the projector or the remote control. The adjusted values stored in memory can be used as a reference to the current.

PROFILE .............. Select a stored [PROFILE] number.
STORE .................. Stores the current adjusted values in memory as a reference.
MOVE .................... Applies the adjusted reference values stored in [STORE] to the current signal.
RESET .................... Reset selected [PROFILE] number [REF. LENS MEMORY] to the factory default settings.
LOAD BY SIGNAL .. When you switch signals the lens will shift to the lens shift, zoom, and focus values for the selected [PROFILE] number.
If no adjusted values have been saved to [LENS MEMORY], the lens will apply [REF. LENS MEMORY] adjusted values. Alternatively, if no adjusted values have been saved to [REF. LENS MEMORY], the unit will return to factory default settings.
FORCED MUTE ...... To turn off the image during lens shift, select [YES].

NOTE:
• Adjusted values in [REF. LENS MEMORY] will not be returned to default when performing [CURRENT SIGNAL] or [ALL DATA] for [RESET] from the menu.
• To store adjusted values for each input source, use the Lens Memory function. (→ page 49, 91)
• When [PICTURE MUTE SHUTTER] under [SHUTTER SETTINGS] is [ON], [FORCED MUTE] will turn off the light source and stop projection. (→ previous page)

[LENS CALIBRATION]
The adjustment range of the zoom and focus of the [LENS MEMORY] is calibrated. The SHUTTER indicator flashes in green when [LENS CALIBRATION] is being executed.
Be sure to carry out [LENS CALIBRATION] after replacing the lens.
### ADMINISTRATOR MODE

This allows you to select MENU MODE, save settings, and set a password for the administrator mode.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MENU MODE</strong></td>
<td>Select either [BASIC] or [ADVANCED] menu.</td>
<td>[ADVANCED]</td>
</tr>
<tr>
<td>NOT SAVE SETTING VALUES</td>
<td>Placing a check mark will not save your projector settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clear this check box to save your projector settings.</td>
<td></td>
</tr>
<tr>
<td>NEW PASSWORD/CONFIRM PASS-</td>
<td>Assign a password for the administrator mode.</td>
<td>Up to 10 alphanumeric</td>
</tr>
<tr>
<td>WORD</td>
<td></td>
<td>characters</td>
</tr>
</tbody>
</table>
This option turns on/standby the projector and changes video signals, and selects ECO mode automatically at a specified time.

NOTE:
• Before using [PROGRAM TIMER], make sure that the [DATE AND TIME] feature is set. (→ page 111)
  Make sure that the projector is in the standby condition with the POWER cord connected.
  The projector has a built-in clock. The clock will keep working for about two weeks after the main power is turned off. If the main power is not supplied to the projector for two weeks or more, it requires to set [DATE AND TIME SETTINGS] feature again.

Setting a new program timer
1. On the PROGRAM TIMER screen, use the ▲ or ▼ button to select [SETTINGS] and press the ENTER button.

2. Select a blank program number and press the ENTER button.

3. Make settings for each item as required.

ACTIVE ..................... Place a check mark to enable the program.
DAY ......................... Select days of the week for the program timer. To execute the program from Monday to Friday, select [MON-FRI]. To execute the program in everyday basis, select [EVERYDAY].
TIME ....................... Set the time to execute the program. Enter time in 24-hour format.

FUNCTION .............. Select a function to be executed. Selecting [POWER] will allow you to turn on or off the projector by setting [ADVANCED SETTINGS]. Selecting [INPUT] will allow you to select a video source by setting [ADVANCED SETTINGS]. Selecting [LIGHT MODE] will allow you to select [LIGHT MODE] by setting [ADVANCED SETTINGS].

ADVANCED SETTINGS ................................ Select power on/off, a type of video source, or LIGHT MODE for the selected item in [FUNCTION].

REPEAT .................. Place a check mark to repeat the program continuing basis. To use the program this week only, clear the check mark.

4. **Select [OK] and press the ENTER button.**
   
   This will complete the settings.

   You will be returned to the [PROGRAM LIST] screen.

5. **Select [BACK] and press the ENTER button.**
   
   You will be returned to the [PROGRAM TIMER] screen.

6. **Select [OK] and press the ENTER button.**
   
   You will be returned to the [TOOLS] screen.

**NOTE:**

- Up to 30 different timer settings can be programmed.
- When [PROGRAM TIMER] is turned on, the [STANDBY MODE] setting is ignored.
- The Program Timer is executed on a set time basis, not in a program basis.
- Once the program not marked with a check in [REPEAT] has been executed, the check mark in the [ACTIVE] check box will be cleared automatically and the program will be disabled.
- When the on-time and the off-time set for the same time, the off-time setting will take preference.
- Two different sources are set for the same time, the larger program number will take preference.
- The on-time setting will not be executed while the cooling fans are running or an error is occurring.
- If the off-time setting is expired under the condition in which the power off is not possible, the off-timer setting will not be executed until the power off becomes possible.
- Programs not marked with a check mark in [ACTIVE] of the [EDIT] screen will not be executed even if the Program Timer is enabled.
- When the projector is turned on by using the program timer and if you want to turn off the projector, set the off-time or do it manually so as not to leave the projector on for a long period of time.
Activating the program timer

   The selection screen will be displayed.
2. Press the ▼ button to align the cursor with [ON] and then press the ENTER button.
   Return to the [PROGRAM TIMER] screen.

NOTE:
• When the effective settings of the [PROGRAM TIMER] have not been set to [ON], the program will not be executed even if the [ACTIVE] items in the program list have been ticked.
• Even when the effective settings of the [PROGRAM TIMER] are set to [ON], the [PROGRAM TIMER] will not work until the [PROGRAM TIMER] screen is closed.

Changing the programmed settings

1. On the [PROGRAM LIST] screen, select a program you want to edit and press the ENTER button.
2. Change the settings on the [EDIT] screen.
3. Select [OK] and press the ENTER button.
   The programmed settings will be changed.
   You will be returned to the [PROGRAM LIST] screen.

Changing the order of programs

1. On the [PROGRAM LIST] screen, select a program whose order you want to change and press the ▶ button.
2. Press the ▼ button to select ▲ or ▼.
3. Press the ENTER button a few times to select a row to which you wish to move the program.
   The order of the programs will be changed.

Deleting the programs

1. On the [PROGRAM LIST] screen, select a program number you want to delete and press the ▶ button.
2. Press the ▼ button to select [DELETE].
3. Press the ENTER button.
   The confirmation screen will be displayed.
4. Select [YES] and press the ENTER button.
   The program will be deleted.

This will complete deleting the program.
5. Using On-Screen Menu

**DATE AND TIME SETTINGS**

You can set the current time, month, date, and year.

**NOTE:** The projector has a built-in clock. The clock will keep working for about 2 weeks after the main power is turned off. If the main power is off for 2 weeks or more, the built-in clock will cease. If the built-in clock ceases, set the date and time again. **The built-in clock will not cease while in the standby mode.**

<table>
<thead>
<tr>
<th>TIME ZONE SETTINGS</th>
<th>DATE AND TIME SETTINGS</th>
<th>SUMMER TIME SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTER SELECT</td>
<td>EXIT MOVE</td>
<td></td>
</tr>
</tbody>
</table>

- **TIME ZONE SETTINGS** Select your time zone.
- **DATE AND TIME SETTINGS** Set your current date (MM/DD/YYYY) and time (HH:MM).
- **INTERNET TIME SERVER** If you place a check mark, the projector’s built-in clock will be synchronized with an Internet time server in every 24 hours and at the time of projector’s startup.
- **UPDATE** Synchronizes the projector’s built-in clock immediately. The UPDATE button is not available unless the INTERNET TIME SERVER check box is turned on.
- **SUMMER TIME SETTINGS** If you place a check mark, the clock for daylight saving will be enabled.

**[MOUSE]**
This function cannot be used in this device. It is used for future expansion purposes only.
Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
- How to cancel the [CONTROL PANEL LOCK]
  When the [CONTROL PANEL LOCK] is set to [ON], press either the KEY LOCK button on the projector over 1 second or the SOURCE button over 10 seconds to cancel the [CONTROL PANEL LOCK].

TIP:
- When the [CONTROL PANEL LOCK] is turned on, a key lock icon [ ] will be displayed at the bottom right of the menu.
- This CONTROL PANEL LOCK does not affect the remote control functions.

[NOTIFICATION SETTINGS]
This setting is to enable/disable the notification by the buzzer and rear LED.

<table>
<thead>
<tr>
<th>REAR LED</th>
<th>OFF</th>
<th>[REAR LED] is deactivated.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ON</td>
<td>The [REAR LED] informs you of the unit’s status just like the status indicator.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BUZZER</th>
<th>OFF</th>
<th>The buzzer goes off</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ON</td>
<td>The buzzer stops.</td>
</tr>
</tbody>
</table>

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function. Unless the correct keyword is entered, the projector cannot project an image. (→ page 37)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 115200 bps. The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate may be recommended for long cable runs).

NOTE:
- Select [38400bps] or less when using the User Supportware.
- Your selected communication speed will not be affected even when [RESET] is done from the menu.
5. Using On-Screen Menu

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER .......Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID.......................Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.

NOTE:
• When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support the CONTROL ID function. (If this case the buttons on the projector cabinet can be used.)
• Your setting will not be affected even when [RESET] is done from the menu.
• Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control ID.

Assigning or Changing the Control ID
1. Turn on the projector.
2. Press the ID SET button on the remote control.
   The CONTROL ID screen will be displayed.

   ![CONTROL ID Screen]

   If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive projector, assign the control ID used for the projector by using the following procedure (Step 3).

3. Press one of numeric keypad buttons while pressing and holding the ID SET button on the remote control.
   Example:
   To assign “3”, press the “3” button on the remote control.
   No ID means that all the projectors can be operated together with a single remote control. To set “No ID”, enter “000” or press the CLEAR button.
   TIP: The range of IDs is from 1 to 254.

4. Release the ID SET button.
   The updated CONTROL ID screen will be displayed.

NOTE:
• The IDs can be cleared in a few days after the batteries are run down or removed.
• If one of buttons of the remote control without batteries is pressed accidentally, current specified ID will be cleared.
5. Using On-Screen Menu

Turning On or Off Remote Sensor [REMOTE SENSOR]
This option determines which remote sensor on the projector is enabled in wireless mode. The options are: FRONT/BACK, FRONT, BACK, and HDBaseT.

**NOTE:**
- The remote control of the projector will not be able to receive signals if the power supply of the HDBaseT transmission device connected to the projector is switched on when this has been set to “HDBaseT”.

**TIP:**
- If the remote control system does not function when direct sunlight or strong illumination strikes the remote control sensor of the projector, change another option.

[LENS TYPE]
Depending on the lens installed on the projector, select either [WITH SENSOR] or [WITHOUT SENSOR].

- [WITH SENSOR] ................. For the lens units support the lens memory function
- [WITHOUT SENSOR] .......... For the lens units do not support the lens memory function.
5. Using On-Screen Menu

[NETWORK SETTINGS]

**Important:**
- Consult with your network administrator about these settings.
- When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projector. (→ page 138)

**TIP:** The network settings you make will not be affected even when [RESET] is done from the menu.

**Hints on How to Set Up LAN Connection**

**To set up the projector for a LAN connection:**
Select [WIRED LAN] → [PROFILES] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for wired LAN.
Next turn on or off for [DHCP], [IP ADDRESS], [SUBNET MASK], and [GATEWAY] and select [OK] and press the ENTER button. (→ page 116)

**To recall LAN settings stored in the profile number:**
Select [PROFILE 1] or [PROFILE 2] for wired LAN, and then select [OK] and press the ENTER button. (→ page 116)

**To connect a DHCP server:**
Turn on [DHCP] for wired LAN. Select [ON] and press the ENTER button. To specify IP address without using the DHCP server, turn off [DHCP]. (→ page 116)

**To receive error messages via e-mail:**
Select [ALER T MAIL], and set [SENDER’S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT’S ADDRESS].
Last, select [OK] and press the ENTER button. (→ page 118)
### WIRED LAN

**PROFILES**

- The settings for using the built-in Ethernet/HDBaseT port in the projector can be recorded in the projector memory in two ways.
- Select [PROFILE 1] or [PROFILE 2] and then do settings for [DHCP] and the other options.
  - After doing this, select [OK] and press the ENTER button. This will store your settings in memory.
- To recall the settings from memory:
  - After selecting [PROFILE 1] or [PROFILE 2] from the [FILES] list.
  - Select [OK] and press the ENTER button.
- Select [DISABLE] when not connecting to a wired LAN.

<table>
<thead>
<tr>
<th>DHCP</th>
<th>Place a check mark to automatically assign an IP address to the projector from your DHCP server. Clear this check box to register the IP address or subnet mask number obtained from your network administrator.</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of the network connected to the projector when [DHCP] is turned off.</td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>Set your subnet mask number of the network connected to the projector when [DHCP] is turned off.</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>Set the default gateway of the network connected to the projector when [DHCP] is turned off.</td>
</tr>
<tr>
<td>AUTO DNS</td>
<td>Place a check mark to automatically assign the IP address of your DNS server connected to the projector from your DHCP server. Clear this check box to set the IP address of your DNS server connected to the projector.</td>
</tr>
<tr>
<td>DNS CONFIGURATION</td>
<td>Set the IP address of your DNS server on the network connected to the projector when [AUTO DNS] is cleared.</td>
</tr>
<tr>
<td>RECONNECT</td>
<td>Retry to connect the projector to a network. Try this if you have changed [PROFILES].</td>
</tr>
</tbody>
</table>
### 5. Using On-Screen Menu

#### PROJECTOR NAME

Set a unique projector name.  
Up to 16 alphanumeric characters and symbols.

<table>
<thead>
<tr>
<th>PROJECTOR NAME</th>
<th>Set a unique projector name.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Graphical representation of PROJECTOR NAME" /></td>
<td><img src="image" alt="Graphical representation of PROJECTOR NAME" /></td>
</tr>
</tbody>
</table>

#### DOMAIN

Set a host name and domain name of the projector.

| HOST NAME | Set a host name of the projector.  
Up to 15 alphanumeric characters |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Graphical representation of HOST NAME" /></td>
<td><img src="image" alt="Graphical representation of HOST NAME" /></td>
</tr>
</tbody>
</table>

| DOMAIN NAME | Set a domain name of the projector.  
Up to 60 alphanumeric characters |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Graphical representation of DOMAIN NAME" /></td>
<td><img src="image" alt="Graphical representation of DOMAIN NAME" /></td>
</tr>
</tbody>
</table>
### ALERT MAIL

This option will notify your computer of error messages via e-mail when using wireless or wired LAN.

Placing a checkmark will turn on the Alert Mail feature.

Clearing a checkmark will turn off the Alert Mail feature.

**Sample of a message to be sent from the projector:**

```plaintext
Subject: [Projector] Projector Information
THE COOLING FAN HAS STOPPED.
[INFORMATION]
PROJECTOR NAME: PH1202HL Series
LIGHT HOURS USED: 0000[H]
FILTER HOURS USED: 0000[H]
```

<table>
<thead>
<tr>
<th>HOST NAME</th>
<th>Type in a host name.</th>
<th>Up to 15 alphanumeric characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN NAME</td>
<td>Type in a domain name of the network connected to the projector.</td>
<td>Up to 60 alphanumeric characters</td>
</tr>
<tr>
<td>SENDER'S ADDRESS</td>
<td>Specify the sender’s address.</td>
<td>Up to 60 alphanumeric characters and symbols</td>
</tr>
<tr>
<td>SMTP SERVER NAME</td>
<td>Type in the SMTP server name to be connected to the projector.</td>
<td>Up to 60 alphanumeric characters</td>
</tr>
<tr>
<td>RECIPIENT’S ADDRESS 1, 2, 3</td>
<td>Type in your recipient’s address.</td>
<td>Up to 60 alphanumeric characters and symbols</td>
</tr>
<tr>
<td>TEST MAIL</td>
<td>Send a test mail to check if your settings are correct.</td>
<td>—</td>
</tr>
</tbody>
</table>

**NOTE:**
- If you entered an incorrect address in a test, you may not receive an Alert mail. Should this happen, check if the Recipient’s Address is correctly set.
- Unless any one of the [SENDER’S ADDRESS], [SMTP SERVER’S NAME] or [RECIPIENT’S ADDRESS 1-3] is selected, [TEST MAIL] is not available.
- Be sure to highlight [OK] and press the ENTER button before executing [TEST MAIL].
## 5. Using On-Screen Menu

### NETWORK SERVICE

<table>
<thead>
<tr>
<th>HTTP SERVER</th>
<th><strong>Set a password for your HTTP server.</strong></th>
<th>Up to 10 alphanumeric characters</th>
</tr>
</thead>
</table>
| **PJLink**   | This option allows you to set a password when you use the PJLink feature. **NOTE:**  

- Do not forget your password. However, if you forget your password, consult with your dealer.  
- What is PJLink?  

  PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005.  

  The projector supports all the commands of PJLink Class 1.  

- Setting of PJLink will not be affected even when [RESET] is done from the menu. | Up to 32 alphanumeric characters |
| **AMX BEACON** | Turn on or off for detection from AMX Device Discovery when connecting to the network supported by AMX's NetLinx control system. **TIP:**  

  When using a device that supports AMX Device Discovery, all AMX NetLinx control system will recognize the device and download the appropriate Device Discovery Module from an AMX server.  

  Placing a checkmark will enable detecting the projector from AMX Device Discovery.  

  Clearing a checkmark will disable detecting the projector from AMX Device Discovery. | — |
| **CRESTRON** | ROOMVIEW: Turn on or off when controlling the projector from your PC.  
CRESTRON CONTROL: Turn on or off when controlling the projector from your controller.  
- CONTROLLER IP ADDRESS: Enter your IP address of CRESTRON SERVER.  
- IP ID: Enter your IP ID of CRESTRON SERVER. | Up to 12 numeric characters |

**TIP:** The CRESTRON settings are required only for use with CRESTRON ROOMVIEW.  
For more information, visit [http://www.crestron.com](http://www.crestron.com)
5. Using On-Screen Menu

**[SOURCE OPTIONS]**

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NETWORK SETTINGS</td>
<td><em>SOURCE OPTIONS</em></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **AUTO ADJUST**
  - NORMAL
- **COLOR SYSTEM**
  - AUTO
- **DEFAULT INPUT SELECT**
  - LAST
- **SEAMLESS SWITCHING**
  - OFF
- **CLOSED CAPTION**
  - OFF
- **BACKGROUND**
  - BLUE

**Setting Auto Adjust [AUTO ADJUST]**

This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

- OFF. The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
- NORMAL. Default setting. The computer signal will be automatically adjusted. Normally select this option.
- FINE. Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NORMAL] is selected.

**TIP:**
- The default setting when shipped from the factory is [NORMAL].
- When the AUTO ADJ. button is pressed, the same [FINE] adjustment is carried out.

**[COLOR SYSTEM]**

This feature allows you to select the TV video signal, which differs from country to country (NTSC, PAL, etc.). This is set to [AUTO] by factory default. Set this if the projector cannot identify the signal automatically.

**Selecting Default Source [DEFAULT INPUT SELECT]**

You can set the projector to default to any one of its inputs each time the projector is turned on.

- LAST. Set the projector to default to the previous or last active input each time the projector is turned on.
- AUTO. Search for an active source in order of HDMI → DisplayPort → BNC → BNC(CV) → BNC(Y/C) → COMPUTER → HDBaseT → SLOT and displays the first found source.
- HDMI. Display the digital source from the HDMI IN terminal every time the projector is turned on.
- DisplayPort. Display the digital source from the DisplayPort IN terminal every time the projector is turned on.
- BNC. Project the input signal from the BNC input terminal.
- BNC(CV). Project the input signal from the BNC(CV) input terminal.
- BNC(Y/C). Project the input signal from the BNC(Y/C) input terminal.
- COMPUTER. Display the computer signal from the COMPUTER IN terminal every time the projector is turned on.
- HDBaseT. Project the HDBaseT or WIRED LAN signal.
- SLOT. Project the picture via the optional board (sold separately) inserted into the SLOT.
5. Using On-Screen Menu

[SEAMLESS SWITCHING]
When the input connector is switched, the image displayed before switching is held to switch to the new image without a break due to absence of a signal.

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video or S-Video.
The subtitles and text will be displayed a short while after the on-screen menu disappears.

  - OFF ...................... This exits the closed caption mode.
  - CAPTION 1-4 .......... Text is superimposed.
  - TEXT 1-4 .............. Text is displayed.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].

NOTE:
• Even when the background logo is selected, if two pictures are displayed in [PIP/PICTURE BY PICTURE] mode, the blue background is displayed without the logo when there is no signal.
5. Using On-Screen Menu

[POWER OPTIONS]

![Menu Interface]

Selecting Power-saving in [STANDBY MODE]

Setting the power consumption in the standby mode.

**NORMAL**................. In the standby mode, the power consumption of the projector is minimized.

In the standby mode, the POWER indicator lights up in red while the STATUS indicator will go off.

- When set to [NORMAL], the following terminals and functions will be disabled. HDMI OUT terminals, Ethernet/HDBaseT port, LAN function, mail notification function

**HDBaseT STANDBY**

.............................. Compared to [NORMAL], the power consumption in the standby mode is higher but power can be supplied to the projector using a wired LAN.

In the standby mode, the power indicator will light up in orange while the status indicator will be turned off.

**Important:**

- When [HDBaseT STANDBY] is selected, [AUTO POWER OFF] will turn grey in color and be disabled and [0:15] will be selected automatically.
- In the following conditions, the [STANDBY MODE] setting will be disabled and the projector will go into the sleep mode. In the sleep mode, the fans in the projector rotate for the purpose of interior parts protection.
  - Sleep mode refers to the mode whereby the functional restrictions due to the [STANDBY MODE] setting are removed.
    - When [ENABLE] is selected under [NETWORK SERVICE] → [AMX BEACON]
    - When [ENABLE] is selected under [NETWORK SERVICE] → [CRESTRON] → [CRESTRON CONTROL]
    - When [HDBaseT] is selected under [CONTROL] → [REMOTE SENSOR]
    - When a signal is being received from a HDBaseT transmission device
    - When the projector is in HDBaseT standby mode connecting the optional board (sold commercially) to the SLOT terminal and [PROJECTOR STANDBY] for [SLOT POWER] is [ENABLE].

- When [NORMAL] is selected, the [AUTO POWER ON SELECT] display turns grey in color and is disabled, and [OFF] is automatically selected.

**NOTE:**

- When connecting to a HDBaseT transmission device sold commercially, if the transmission device is set to transmit remote control signals, the power consumption of the projector in the standby mode will increase.

**TIP:**

- Your setting will not be affected even when [RESET] is done from the menu.
- The power consumption in the standby mode will not be included in calculating CO₂ emission reduction.

Enabling Direct Power On [DIRECT POWER ON]

Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the need to always use the POWER button on the remote control or projector cabinet.
Turning On the Projector By Applying Computer Signal [AUTO POWER ON SELECT]

If set to [HDBaseT STANDBY], the projector automatically detects the synchronizing signal input from the following selected terminals and projects the picture accordingly: Computer, HDMI, DisplayPort, HDBaseT, and SLOT.

OFF ...................... AUTO POWER ON SELECT function will be switch off.
HDMI, DisplayPort, COMPUTER, HDBaseT, SLOT
........................................... When a computer signal of a selected input terminal is detected, the power supply of the projector will be turned on automatically and the computer screen will be projected.

NOTE:
• If you want to activate the AUTO POWER ON SELECT function after powering OFF the projector, interrupt the signal from the input terminals or disconnect the computer cable from the projector and wait for at least 3 seconds before inputting the signal from the selected terminal. When the projector is turned off and enters HDBaseT STANDBY mode, but signals from the computer continue to be sent to the projector, the projector maintains HDBaseT STANDBY mode and will not turn ON automatically. In addition, if signals from HDMI, DisplayPort or HDBaseT continue to be sent to the projector, depending on the settings of connected external devices, the projector may turn ON automatically even if it is powered off and HDBaseT STANDBY mode is in effect.

Enabling Power Management [AUTO POWER OFF]

When this option is selected you can enable the projector to automatically turn off (at the selected time: 0:05, 0:10, 0:15, 0:20, 0:30, 1:00) if there is no signal received by any input or if no operation is performed.

NOTE:
• The power will not go off automatically when a signal from the Ethernet/HDBaseT port is being projected.
• [AUTO POWER OFF] appears in grey when the [STANDBY MODE] is set to [HDBaseT STANDBY] and [0:15] will be set automatically.

Using Off Timer [OFF TIMER]

1. Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.
2. Press the ENTER button on the remote control.
3. The remaining time starts counting down.
4. The projector will turn off after the countdown is complete.

NOTE:
• To cancel the preset time, set [OFF] for the preset time or turn off the power.
• When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 MINUTES] message will be displayed on the bottom of the screen.

Setting for the Optional Board [SLOT POWER]

When using the optional board installed in the slot, set the following options.

PROJECTOR ON ................. This feature will turn on or off the power to the optional board.
OFF: Forcibly turn off the power to the optional board installed in the slot.
ON (Default): Turn on the power to the optional board installed in the slot.

PROJECTOR STANDBY........ This feature will automatically enable or disable the optional board installed in the slot when the projector is in standby.
DISABLE: Select this option to disable the optional board in the projector standby.
ENABLE (Default): Select this option to enable the optional board in the projector standby.

NOTE:
• In the below three conditions are satisfied, the standby mode will go into the sleep mode.
  The optional board is connected
  In HDBaseT standby
  [PROJECTOR STANDBY] for [SLOT POWER] is enable
**5. Using On-Screen Menu**

**Returning to Factory Default [RESET]**

The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source(s) except the following:

- [CURRENT SIGNAL]
  - Resets the adjustments for the current signal to the factory preset levels.
  - The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], [ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

- [ALL DATA]
  - Reset all the adjustments and settings for all the signals to the factory preset.
  - All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [EDGE BLENDING], [MULTI SCREEN], [SCREEN TYPE], [GEOMETRIC CORRECTION], [REF. WHITE BALANCE], [ADMINISTRATOR MODE], [CONTROL PANEL LOCK], [SECURITY], [REF. LENS MEMORY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LIGHT HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], and [WIRED LAN].

- [ALL DATA (INCLUDING ENTRY LIST)]
  - Reset all the adjustments and settings for all the signals to the factory preset except [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [EDGE BLENDING], [MULTI SCREEN], [SCREEN TYPE], [GEOMETRIC CORRECTION], [REF. WHITE BALANCE], [ADMINISTRATOR MODE], [CONTROL PANEL LOCK], [SECURITY], [REF. LENS MEMORY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LIGHT HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], and [WIRED LAN].
  - Also deletes all the signals in the [ENTRY LIST] and returns to the factory preset.

*NOTE:* Locked signals in Entry List cannot be reset.

**Clearing the Filter Usage Hours [CLEAR FILTER HOURS]**

- Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

  - The [OFF] item is selected for [FILTER MESSAGE] at the time of shipment. When [OFF] is selected, you do not need to clear the filter usage hour.

*NOTE:* Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
Displays the status of the current signal and light module usage. This item has nine pages. The information included is as follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

**[USAGE TIME]**

- [LIGHT HOURS USED] (H)
- [FILTER HOURS USED] (H)
- [TOTAL CARBON SAVINGS] (kg-CO2)

This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving calculation is based on the OECD (2008 Edition). (→ page 33)

**[SOURCE(1)]**

INPUT TERMINAL
HDMI

RESOLUTION
1024x768

HORIZONTAL FREQUENCY
48.58[kHz]

VERTICAL FREQUENCY
62.13[Hz]

SYNC TYPE
SEPARATE SYNC

SYNC POLARITY
H(−) V(−)

SCAN TYPE
NON-INTERLACE

SOURCE NAME
1024x768

ENTRY NO.
1
### [SOURCE(2)]

<table>
<thead>
<tr>
<th>SIGNAL TYPE</th>
<th>RGB</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO TYPE</td>
<td>NTSC</td>
</tr>
<tr>
<td>BIT DEPTH</td>
<td>6[bits]</td>
</tr>
<tr>
<td>VIDEO LEVEL</td>
<td>FULL</td>
</tr>
<tr>
<td>LINK RATE</td>
<td>2.7[GBps]</td>
</tr>
<tr>
<td>LINK LANE</td>
<td>1[lane]</td>
</tr>
<tr>
<td>3D FORMAT</td>
<td>FRAME PACKING</td>
</tr>
</tbody>
</table>

### [SOURCE(3)]

<table>
<thead>
<tr>
<th>INPUT TERMINAL</th>
<th>---</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESOLUTION</td>
<td>1024x768</td>
</tr>
<tr>
<td>HORIZONTAL FREQ</td>
<td>48.58[kHz]</td>
</tr>
<tr>
<td>VERTICAL FREQ</td>
<td>62.13[Hz]</td>
</tr>
<tr>
<td>SYNC TYPE</td>
<td>SEPARATE SYNC</td>
</tr>
<tr>
<td>SYNC POLARITY</td>
<td>Ht(-) Vt(-)</td>
</tr>
<tr>
<td>SCAN TYPE</td>
<td>NON-INTERLACE</td>
</tr>
<tr>
<td>SOURCE NAME</td>
<td>1024x768</td>
</tr>
<tr>
<td>ENTRY NO.</td>
<td>1</td>
</tr>
</tbody>
</table>

### [SOURCE(4)]

<table>
<thead>
<tr>
<th>SIGNAL TYPE</th>
<th>RGB</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO TYPE</td>
<td>NTSC</td>
</tr>
<tr>
<td>BIT DEPTH</td>
<td>6[bits]</td>
</tr>
<tr>
<td>VIDEO LEVEL</td>
<td>FULL</td>
</tr>
<tr>
<td>LINK RATE</td>
<td>2.7[GBps]</td>
</tr>
<tr>
<td>LINK LANE</td>
<td>1[lane]</td>
</tr>
<tr>
<td>3D FORMAT</td>
<td>FRAME PACKING</td>
</tr>
</tbody>
</table>
## [WIRED LAN]

### INPUT ADJUST DISPLAY SETUP INFO.

- **SOURCE(1) • SOURCE(2) • SOURCE(4) • WIRED • VERSION(1) • 2/3**

<table>
<thead>
<tr>
<th>IP ADDRESS</th>
<th>192.168.0.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUBNET MASK</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>192.168.0.1</td>
</tr>
<tr>
<td>MAC ADDRESS</td>
<td>00-00-00-00-00-00</td>
</tr>
</tbody>
</table>

### [VERSION(1)]

### INPUT ADJUST DISPLAY SETUP INFO.

- **SOURCE(3) • SOURCE(4) • WIRED • VERSION(1) • 2/3**

<table>
<thead>
<tr>
<th>FIRMWARE</th>
<th>1.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATA</td>
<td>1.00</td>
</tr>
<tr>
<td>SUB-CPU</td>
<td>1.00</td>
</tr>
</tbody>
</table>

### [VERSION(2)]

### INPUT ADJUST DISPLAY SETUP INFO.

- **VERSION(2) • OTHERS • CONDITIONS • HDBaseT • 3/3**

| FIRMWARE3 | F.00 |

### HDMI ADVANCED
### [OTHERS]

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **DATE TIME**: 01/01/2013 TUE 00:00
- **PROJECTOR NAME**: [Redacted]
- **MODEL NO.**: [Redacted]
- **SERIAL NUMBER**: [Redacted]
- **CONTROL ID** (when [CONTROL ID] is set)

### [CONDITIONS]

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **INTAKE TEMPERATURE**: -1.1[°C] / -0.1[°F]
- **EXHAUST TEMPERATURE**: 26.5[°C] / 83.1[°F]
- **ATMOSPHERIC PRESSURE**: 89kPa

### [HDBaseT]

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **SIGNAL QUALITY**: NORMAL
- **OPERATION MODE**: HDBaseT
- **LINK STATUS**: HDBaseT
- **HDMI STATUS**: NO HDMI
6. Connecting to Other Equipment

1 Connecting a computer

A computer cable, BNC cable (5-core type), HDMI cable, or a DisplayPort cable can be used to connect to a computer. The connection cable is not enclosed with the projector. Please get ready a suitable cable for the connection.

Analog RGB signal connection

- Connect the computer cable to the display output terminal (mini D-sub 15 pin) on the computer and the COMPUTER IN terminal on the projector. Please use a computer cable attached with a ferrite core.
- When connecting the display output terminal (mini D-sub 15 pin) on the computer to the BNC input terminal, use a conversion cable to convert the BNC cable (5 core) to a mini D-sub 15 pin cable.

NOTE: Please check the operating manual of the computer as the name, position and direction of the terminal may differ depending on the computer.

Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>📱 COMPUTER</td>
<td>COMPUTER 1</td>
</tr>
<tr>
<td>BNC</td>
<td>📱 BNC</td>
<td>COMPUTER 2</td>
</tr>
</tbody>
</table>
Digital RGB signal connection

- Connect a commercially available HDMI cable between the computer's HDMI output terminal and the projector's HDMI IN terminal.
- Connect a commercially available DisplayPort cable between the computer's DisplayPort output terminal and the projector's DisplayPort IN terminal.

*HDMI cable (not supplied)  DisplayPort cable (not supplied)*

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI IN</td>
<td>HDMI</td>
<td>HDMI</td>
</tr>
<tr>
<td>DisplayPort IN</td>
<td>DisplayPort</td>
<td>DisplayPort</td>
</tr>
</tbody>
</table>
6. Installation and Connections

Cautions when connecting an HDMI cable
• Use a certified High Speed HDMI® Cable or High Speed HDMI® Cable with Ethernet.

Cautions when connecting a DisplayPort cable
• Use a certified DisplayPort cable.

• Depending on the computer, some time may be required until the image is displayed.
• Some DisplayPort cables (commercially available) have locks.
• To disconnect the cable, press the button on the top of the cable’s terminal, then pull the cable out.
• Power can be supplied to the connecting device from the DisplayPort IN terminal (maximum of 1.65 W). However, power will not be supplied to the computer.
• When signals from a device that uses a signal converter adapter are connected to the DisplayPort IN terminal, in some cases the image may not be displayed.
• When the HDMI output of a computer is connected to the DisplayPort IN terminal, use a converter (commercially available).
Cautions when using a DVI signal

- When the computer has a DVI output terminal, use a commercially available converter cable to connect the computer to the projector’s HDMI IN terminal (only digital video signals can be input).

**NOTE: When Viewing a DVI Digital Signal**

- Turn off the power of the computer and projector before connecting devices.
- When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.
- Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 standard. The cable should be within 197'/5 m long.
- Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
- To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI. Finally, turn on your PC. Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, restart your PC.
- Some graphics cards have both analog RGB (15-pin D-Sub) and DVI (or DFP) outputs. Use of the 15-pin D-Sub terminal may result in no picture being displayed from the digital output of the graphics card.
- Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
- The COMPUTER IN terminals support Windows Plug and Play. The BNC input terminal does not support Windows Plug and Play.
- A Mac signal adapter (commercially available) may be required to connect a Mac computer.

To connect a Mac computer equipped with a Mini DisplayPort to the projector, use a commercially available Mini DisplayPort → DisplayPort converter cable.
Connecting an External Monitor

As shown in the figure, when the projector is connected to a computer, the same content from the HDMI input signal is displayed on the monitor for confirmation.

- The HDMI OUT terminal cannot send analog signals (COMPUTER IN terminal, BNC terminal).
- Please refer to Page 58 when displaying the PIP/PBP screen.

**NOTE:**

- When outputting HDMI signals, turn on the power of the video device on the output side and keep it connected before inputting video signals into this device. The HDMI OUT terminals of the projector are equipped with repeater functions. When a device is connected to the HDMI OUT terminal, the resolution of the output signal is limited by the resolution supported by the connected device.
- In the case of the HDMI OUT terminal of the projector, the theoretical number of units that can be connected in a series is seven. The maximum number of units that can be connected may be reduced by the external environment and quality of the signal and cable, etc. The number of units that can be connected may differ depending on the HDCP version, restriction on the number of HDCP repeaters in the source device and the quality of the cable. The overall system needs to be checked in advance when building a system.
- When the [STANDBY MODE] is set to [NORMAL], video will not be output if the projector goes into the standby mode. Set the mode to [HDBaseT STANDBY], turn on the power of the transmission device and keep it in a connected state.
- When the [STANDBY MODE] of this device is set to [NORMAL], HDMI signals will not be output. To output HDMI signals, set the [STANDBY MODE] to [HDBaseT STANDBY], turn on the power supply of the transmission device and keep it connected.
- HDMI repeater function will not be functioned if switching terminals and putting in/pulling out the HDMI cable is performed on the 2nd projector and after.
Connecting Your Blu-ray Player or Other AV Equipment
Component video signal/S-video signal connection

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC(CV)</td>
<td>![BNC(CV)]</td>
<td>VIDEO</td>
</tr>
<tr>
<td>BNC(Y/C)</td>
<td>![BNC(Y/C)]</td>
<td>S-VIDEO</td>
</tr>
</tbody>
</table>
Connecting Component Input

Connect the Blu-ray player’s audio to the audio device.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>[COMPUTER]</td>
<td>COMPUTER 1</td>
</tr>
<tr>
<td>BNC</td>
<td>[BNC]</td>
<td>COMPUTER 2</td>
</tr>
</tbody>
</table>

**NOTE:**
- When the signal format is set to [AUTO] (default factory setting when shipped), the computer signal and component signal are automatically distinguished and switched. If the signals cannot be distinguished, select [COMPONENT] under [ADJUST] → [VIDEO] → [SIGNAL TYPE] in the on-screen menu of the projector.
- To connect to a video device with a D terminal, use the sold separately D terminal converter adapter (model ADP-DT1E).
Connecting HDMI Input
You can connect the HDMI output of your Blu-ray player, hard disk player, or notebook type PC to the HDMI IN terminal of your projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI IN</td>
<td>HDMI</td>
<td>HDMI</td>
</tr>
</tbody>
</table>

**TIP:** For users of audio video equipment with an HDMI terminal:
Select “Enhanced” rather than “Normal” if HDMI output is switchable between “Enhanced” and “Normal.”
This will provide improved image contrast and more detailed dark areas.
For more information on settings, refer to the instruction manual of the audio video equipment to be connected.

- When connecting the HDMI IN terminal of the projector to the Blu-ray player, the projector’s video level can be made settings in accordance with the Blu-ray player’s video level. In the menu select [ADJUST] → [VIDEO] → [VIDEO LEVEL] and make necessary settings.
4 Connecting a document camera
You can connect a document camera and project printed documents, etc.

NOTE:
• Name, position, and direction of terminals are vary depending on camera model. Please check user’s manual of your camera for details.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>COMPUTER</td>
<td>COMPUTER 1</td>
</tr>
<tr>
<td>BNC(CV)</td>
<td>BNC(CV)</td>
<td>VIDEO</td>
</tr>
</tbody>
</table>

BNC (male) and RCA (male) conversion cable (not supplied)
Connecting to a Wired LAN

The projector comes standard with a Ethernet/HDBaseT port (RJ-45) which provides a LAN connection using a LAN cable. To use a LAN connection, you are required to set the LAN on the projector menu. Select [SETUP] → [NETWORK SETTINGS] → [WIRED LAN]. (→ page 115).

Example of LAN connection

Example of wired LAN connection

NOTE: Use a Category 5 or higher LAN cable.
6 Connecting to a HDBaseT transmission device (sold commercially)

HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance. Use a LAN cable sold commercially to connect the Ethernet / HDBaseT port of the projector (RJ-45) to a HDBaseT transmission device sold commercially. The Ethernet/HDBaseT port of the projector supports HDMI signals (HDCP) from transmission devices, control signals from external devices (serial, LAN) and remote control signals (IR commands).

Connection example

NOTE:
• Never use the LAN port (RJ-45) on the projector terminal panel for connecting a HDBaseT transmission device. It may cause of malfunction.
• Please use a shielded twisted pair (STP) cable of Category 5e or higher for the LAN cable (sold commercially).
• The maximum transmission distance over the LAN cable is 100 m. (the maximum distance is 70 m for a 4K signal)
• Please do not use other transmission equipment between the projector and transmission equipment. The picture quality may be deteriorated as a result.
• This projector is not guaranteed to work with all HDBaseT transmission devices sold commercially.
7 Portrait projection (vertical orientation)
If you install the projector vertically you can project screens from your computer and other sources in portrait orientation.

⚠️ Precautions during installation
- Do not simply set the projector vertically on the floor or on a table. The projector may fall over, resulting in injury, damage or malfunction. Also the intake vent may become blocked causing the unit’s internal temperature to rise resulting in malfunction and risk of fire.
- For portrait installation the intake vents must be installed at the top and bottom. To ensure air flow to the bottom intake vent, a rack to support the unit is necessary. Please hire an installation service provider (for a fee) to make a custom portrait projection stand.
- When installed in portrait orientation the projector can be tilted forward or backward within a range of ± 10°. Tilting the projector forward or backward outside of this range, or tilting it to the left or to the right could cause it to malfunction.

- To ensure air flow, maintain 30 cm/11.8” of space between the intake vent and the installation surface.
  (NOTE) In the figure to the right there is plenty of space behind, above, and on either side of the projector unit.
6. Installation and Connections

Design and manufacturing conditions for the projector stand

Please hire an installation service provider (for a fee) to design and manufacture a customized stand. Please ensure that the design complies with the following conditions:

- There is one intake vent on either side and one exhaust vent at the rear. These should remain unobstructed. Also, secure enough space for easy filter cover removal for filter cleaning.
- Remove the level adjusters or the projector handles in case these hit against the stand. For removing the level adjuster, rotate the level adjuster itself, and for removing the handle, remove the handle fastening screws.
- Fix the stand onto the ceiling mount screw holes (6 positions) on the projector bottom face.
  Dimensions of screw hole: for M6 screw Maximum depth 10 mm (Calculate the bolt length depending on the stand design)
- Horizontal adjustment mechanism (for example, bolts and nuts in 4 places)
- Make sure to design the stand not falling over easily.

Reference drawings

* Figure illustrating the dimensions and conditions (not actual design blueprint).

(Unit: mm)

![Reference diagrams](image_url)

**CAUTION**

- When moving the projector, make sure you have at least four people. Attempting to move the projector alone could result in back pain or other injuries.
7. Maintenance

This section describes the simple maintenance procedures you should follow to clean the filters, the lens, and the cabinet.

1 Cleaning the Filters

The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter is dirty or clogged, your projector may overheat.

**WARNING**

- Please do not use a spray containing flammable gas to remove dust attached to the filters, etc. Doing so may result in fires.

**NOTE:** The message for filter cleaning will be displayed for one minute after the projector is turned on or off. When the message is displayed, clean the filters. The time to clean the filters is set to [OFF] at time of shipment. (→ page 102)

To cancel the message, press any button on the projector cabinet or the remote control.

**CAUTION**

- Before cleaning the filter, first turn off the power, make sure the cooling fan has completely stopped, then turn off the main power switch. Make sure the unit has cooled down completely before cleaning the filter. Removing the filter cover while the unit is running could result in burns or electric shock from contact with internal parts.

The unit uses a three layer metal-mesh filter installed behind the filter cover. It can be used repeatedly by periodical cleaning.

There are four filters in total, located on the right and left sides. Clean all four at the same time.

1. **Remove the filter cover.**
   
   (1) Twist the knob to the left until it turns without resistance.
   
   (2) Open the filter cover and remove it.

   - The knob does not come off.
   - If the knob will not turn, use a Phillips head screwdriver.

![Filter cover(Filter)](image-url)
2. **Undo the lock lever on the filter cover and remove it.**
   If the filter gets caught on the filter cover, press the filter cover down slightly and it will come out.

3. **Remove the filters.**
   (1) Turn the tabs to the left position and slide the top filter to the right.

   - If it is stuck, slowly inserting the tip of a Phillips head screwdriver into the gap in a few places will loosen it.

   **NOTE:**
   - Do not apply a high degree of force or attempt to pry it open. This could deform the flange making it impossible to reattach the filter cover.
   
   (2) With the tabs still on the left-facing position, remove the filter inside by pulling it toward you. All three layers of the filter will come out.

4. **Clean all the dust from the filters using a vacuum cleaner.**
   Carefully remove the dust from the filter covers as well as from both sides of all the filters.
Remove the dust from the grates on the outside of the projector as well.
- Some intake vents do not have grates. Be sure to also remove any dust stuck to the louver (blind with angled horizontal slats) with a vacuum cleaner.

**NOTE:**
- Whenever you vacuum the filter, use the soft brush attachment to vacuum. This is to avoid damage to the filter.
- Do not wash the filter with water. Doing so can result in damage to the filter membrane and also cause clogging.

5. **Put the various parts of the filter together and fit them inside the filter cover.**

The three layers of the filter must be assembled and installed in a particular order and direction.

1. Turn the tabs on the fine grade filter to the left, turn the tabs on the medium grade filter (with diagonal crossed mesh) to the right, then slide the fine grade filter into the medium grade filter.

2. Turn the tab slots on the coarse grade filter to the left. Next set the fine grade filter and the medium grade filter into the flange, then slide them to the left.

3. Make sure that all six tabs are slightly into the tab slots, then slowly push the filter together (some filters have ten tabs).
- If the parts of the filter are not completely fitted together they will not fit inside the filter cover.
(4) Turn the fine grade filter so it is facing upward, set the cutout portion of the medium grade filter inside the filter cover along the direction indicated by the tabs, and slowly slide the filter in.

(5) Lock the lever, and insert it into the lock slot on the fine grade filter.

6. Fix the filter inside the projector unit.
   (1) Snap the filter cover tabs into the cutout portion of the projector unit to secure it.
   (2) Turn the knob to the right to fix it in place.

   Clean the other intake vent air filters in the same way.

NOTE:
- Before turning on the power make sure that all filter covers are in place. If they are not fitted properly dust could get inside the projector causing it to malfunction.
- Reset [FILTER HOURS USED] after cleaning the filters. To reset go to the on screen menu and select [SETUP] → [RESET] → [CLEAR FILTER HOURS]. (→ page 124)
2 Cleaning the Protection glass

- Turn off the projector before cleaning.
- Use a blower or lens paper to clean the protection glass, and be careful not to scratch or mar the protection glass.

⚠️ WARNING
- Do not look into the light source while the projector is ON. Strong light is emitted from the projector and visual impairment could result.
- Please do not use a spray containing flammable gas to remove dust attached on the protection glass, etc. Doing so may result in fires.

3 Cleaning the Cabinet

Turn off the projector, and unplug the projector before cleaning.
- Use a dry soft cloth to wipe dust off the cabinet.
  - If heavily soiled, use a mild detergent.
- Never use strong detergents or solvents such as alcohol or thinner.
- When cleaning the ventilation slits or the speaker using a vacuum cleaner, do not force the brush of the vacuum cleaner into the slits of the cabinet.

Vacuum the dust off the ventilation slits.

- Poor ventilation caused by dust accumulation in ventilation openings (intake, exhaust) can result in overheating and malfunction. These areas should be cleaned regularly.
- Do not scratch or hit the cabinet with your fingers or any hard objects
- Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off.
Operating Environment for User Supportware

The following software programs can be downloaded from our website.

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Remote Tool (Windows only)</td>
<td>When the computer and projector are connected using a network (wired LAN), such operations as turning the projector’s power on and off and switching the signal can be performed. It is also possible to send an image to the projector and register it as the background logo. Once the image is registered, it can be locked to prevent the logo from being overwritten. (→ page 150)</td>
</tr>
<tr>
<td>PC Control Utility Pro 4, PC Control Utility Pro 5 (for Mac OS)</td>
<td>This is a software program used to operate the projector from the computer when the computer and the projector are connected with LAN. (→ page 153) • PC Control Utility Pro 4 can be used with a serial connection.</td>
</tr>
</tbody>
</table>

**NOTE:**
- To connect the projector to the network by using the Virtual Remote Tool, PC Control Utility Pro 4, PC Control Utility Pro 5, please configure the settings of [SETUP] → [NETWORK SETTINGS] in the on-screen menu (→ page 115).

**Download service**

For the update information about these software programs, visit our website:


**Operating Environment**

**[Windows]**


**[Mac]**

| Supported OS | Mac OS X v10.6, v10.7, v10.8, v10.9, v10.10 |
Installing Software Program

Installation for Windows software

The software programs except PC Control Utility Pro 5 support Windows 8.1, Windows 8, Windows 7, Windows Vista, and Windows XP.

NOTE:
• To install or uninstall each software program, the Windows user account must have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7, Windows Vista) or “Computer Administrator” privilege (Windows XP).
• Exit all running programs before installation. If another program is running, the installation may not be completed.

2. Download the supported software programs from “Download” and save an “.exe” file to your computer.
   File name is different depending on the version of the software program.
3. Click the “.exe” file.
   The installation will start.
   Follow the instructions on the installer screens to complete the installation.

TIP:
Uninstalling a Software Program

Preparation:
Exit the software program before uninstalling. To uninstall the software program, the Windows user account must have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7, and Windows Vista) or “Computer Administrator” privilege (Windows XP).

• For Windows 8.1/Windows 8/Windows 7/Windows Vista
  1 Click “Start” and then “Control Panel”.
   The Control Panel window will be displayed.
  2 Click “Uninstall a program” under “Programs”
   The “Programs and Features” window will be displayed.
  3 Select the software program and click it.
  4 Click “Uninstall/Change” or “Uninstall”.
   • When the “User Account Control” windows is displayed, click “Continue”.
   Follow the instructions on the screens to complete the uninstallation.

• For Windows XP
  1 Click “Start” and then “Control Panel”.
   The Control Panel window will be displayed.
  2 Double-click “Add / Remove Programs”.
   The Add / Remove Programs window will be displayed.
  3 Click the software program from the list and then click “Remove”.
   Follow the instructions on the screens to complete the uninstallation.
Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer.

1. Connect your computer to the Internet and visit our website (http://www.nec-display.com/dl/en/index.html).
2. Download the updated PC Control Utility Pro 5 for Mac OS from our website.
3. In Finder, control-click (“control”+ click) or right click the PC Control Utility Pro 5.pkg.
4. Select “Open” from the top of contextual menu that appears.
5. Click “Open” in the dialog box. If prompted, enter an administrator name and password.
6. Click “Next”.
   “END USER LICENSE AGREEMENT” screen will be displayed.
7. Read “END USER LICENSE AGREEMENT” and click “Next”.
   The confirmation window will be displayed
8. Click “I accept the terms in the license agreement”.
   Follow the instructions on the installer screens to complete the installation.

TIP:
• Uninstalling a software program
   1. Put the “PC Control Utility Pro 5” folder to the Trash icon.
   2. Put the configuration file of PC Control Utility Pro 5 to the Trash icon.
      • The configuration file of PC Control Utility Pro 5 is located in “/Users/<your user name>/Application Data/NEC Projector User Supportware/PC Control Utility Pro 5”.
8. User Supportware

3 Operating the Projector Via the LAN (Virtual Remote Tool)

This will help you perform operations such as projector’s power on or off and signal selection via a LAN connection. It is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote control operation on your PC.

Virtual Remote screen

Remote Control Window

NOTE:
- Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:
  (Only via serial or LAN connection)
  * File size: Within 256 kilobytes
  * Image size: Within the resolution of the projector
  * File format: PNG (Full color)
- Logo data (image) sent using the Virtual Remote Tool will be displayed in the center with the surrounding area in black.
- To put the default “NEC logo” back in the background logo, you need to register it as the background logo by using the image file (¥Logo¥NEC_logo2012_1920x1080.png) included on the supplied NEC Projector CD-ROM.
Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 138) and “[NETWORK SETTINGS]” (→ page 115)

Start Virtual Remote Tool
Start using the shortcut icon
• Double-click the shortcut icon on the Windows Desktop.

Start from the Start menu
• Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] → [Virtual Remote Tool].

When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

The “Easy Setup” feature is not available on this model. Click “Close Easy Setup”.
Closing the “Easy Setup” window will display the “Projector List” window.
Select your projector you wish to connect. This will display the Virtual Remote screen.

NOTE:
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via network connection.

TIP:
• The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window.
  To do so, click to place a check mark for “[ ] Do not use Easy Setup next time” on the screen.
8. User Supportware

Exiting Virtual Remote Tool

1. Click the Virtual Remote Tool icon on the Taskbar.
   The pop-up menu will be displayed.

2. Click “Exit”.
   The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool

• Displaying the help file using the taskbar

1. Click the Virtual Remote Tool icon on the taskbar when Virtual Remote Tool is running.
   The pop-up menu will be displayed.

2. Click “Help”.
   The Help screen will be displayed.

• Displaying the help file using the Start Menu.

1. Click “Start” > “All programs” or “Programs” > “NEC Projector User Supportware” > “Virtual Remote Tool” and then “Virtual Remote Tool Help” in this order.
   The Help screen will be displayed.
Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5)

Using the utility software “PC Control Utility Pro 4” or “PC Control Utility Pro 5” included on the companion NEC Projector CD-ROM, the projector can be controlled from a computer over a LAN.

PC Control Utility Pro 4 is a program compatible with Windows. (→ next page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 155)

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 154, 155)

Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start PC Control Utility Pro 4/Pro 5.

TIP:
• PC Control Utility Pro 4 can be used with a serial connection.
Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer
Refer Installing Software Program on page 148, 149.

Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 138) and “[NETWORK SETTINGS]” (→ page 115)

(Using on Windows)
Step 3: Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4”.

NOTE:
• For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the scheduler.
[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer to sleep” → “Never”.
NOTE:
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN) connection.

TIP:
Viewing the Help of PC Control Utility Pro 4
• Displaying the Help file of PC Control Utility Pro 4 while it is running.
  Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.
  The pop-up menu will be displayed.

• Displaying the help file using the Start Menu.
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4 Help”.
  The Help screen will be displayed.
(Using on Mac OS)

Step 3: Start PC Control Utility Pro 5

1. Open your Applications folder in Mac OS.
2. Click the “PC Control Utility Pro 5” folder.
3. Click the “PC Control Utility Pro 5” icon.

PC Control Utility Pro 5 will start.

NOTE:
• For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN) connection.

TIP:

Viewing the Help of PC Control Utility Pro 5

• Displaying the Help file of PC Control Utility Pro 5 while it is running.
  • From the menu bar, click “Help” → “Help” in this order.
    The Help screen will be displayed.

• Displaying the Help using the Dock
  1. Open “Application Folder” in Mac OS.
  2. Click the “PC Control Utility Pro 5” folder.
  3. Click the “PC Control Utility Pro 5 Help” icon.
    The Help screen will be displayed.
9. Appendix

1 Throw distance and screen size

Four separate bayonet style lenses can be used on this projector. Refer to the information on this page and use a lens suited for the installation environment (screen size and throw distance). For installation and replacement of lens units contact your dealer.

Each number provided in the table below means the throw distance between the lens surface and the screen.

Lens types and throw distance

calculated on the installation environment (screen size and throw distance). For installation and replacement of lens units contact your dealer.

Each number provided in the table below means the throw distance between the lens surface and the screen.

Lens types and throw distance

<table>
<thead>
<tr>
<th>Screen size (cm)</th>
<th>NP-9LS08ZM1</th>
<th>NP-9LS12ZM1</th>
<th>NP-9LS13ZM1</th>
<th>NP-9LS16ZM1</th>
</tr>
</thead>
<tbody>
<tr>
<td>60″</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>70″</td>
<td>1.4–2.1</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>100″</td>
<td>2.0–3.0</td>
<td>2.8–4.0</td>
<td>3.1–4.9</td>
<td>3.8–6.3</td>
</tr>
<tr>
<td>120″</td>
<td>2.4–3.6</td>
<td>3.4–4.8</td>
<td>3.7–5.9</td>
<td>4.5–7.6</td>
</tr>
<tr>
<td>150″</td>
<td>3.0–4.5</td>
<td>4.2–6.0</td>
<td>4.7–7.4</td>
<td>5.7–9.5</td>
</tr>
<tr>
<td>200″</td>
<td>4.0–6.0</td>
<td>5.6–8.1</td>
<td>6.2–9.9</td>
<td>7.6–12.7</td>
</tr>
<tr>
<td>250″</td>
<td>5.0–7.5</td>
<td>7.0–10.1</td>
<td>7.8–12.4</td>
<td>9.5–15.9</td>
</tr>
<tr>
<td>300″</td>
<td>6.0–9.0</td>
<td>8.5–12.1</td>
<td>9.4–14.9</td>
<td>11.4–19.1</td>
</tr>
<tr>
<td>350″</td>
<td>7.0–10.6</td>
<td>9.9–14.2</td>
<td>11.0–17.4</td>
<td>13.3–22.3</td>
</tr>
<tr>
<td>400″</td>
<td>8.0–12.1</td>
<td>11.3–16.2</td>
<td>12.5–19.8</td>
<td>15.2–25.5</td>
</tr>
<tr>
<td>450″</td>
<td>9.0–13.6</td>
<td>12.7–18.2</td>
<td>14.1–22.4</td>
<td>17.1–28.9</td>
</tr>
<tr>
<td>500″</td>
<td>10.0–15.1</td>
<td>14.1–20.2</td>
<td>15.7–24.8</td>
<td>19.0–31.9</td>
</tr>
<tr>
<td>550″</td>
<td>11.1–16.6</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>600″</td>
<td>12.1–18.1</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

TIP

Calculation of the throw distance from the screen size

NP-9LS08ZM1 lens throw distance (m) = \( H \times 0.90 \) to \( H \times 1.35 : 1.4 \) m (min.) to 18.1 m (max.)

NP-9LS12ZM1 lens throw distance (m) = \( H \times 1.28 \) to \( H \times 1.83 : 2.8 \) m (min.) to 20.2 m (max.)

NP-9LS13ZM1 lens throw distance (m) = \( H \times 1.42 \) to \( H \times 2.24 : 3.1 \) m (min.) to 24.8 m (max.)

NP-9LS16ZM1 lens throw distance (m) = \( H \times 1.73 \) to \( H \times 2.88 : 3.8 \) m (min.) to 31.9 m (max.)

“H” (Horizontal) refers to the screen width.

* Figures differ by several % with the table above because the calculation is approximate.

Ex.: Throw distance when projecting on a 300” screen using the NP-9LS13ZM1 lens:

According to the “Tables of screen sizes and dimensions” (→ page 157), \( H \) (screen width) = 664.1 cm.

The throw distance is 6.641 cm × 1.42 to 6.641 cm × 2.24 = 9.430 cm to 14.876 cm (because of the zoom lens).
Projection range for the different lenses

<table>
<thead>
<tr>
<th>Lens</th>
<th>Projection Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>NP-9LS13ZM1</td>
<td>3.1–24.8 m</td>
</tr>
<tr>
<td>NP-9LS08ZM1</td>
<td>1.4–18.1 m</td>
</tr>
<tr>
<td>NP-9LS12ZM1</td>
<td>2.8–20.2 m</td>
</tr>
<tr>
<td>NP-9LS16ZM1</td>
<td>3.8–31.9 m</td>
</tr>
</tbody>
</table>

Tables of screen sizes and dimensions

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width</th>
<th>Screen height</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(inches)</td>
<td>(cm)</td>
</tr>
<tr>
<td>60</td>
<td>52</td>
<td>132.8</td>
</tr>
<tr>
<td>70</td>
<td>61</td>
<td>155.0</td>
</tr>
<tr>
<td>100</td>
<td>87</td>
<td>221.4</td>
</tr>
<tr>
<td>150</td>
<td>131</td>
<td>332.1</td>
</tr>
<tr>
<td>200</td>
<td>174</td>
<td>442.8</td>
</tr>
<tr>
<td>250</td>
<td>218</td>
<td>553.5</td>
</tr>
<tr>
<td>300</td>
<td>261</td>
<td>664.1</td>
</tr>
<tr>
<td>350</td>
<td>305</td>
<td>774.1</td>
</tr>
<tr>
<td>400</td>
<td>349</td>
<td>885.5</td>
</tr>
<tr>
<td>450</td>
<td>392</td>
<td>996.2</td>
</tr>
<tr>
<td>500</td>
<td>436</td>
<td>1106.9</td>
</tr>
<tr>
<td>550</td>
<td>479</td>
<td>1217.6</td>
</tr>
<tr>
<td>600</td>
<td>523</td>
<td>1328.3</td>
</tr>
</tbody>
</table>
**Lens shifting range**

This projector is equipped with a lens shift function for adjusting the position of the projected image by using the LENS SHIFT buttons (→ page 22). The lens can be shifted within the range shown below.

**NOTE:**
- Please do not use the lens shift function when projecting portrait images. Please use it with the lens in the center.

Legend: V “Vertical” refers to the screen height and H “Horizontal” refers to the screen width. The lens shift range is expressed as a ratio of height and width, respectively.

Compatible lens units
NP-9LS08ZM1, NP-9LS12ZM1, NP-9LS13ZM1, NP-9LS16ZM1

* The lens shift range is the same for ceiling installation.

(Example calculation) If projecting on a 300 inch screen using an NP-9LS13ZM1 lens unit
According to the “Table of screen sizes and dimensions” (→ page 157), H = 261.5”/664.1 cm, V = 147.1”/373.6 cm. Adjustment range in the vertical direction: the projected image can be moved upwards 0.5 × 147.1”/373.6 cm = 73.6”/187 cm, downwards approximately 73.6”/187 cm (when the lens is at the center position). Adjustment range in the horizontal direction: the projected image can be moved to the left 0.11 × 261.5”/664.1 cm = 28.7”/73 cm, to the right approximately 28.7”/73 cm.
* Figures differ by several % because the calculation is approximate.
Mounting the Optional Board (sold separately)

CAUTION
Before mounting or removing the optional board, be sure to turn off the projector, wait for the fans to stop and turn off the main power switch.

Tool needed: Phillips screwdriver (plus-head)

1. **Turn off the main power switch of the projector.**

2. **Loosen the two screws on the SLOT cover of the terminals.**
   Remove the two screws and the SLOT cover.
   
   **NOTE:** Keep the two screws and the slot cover.

3. **Insert the optional board into the slot.**
   Make sure that the board is inserted into the slot in the correct orientation.
   Incorrect orientation may cause miscommunication between the optional board and projector.
4. **Tighten the two screws on both sides of the slot.**
   - Be sure to tighten the screws.

   This will complete installation of the optional board.

   To select the optional board source, select SLOT as the input.

   ![Diagram showing screws being tightened on both sides of a slot.]

---

**NOTE:**
- Mounting the optional board may cause the fans to run in the standby mode for the purpose of cooling depending on the optional board. The fan speed may also increase in order to cool the projector properly. Both of these instances are considered normal and not a malfunction of the projector.
### Compatible Input Signal List
#### Analog Computer Signal

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>56/60/72/75/85/iMac</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>60/70/75/85/iMac</td>
</tr>
<tr>
<td>XGA+</td>
<td>1152 × 864</td>
<td>4 : 3</td>
<td>60/70/75/85</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
<td>4 : 3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td></td>
<td>1280 × 800</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1360 × 768</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4 : 3</td>
<td>60/75/85</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60/75/85</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60/75</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
<td>4 : 3</td>
<td>60/65/70/75</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>2K</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>MAC 13&quot;</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>67</td>
</tr>
<tr>
<td>MAC 16&quot;</td>
<td>832 × 624</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 19&quot;</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21&quot;</td>
<td>1152 × 870</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23&quot;</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>65</td>
</tr>
</tbody>
</table>

#### Component

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDTV (1080p)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (1080)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>720 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576p)</td>
<td>720 × 576</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (480i)</td>
<td>720 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i)</td>
<td>720 × 576</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
</tbody>
</table>

#### Composite Video/S-Video

<table>
<thead>
<tr>
<th>Signal</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>PAL</td>
<td>4 : 3</td>
<td>50</td>
</tr>
<tr>
<td>PAL60</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SECAM</td>
<td>4 : 3</td>
<td>50</td>
</tr>
</tbody>
</table>
### HDMI

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 800</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1366 × 768</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>UXGA+</td>
<td>1600 × 1200</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1200</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>2K</td>
<td>2048 × 1080</td>
<td>17 : 9</td>
<td>60</td>
</tr>
<tr>
<td>iMac 27&quot;</td>
<td>2560 × 1440</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WQHD</td>
<td>2560 × 1600</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>4K</td>
<td>3840 × 2160</td>
<td>16 : 9</td>
<td>23.98/24/25/29.97/30</td>
</tr>
<tr>
<td>4K</td>
<td>4096 × 2160</td>
<td>17 : 9</td>
<td>24</td>
</tr>
<tr>
<td>HDTV(1080p)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(1080i)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(720p)</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480i/p)</td>
<td>720/1440 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i/p)</td>
<td>720/1440 × 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

### HDMI 3D

<table>
<thead>
<tr>
<th>Signal Resolution (dots)</th>
<th>Refresh Rate (Hz)</th>
<th>Aspect Ratio</th>
<th>3D Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 × 1080p</td>
<td>23.98/24</td>
<td>16 : 9</td>
<td>Frame Packing</td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>Top and Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td>1920 × 1080i</td>
<td>50</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Frame Packing</td>
<td></td>
</tr>
<tr>
<td>1280 × 720p</td>
<td>50</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Top and Bottom</td>
<td></td>
</tr>
</tbody>
</table>
## DisplayPort

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
<td>15 : 9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366 × 768</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>UXGA+</td>
<td>1600 × 1200</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1200</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>2K</td>
<td>2048 × 1080</td>
<td>17 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WQHD iMac 27”</td>
<td>2560 × 1440</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WQXGA</td>
<td>2560 × 1600</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>4K</td>
<td>3840 × 2160</td>
<td>16 : 9</td>
<td>23.98/24/25/29.97/30</td>
</tr>
<tr>
<td></td>
<td>4096 × 2160</td>
<td>17 : 9</td>
<td>24</td>
</tr>
<tr>
<td>HDTV (1080p)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480i/p)</td>
<td>720/1440 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i/p)</td>
<td>720/1440 × 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

### DisplayPort 3D

<table>
<thead>
<tr>
<th>Signal Resolution (dots)</th>
<th>Refresh Rate (Hz)</th>
<th>Aspect Ratio</th>
<th>3D Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 × 1080p</td>
<td>23.98/24</td>
<td>16 : 9</td>
<td>Side By Side</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>Top and Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td>1920 × 1080i</td>
<td>50</td>
<td>Top and Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td>1280 × 720p</td>
<td>50</td>
<td>Top and Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Side By Side</td>
<td></td>
</tr>
</tbody>
</table>

*1 Native resolution

*2 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].

*3 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [4:3] for [ASPECT RATIO].

- Signals exceeding the projector’s resolution are handled with Advanced AccuBlend.
- With Advanced AccuBlend, the size of characters and ruled lines may be uneven and colors may be blurred.
- Upon shipment, the projector is set for signals with standard display resolutions and frequencies, but adjustments may be required depending on the type of computer.
## Specifications

<table>
<thead>
<tr>
<th>Model name</th>
<th>PH1202HL1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>3 chip DMD reflection type</td>
</tr>
</tbody>
</table>

### Specifications of main parts

<table>
<thead>
<tr>
<th>Component</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DMD panel</strong></td>
<td>Size: 0.65&quot; (aspect ratio: 16:9)</td>
</tr>
<tr>
<td></td>
<td>Pixels (*): 2,073,600 (1920 dots x 1080 lines)</td>
</tr>
<tr>
<td><strong>Projection lenses</strong></td>
<td>Zoom: Power zoom (zoom range depends on lens)</td>
</tr>
<tr>
<td></td>
<td>Focus: Power focus</td>
</tr>
<tr>
<td></td>
<td>Lens shifting: Power lens shift</td>
</tr>
<tr>
<td>Light source</td>
<td>Laser Diode</td>
</tr>
<tr>
<td><strong>Optical device</strong></td>
<td>Optical isolation by dichroic mirror, combining by dichroic prism</td>
</tr>
<tr>
<td>Light output</td>
<td>(2) (3) 12,000 lm</td>
</tr>
<tr>
<td><strong>Contrast ratio</strong> (white/all black)</td>
<td>10,000:1 with dynamic contrast</td>
</tr>
<tr>
<td><strong>Screen size (throw distance)</strong></td>
<td>Please refer to projection lens specifications (projection lenses sold separately). (→ page 166)</td>
</tr>
<tr>
<td><strong>Color reproducibility</strong></td>
<td>10-bit color processing (approx. 1.07 billion colors)</td>
</tr>
</tbody>
</table>

### Scanning frequency

| Component       | Horizontal: Analog: 15 kHz, 24 to 100 kHz (24 kHz or greater for RGB inputs), conforming to VESA standards. Digital: 15 kHz, 24 to 153 kHz, conforming to VESA standards |
|                 | Vertical: Analog: 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards. Digital: 24, 25, 30, 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards |

### Main adjustment functions

Power zoom, power focus, power lens shift, input signal switching (HDMI/DisplayPort/ BNC/BNC(CV)/BNC(Y/C)/COMPUTER/HDBaseT/SLOT), auto image adjustment, picture magnification, shutter, muting (video), power on/standby, on-screen display/ selection, etc.

### Max. display resolution (horizontal × vertical)

Analog: 1920 × 1200 (handled with Advanced AccuBlend) Digital: 4096 × 2160 (handled with Advanced AccuBlend)

### Input signals

- **RGB**:
  - 0.7Vp-p/75Ω
  - 1.0Vp-p/75Ω (with Negative Polarity Sync)
  - **Cb, Cr (Pb, Pr):** 0.7Vp-p/75Ω
  - **H/V Sync:** 4.0Vp-p/TTL
  - **Composite Sync:** 4.0Vp-p/TTL
  - **Sync on G:** 1.0Vp-p/75Ω (with Sync)

- **S-Video**:
  - Y: 1.0Vp-p/75Ω
  - C: 0.286Vp-p/75Ω

- **Component**:
  - Y: 1.0Vp-p/75Ω (with Sync)
  - **Cb, Cr (Pb, Pr):** 0.7Vp-p/75Ω
  - **DTV:** 480i, 480p, 720p, 1080i, 1080p (60Hz)
  - 756p, 756p, 720p, 1080i, 1080p (50Hz)
  - **DVD:** Progressive signal (50/60Hz)

### Input/output terminals

<table>
<thead>
<tr>
<th>Component/Component</th>
<th>Video input</th>
<th>Mini D-Sub 15-pin × 1, BNC terminal × 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI</td>
<td>Video input</td>
<td>HDMI™ Terminal type A × 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deep Color (color depth): 8/10/12-bit compatible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Colorimetry: RGB, YCbCr444 and YcbCr422 compatible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LipSync compatible, HDCP compatible (*)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Supports 4K and 3D</td>
</tr>
<tr>
<td>Video output</td>
<td></td>
<td>Repeater</td>
</tr>
<tr>
<td>Audio input</td>
<td>HDMI: Sampling frequency – 32/44.1/48 kHz, Sampling bits – 16/20/24 bits</td>
<td></td>
</tr>
<tr>
<td>HDBaseT</td>
<td>Video input</td>
<td>Deep Color (color depth): Support 8/10/12 bits</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Colorimetry: Support RGB, YCbCr444 and YcbCr422</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Support LipSync, HDCP (*)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4K , 3D</td>
</tr>
<tr>
<td>Audio input</td>
<td>Sampling frequency: 32/44.1/48 kHz</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sampling bit: 16/20/24 bit</td>
</tr>
<tr>
<td>DisplayPort</td>
<td>Video input</td>
<td>DisplayPort × 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data rate: 2.7Gbps/1.62Gbps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No. lanes: 1 lane/2 lanes/4 lanes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color depth: 6-bit, 8-bit, 10-bit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Colorimetry: RGB, YCbCr444 and YcbCr422 compatible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HDCP compatible (*)</td>
</tr>
<tr>
<td>Audio input</td>
<td>DisplayPort: Sampling frequency – 32/44.1/48 kHz, Sampling bits – 16/20/24 bits</td>
<td></td>
</tr>
<tr>
<td>BNC (CV)</td>
<td>Video input</td>
<td>BNC × 1</td>
</tr>
<tr>
<td>BNC (Y/C)</td>
<td>Video input</td>
<td>BNC × 2</td>
</tr>
<tr>
<td>USB port</td>
<td>USB type A × 1</td>
<td></td>
</tr>
</tbody>
</table>
9. Appendix

Model name | PH1202HL1
--- | ---
Ethernet/HDBaseT port | RJ-45 x 1, Supports BASE-TX
3D SYNC output terminal | D-Sub
Remote terminal | Stereo mini jack x 1
RS-232C terminal (PC control) | D-Sub 9-pin x 1
3D terminal | D-Sub 15-pin x 1
IP/I/O terminal | D-Sub 37-pin x 1

Usage environment
- Operating temperature: 5 to 40°C (°C)
- Operating humidity: 20 to 80% (with no condensation)
- Storage temperature: -10 to 50°C (°C)
- Storage humidity: 20 to 80% (with no condensation)
- Operating altitude: 0 to 2600 m/8500 feet

* Light output value sometimes drops by the environment at highlands.

Power supply | 200-240 V AC, 50/60 Hz

Power consumption

<table>
<thead>
<tr>
<th>STAND-BY MODE</th>
<th>LIGHT MODE</th>
<th>POWER</th>
<th>CONSUMPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORMAL</td>
<td>NORMAL</td>
<td>1392 W</td>
<td>1110 W</td>
</tr>
<tr>
<td>ECO1</td>
<td>ECO2</td>
<td>752 W</td>
<td>752 W</td>
</tr>
<tr>
<td>LONG LIFE</td>
<td>LONG LIFE</td>
<td>1291 W</td>
<td>1291 W</td>
</tr>
<tr>
<td>STANDBY</td>
<td>STANDBY</td>
<td>1.83 W</td>
<td>5.7 W</td>
</tr>
</tbody>
</table>

Rated input current | 9.2 A

External dimensions | 26.8” (width) x 13.1” (height) x 33.9” (depth)/680 (width) x 333 (height) x 860 (depth) mm (not including the lens/lens hood, handles, or other protruding parts)

Weight | 160.9lbs/73.0kg (not including lens)

*1 Effective pixels are more than 99.99%.
*2 Compliance with ISO21118-2005
*3 This is the light output value that results from setting the [LIGHT MODE] to [NORMAL] and setting the [PRESET] to [HIGH-BRIGHT] while using the NP-9LS16ZM1 lens (sold separately).
   The light output value is lower when setting the [LIGHT MODE] to [ECO1], [ECO2] or [LONG LIFE]. ([ECO1]: about 80%, [ECO2]: about 50%, [LONG LIFE]: about 90%). If any other mode is selected as the [PRESET] mode, the light output value may drop slightly.
*4 HDMI® (Deep Color, Lip Sync) with HDCP
   What is HDCP/HDCP technology?
   HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI).
   If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).
   Video: Deep Color; 8/10/12-bit, LipSync
   Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit; 16/20/24-bit
*5 35 to 40°C – “Forced eco mode”
   • These specifications and the product's design are subject to change without notice.

For additional information visit:
US: http://www.necdisplay.com/
For information on our optional accessories, visit our website or see our brochure.
### Option lens (sold separately)

<table>
<thead>
<tr>
<th>Model</th>
<th>Features</th>
<th>Screen Size (Throwing Distance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NP-9LS08ZM1</td>
<td>Power lens shift, Power zoom, Power focus, [LENS MEMORY] support</td>
<td>70 - 600 inch, 1.4 - 18.1 m</td>
</tr>
<tr>
<td></td>
<td>(Throw ratio 0.90–1.35:1, F2.5/3.0, f = 0.5–0.8”/13.3–19.9 mm)</td>
<td></td>
</tr>
<tr>
<td>NP-9LS12ZM1</td>
<td>Power lens shift, Power zoom, Power focus, [LENS MEMORY] support</td>
<td>100 - 500 inch, 2.8 - 20.2 m</td>
</tr>
<tr>
<td></td>
<td>(Throw ratio 1.27–1.82:1, F2.5/2.5, f = 0.7–1.1”/18.6–26.7 mm)</td>
<td></td>
</tr>
<tr>
<td>NP-9LS13ZM1</td>
<td>Power lens shift, Power zoom, Power focus, [LENS MEMORY] support</td>
<td>100 - 500 inch, 3.1 - 24.8 m</td>
</tr>
<tr>
<td></td>
<td>(Throw ratio 1.41–2.23:1, F2.5/2.5, f = 0.8–1.3”/20.7–32.7 mm)</td>
<td></td>
</tr>
<tr>
<td>NP-9LS16ZM1</td>
<td>Power lens shift, Power zoom, Power focus, [LENS MEMORY] support</td>
<td>100 - 500 inch, 3.8 - 31.9 m</td>
</tr>
<tr>
<td></td>
<td>(Throw ratio 1.71–2.87:1, F2.5/2.5, f = 1–1.7”/25.2–42 mm)</td>
<td></td>
</tr>
</tbody>
</table>
9. Appendix

Cabinet Dimensions

Unit: mm (inch)
Figure for securing the unit with dimensions

Unit: mm (inch)
### 9. Appendix

#### 9. Appendix

### Pin assignments and signal names of main terminals

#### COMPUTER IN/ Component Input Terminal (Mini D-Sub 15 Pin)

Connection and signal level of each pin

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>RGB Signal (Analog)</th>
<th>YCbCr Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>Cr</td>
</tr>
<tr>
<td>2</td>
<td>Green or Sync on Green</td>
<td>Y</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>Cb</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Red Ground</td>
<td>Cr Ground</td>
</tr>
<tr>
<td>7</td>
<td>Green Ground</td>
<td>Y Ground</td>
</tr>
<tr>
<td>8</td>
<td>Blue Ground</td>
<td>Cb Ground</td>
</tr>
<tr>
<td>9</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sync Signal Ground</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Bi-directional DATA (SDA)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Horizontal Sync or Composite Sync</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Vertical Sync</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Data Clock</td>
<td></td>
</tr>
</tbody>
</table>

**Signal Level**

- Video signal: 0.7Vp-p (Analog)
- Sync signal: TTL level

#### HDMI IN Terminal (Type A)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TMDS Data 2+</td>
<td>11</td>
<td>TMDS Clock Shield</td>
</tr>
<tr>
<td>2</td>
<td>TMDS Data 2 Shield</td>
<td>12</td>
<td>TMDS Clock–</td>
</tr>
<tr>
<td>3</td>
<td>TMDS Data 2–</td>
<td>13</td>
<td>CEC</td>
</tr>
<tr>
<td>4</td>
<td>TMDS Data 1+</td>
<td>14</td>
<td>Disconnection</td>
</tr>
<tr>
<td>5</td>
<td>TMDS Data 1 Shield</td>
<td>15</td>
<td>SCL</td>
</tr>
<tr>
<td>6</td>
<td>TMDS Data 1–</td>
<td>16</td>
<td>SDA</td>
</tr>
<tr>
<td>7</td>
<td>TMDS Data 0+</td>
<td>17</td>
<td>DDC/CEC grounding</td>
</tr>
<tr>
<td>8</td>
<td>TMDS Data 0 Shield</td>
<td>18</td>
<td>+5 V power supply</td>
</tr>
<tr>
<td>9</td>
<td>TMDS Data 0–</td>
<td>19</td>
<td>Hot plug detection</td>
</tr>
<tr>
<td>10</td>
<td>TMDS Clock +</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### DisplayPort IN Terminal

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Main link lane 3–</td>
<td>11</td>
<td>Grounding 0</td>
</tr>
<tr>
<td>2</td>
<td>Grounding 3</td>
<td>12</td>
<td>Main link lane 0+</td>
</tr>
<tr>
<td>3</td>
<td>Main link lane 3+</td>
<td>13</td>
<td>Configuration 1</td>
</tr>
<tr>
<td>4</td>
<td>Main link lane 2–</td>
<td>14</td>
<td>Configuration 2</td>
</tr>
<tr>
<td>5</td>
<td>Grounding 2</td>
<td>15</td>
<td>Supplementary channel +</td>
</tr>
<tr>
<td>6</td>
<td>Main link lane 2+</td>
<td>16</td>
<td>Grounding 4</td>
</tr>
<tr>
<td>7</td>
<td>Main link lane 1–</td>
<td>17</td>
<td>Supplementary channel –</td>
</tr>
<tr>
<td>8</td>
<td>Grounding 1</td>
<td>18</td>
<td>Hot plug detection</td>
</tr>
<tr>
<td>9</td>
<td>Main link lane 1+</td>
<td>19</td>
<td>Return</td>
</tr>
<tr>
<td>10</td>
<td>Main link lane 0–</td>
<td>20</td>
<td>+3.3 V power supply</td>
</tr>
</tbody>
</table>
### Ethernet/HDBaseT Port (RJ-45)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxD+/HDBT0+</td>
</tr>
<tr>
<td>2</td>
<td>TxD−/HDBT0−</td>
</tr>
<tr>
<td>3</td>
<td>RxD+/HDBT1+</td>
</tr>
<tr>
<td>4</td>
<td>Disconnection/HDBT2+</td>
</tr>
<tr>
<td>5</td>
<td>Disconnection/HDBT2−</td>
</tr>
<tr>
<td>6</td>
<td>RxD−/HDBT1−</td>
</tr>
<tr>
<td>7</td>
<td>Disconnection/HDBT3+</td>
</tr>
<tr>
<td>8</td>
<td>Disconnection/HDBT3−</td>
</tr>
</tbody>
</table>

### USB Port (Type A)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>V_{BUS}</td>
</tr>
<tr>
<td>2</td>
<td>D−</td>
</tr>
<tr>
<td>3</td>
<td>D+</td>
</tr>
<tr>
<td>4</td>
<td>Grounding</td>
</tr>
</tbody>
</table>

### RS-232C terminal (PC control) (D-Sub 9 Pin)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unused</td>
</tr>
<tr>
<td>2</td>
<td>Transmission data</td>
</tr>
<tr>
<td>3</td>
<td>Reception data</td>
</tr>
<tr>
<td>4</td>
<td>Connection/Pin 6</td>
</tr>
<tr>
<td>5</td>
<td>Grounding</td>
</tr>
<tr>
<td>6</td>
<td>Connection/Pin 4</td>
</tr>
<tr>
<td>7</td>
<td>Unused</td>
</tr>
<tr>
<td>8</td>
<td>Unused</td>
</tr>
<tr>
<td>9</td>
<td>Unused</td>
</tr>
</tbody>
</table>

### Communications protocol
### 3D connector (D-sub 15 pin)

![3D connector Diagram]

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal Name</th>
<th>I/O</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+12V</td>
<td>PWR</td>
<td>Supplies power (+12V) to the 3D image system</td>
</tr>
<tr>
<td>2</td>
<td>GNDC</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>3</td>
<td>GNDC</td>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>reserved</td>
<td>IN</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>reserved</td>
<td>OUT</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>reserved</td>
<td>OUT</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CONN_SYNC+</td>
<td>OUT</td>
<td>3D L/R switching timing signal (+) (Connects to the collector of the output transistor of the photo coupler inside the projector)</td>
</tr>
<tr>
<td>8</td>
<td>reserved</td>
<td>IN</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>+12V</td>
<td>PWR</td>
<td>Supplies power (+12V) to the 3D image system</td>
</tr>
<tr>
<td>10</td>
<td>reserved</td>
<td>IN</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>reserved</td>
<td>IN</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>reserved</td>
<td>IN</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>reserved</td>
<td>OUT</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>CONN_SYNC−</td>
<td>OUT</td>
<td>3D L/R switching timing signal (−) (Connects to the emitter of the output transistor of the photo coupler inside the projector)</td>
</tr>
<tr>
<td>15</td>
<td>N/C</td>
<td>—</td>
<td>Unused</td>
</tr>
</tbody>
</table>
### GP I/O terminal (External control) (D-sub 37 pin)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal Name</th>
<th>I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>reserved</td>
<td>IN</td>
</tr>
<tr>
<td>2</td>
<td>reserved</td>
<td>IN</td>
</tr>
<tr>
<td>3</td>
<td>reserved</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>EXT_GPIN1+ (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>5</td>
<td>EXT_GPIN2+ (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>6</td>
<td>EXT_GPIN3+ (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>7</td>
<td>EXT_GPIN4+ (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>8</td>
<td>GOUT1+ (External 3D L/R Output Reference +)</td>
<td>OUT</td>
</tr>
<tr>
<td>9</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>10</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>11</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>12</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>13</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>14</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>15</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>16</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>17</td>
<td>NC (not connected)</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>GND</td>
<td>PWR</td>
</tr>
<tr>
<td>19</td>
<td>GND</td>
<td>PWR</td>
</tr>
<tr>
<td>20</td>
<td>reserved</td>
<td>IN</td>
</tr>
<tr>
<td>21</td>
<td>reserved</td>
<td>IN</td>
</tr>
<tr>
<td>22</td>
<td>reserved</td>
<td>IN</td>
</tr>
<tr>
<td>23</td>
<td>reserved</td>
<td>IN</td>
</tr>
<tr>
<td>24</td>
<td>EXT_GPIN1- (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>25</td>
<td>EXT_GPIN2- (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>26</td>
<td>EXT_GPIN3- (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>27</td>
<td>EXT_GPIN4- (Control)</td>
<td>IN</td>
</tr>
<tr>
<td>28</td>
<td>GOUT1- (External 3D L/R Output Reference -)</td>
<td>OUT</td>
</tr>
<tr>
<td>29</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>30</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>31</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>32</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>33</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>34</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>35</td>
<td>reserved</td>
<td>OUT</td>
</tr>
<tr>
<td>36</td>
<td>NC (not connected)</td>
<td>-</td>
</tr>
<tr>
<td>37</td>
<td>GND</td>
<td>PWR</td>
</tr>
</tbody>
</table>
Inside Projector

Resist = 360 Ω

Voltage applied across the pins of Ext_GPIN_P and Ext_GPIN_N should be in the range from 3.3 Vdc to 10 Vdc.
Recommended Operating Current: 5 mA
Absolute Maximum Rating: 23 mA

Using GPIO Control

Momentary “ON” pulse enables you to control projector. To enable “ON” pulse, hold it for at least 300 ms. Hold “OFF” for at least 300 ms before “ON”. (→ page 174)

Here is function list to control projector by using GPIO port.

<table>
<thead>
<tr>
<th>Pin No.:</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ext_GPIN_P</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ext_GPIN_N</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
</tr>
</tbody>
</table>

Using GPIO Control

- **Using GPIO Control**
  - Momentary “ON” pulse enables you to control projector. To enable “ON” pulse, hold it for at least 300 ms. Hold “OFF” for at least 300 ms before “ON”. (→ page 174)
  - Here is function list to control projector by using GPIO port.

Using GPIO Control

<table>
<thead>
<tr>
<th>Photo-coupler ON/OFF</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-27 7-26 6-25 5-24</td>
<td>The following functions apply depending on the combination of input terminals.</td>
</tr>
<tr>
<td>OFF OFF OFF ON</td>
<td>Power ON</td>
</tr>
<tr>
<td>OFF OFF ON OFF</td>
<td>Power OFF</td>
</tr>
<tr>
<td>OFF OFF ON ON</td>
<td>Shutter OFF</td>
</tr>
<tr>
<td>OFF ON OFF OFF</td>
<td>Shutter ON</td>
</tr>
<tr>
<td>OFF ON OFF ON</td>
<td>Select HDMI</td>
</tr>
<tr>
<td>OFF ON ON OFF</td>
<td>Select DisplayPort</td>
</tr>
<tr>
<td>OFF ON ON ON ON</td>
<td>Select BNC</td>
</tr>
<tr>
<td>ON OFF OFF Off</td>
<td>Select BNC(CV)</td>
</tr>
<tr>
<td>ON OFF OFF On</td>
<td>Select BNC(Y/C)</td>
</tr>
<tr>
<td>ON OFF On OFF</td>
<td>Select Computer</td>
</tr>
<tr>
<td>ON OFF On On</td>
<td>Select HDBaseT</td>
</tr>
<tr>
<td>ON On Off Off</td>
<td>Select SLOT</td>
</tr>
<tr>
<td>ON On Off On</td>
<td>reserved</td>
</tr>
<tr>
<td>ON On On Off</td>
<td>reserved</td>
</tr>
<tr>
<td>ON On On On</td>
<td>reserved</td>
</tr>
</tbody>
</table>

Example for turning off the power source (Shutter ON): Input ON to 6-25 and 5-24 while 8-27 and 7-26 are OFF.

**NOTE:**
- The operation command coming from GPIO port will be canceled when the projector is processing other tasks.
- Set all other pins than those in use to “OFF”.
- The operation command is executed upon continuous input of the “ON” pulse for approximately 300 ms.
Timing chart of GPIO control

Example of Select HDMI

Execute
Select HDMI

Off at least 300 ms

approx. 300 ms

at least 300 ms

5-24/7-26

on

off

on

off

6-25/8-27
## Troubleshooting

This section helps you resolve problems you may encounter while setting up or using the projector.

### Indicator Messages

#### POWER Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Power is off.</td>
<td></td>
</tr>
<tr>
<td>Flashing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blue (short flashes)</td>
<td>Preparing to turn power on</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Blue (long flashes)</td>
<td>Off timer (enabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Program timer (off time enabled)</td>
<td></td>
</tr>
<tr>
<td>Orange (short flashes)</td>
<td>Projector cooling</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Orange (long flashes)</td>
<td>Program timer (on time enabled)</td>
<td></td>
</tr>
<tr>
<td>Lit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Power on</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>Standby mode (NORMAL)</td>
<td></td>
</tr>
<tr>
<td>Orange</td>
<td>Standby mode (HDBaseT STANDBY)</td>
<td></td>
</tr>
</tbody>
</table>

#### STATUS Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flashing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red (once per cycle)</td>
<td>Problem with the cover</td>
<td>Check to make sure the front cover, top cover, side cover, and lens unit are all correctly fixed in place.</td>
</tr>
<tr>
<td>Red (3 times per cycle)</td>
<td>Power failure</td>
<td>Problem with the power system. Contact the NEC projector customer support center to arrange for repair.</td>
</tr>
<tr>
<td>Red (4 times per cycle)</td>
<td>Problem with the fan</td>
<td>Rotation of the cooling fan has stopped. Contact the NEC projector customer support center to arrange for repair.</td>
</tr>
<tr>
<td>Red (6 times per cycle)</td>
<td>Problem with the light source</td>
<td>Problem with the light source system. Contact the NEC projector customer support center to arrange for repair.</td>
</tr>
<tr>
<td>Red (9 times per cycle)</td>
<td>Hardware problem</td>
<td>Problem with the hardware. Contact the NEC projector customer support center to arrange for repair.</td>
</tr>
<tr>
<td>Lit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>STANDBY MODE in sleep mode*</td>
<td></td>
</tr>
<tr>
<td>Orange</td>
<td>Button has been pressed while projector is in key lock mode</td>
<td>The projector’s keys are locked. The setting must be canceled to operate the projector. (→ Page 28, 112)</td>
</tr>
<tr>
<td></td>
<td>Projector’s ID number and remote control’s ID number do not match</td>
<td>Check the control IDs. (→ Pages 113)</td>
</tr>
</tbody>
</table>

* Sleep mode refers to the state whereby the functional restrictions due to the standby mode setting are removed.
### LIGHT Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The light module is turned off.</td>
<td>–</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Transition to switch ON/OFF the light module</td>
<td>–</td>
</tr>
<tr>
<td>Lit Green</td>
<td>Light module lit</td>
<td>–</td>
</tr>
</tbody>
</table>

### TEMP. Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No problem</td>
<td></td>
</tr>
<tr>
<td>Flashing Red (cycles of 2)</td>
<td>Temperature problem</td>
<td>The temperature protector has been activated. If the room temperature is high, move the projector to a cool place. If the problem still persists, contact an NEC projector customer support center.</td>
</tr>
<tr>
<td>Lit Orange</td>
<td>High surrounding temperature (Forced ECO Mode)</td>
<td>The surrounding temperature is high. Lower the room temperature.</td>
</tr>
</tbody>
</table>

### SHUTTER Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Open shutter</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>[LENS CALIBRATION] in progress</td>
</tr>
<tr>
<td>Lit Green</td>
<td>Shutter closed</td>
</tr>
</tbody>
</table>

### KEY LOCK Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>[CONTROL PANEL LOCK] [OFF]</td>
</tr>
<tr>
<td>Lit Orange</td>
<td>[CONTROL PANEL LOCK] [ON]</td>
</tr>
</tbody>
</table>

---

**If the temperature protector is activated**

If the projector’s internal temperature rises abnormally, the light module turns off and the temperature indicator flashes (repeatedly in cycles of 2).

It may happen that the projector’s temperature protector is simultaneously activated and the projector’s power turns off. If this happens, do the following:

- Unplug the power cord from the power outlet.
- If using in a place where the surrounding temperature is high, move the projector to a different, cool place.
- If there is dust in the ventilation holes, clean. (→ page 146)
- Wait as such about 1 hour for the projector’s internal temperature to lower.
## Common Problems & Solutions

(→ “POWER/STATUS/LIGHT/TEMP/Shutter/KEY LOCK Indicator” on page 175, 176.)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Does not turn on or shut down                | • Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control is on. (→ pages 13, 14)  
• Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room where you are presenting is particularly warm, move the projector to a cooler location.  
• The light module may fail to light. Wait a full minute and then turn on the power again.  
• Set [FAN MODE] to [HIGH] when using the projector at highlands. Using the projector at highlands can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and turn on the projector. (→ page 104)  
If you turn on the projector immediately after the light module is turned off, the fans run without displaying an image for some time and then the projector will display the image. Wait for a moment.  
• In case it’s hard to think the trouble is not caused on the above mentioned conditions, unplug the power cord from the outlet. Then wait 5 minutes before plugging it in again. (→ page 26) |
| Will turn off                                 | • Ensure that the [OFF TIMER], [AUTO POWER OFF] or [PROGRAM TIMER] is off. (→ page 108, 123)                                                                                                                                                                                                                                                                         |
| No picture                                   | • Check if the appropriate input is selected. (→ page 18) If there is still no picture, press the SOURCE button or one of the source buttons again.  
• Ensure your cables are connected properly.  
• Use menus to adjust the brightness and contrast. (→ page 82)  
• Is the [POWER ON SHUTTER] in the on-screen menu set to [CLOSE]?  
• Check that the SHUTTER (lens shutter), the LIGHT SOURCE, or AV MUTE (image off) buttons are not pressed.  
• Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 124)  
• Enter your registered keyword if the Security function is enabled. (→ page 37)  
• If the HDMI IN or the DisplayPort IN signal cannot be displayed, try the following.  
  - Reinstall your driver for the graphics card built in your computer, or use the updated driver.  
  For reinstalling or updating your driver, refer to the user guide accompanied with your computer or graphics card, or contact the support center for your computer manufacturer.  
  - Install the updated driver or OS on your own responsibility.  
  We are not liable for any trouble and failure caused by this installation.  
• Signals may not be supported depending on the HDBaseT transmission device. IR and RS232C cannot be used in certain cases as well.  
• Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.  
In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  
* If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power management software.  
• See also the page 179. |
| Picture suddenly becomes dark                 | • Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 104) |
| Color tone or hue is unusual                  | • Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 104)  
• Adjust [HUE] in [PICTURE]. (→ page 83)                                                                                                                                                                                                                                                                       |
| Image isn’t square to the screen             | • Reposition the projector to improve its angle to the screen. (→ page 20)  
• Use the Keystone correction function to correct the trapezoid distortion. (→ page 34)                                                                                                                                                                                                                     |
| Picture is blurred                           | • Adjust the focus. (→ page 24)  
• Reposition the projector to improve its angle to the screen. (→ page 20)  
• Ensure that the distance between the projector and screen is within the adjustment range of the lens. (→ page 156)  
• Has the lens been shifted by an amount exceeding the guaranteed range? (→ page 158)  
• Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. Should this happen, let the projector stand until there is no condensation on the lens. |
| Image is scrolling vertically, horizontally or both | • Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported by the projector. (→ page 161)  
• Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 85)                                                                                                                                                                                                 |

9. Appendix

177
<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote control does not work</td>
<td>• Install new batteries. (→ page 10)</td>
</tr>
<tr>
<td></td>
<td>• Make sure there are no obstacles between you and the projector.</td>
</tr>
<tr>
<td></td>
<td>• Stand within 42.21 ft (15 m) of the projector. (→ page 11)</td>
</tr>
<tr>
<td>Indicator is lit or blinking</td>
<td>• See the POWER/STATUS/LIGHT/TEMP/SHUTTER/KEY LOCK Indicator. (→ page 175, 176)</td>
</tr>
<tr>
<td>Cross color in RGB mode</td>
<td>• Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 25)</td>
</tr>
<tr>
<td></td>
<td>• Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 84)</td>
</tr>
</tbody>
</table>

For more information contact your dealer.
If there is no picture, or the picture is not displayed correctly.

• Power on process for the projector and the PC.

Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.

In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.

*NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, this means there is no signal being output from the computer. (→ page 125 or go to next step)

• Enabling the computer’s external display.

Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

• Non-standard signal output from the computer

If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. Refer to your computer’s documentation for detailed information.

• Image displayed is incorrect when using a Mac

When using a Mac with the projector, set the DIP switch of the Mac adapter (not supplied with the projector) according to your resolution. After setting, restart your Mac for the changes to take affect.

For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to the 13” fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then restart the Mac again.

*NOTE: A Video Adapter cable manufactured by Apple Computer is needed for a MacBook which does not have a mini D-Sub 15-pin terminal.

• Mirroring on a MacBook

* When using the projector with a MacBook, output may not be set to 1024 × 768 unless “mirroring” is off on your MacBook. Refer to owner’s manual supplied with your Mac computer for mirroring.

• Folders or icons are hidden on the Mac screen

Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple menu and arrange icons.
### PC Control Codes and Cable Connection

#### PC Control Codes

<table>
<thead>
<tr>
<th>Function</th>
<th>Code Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER ON</td>
<td>02H 00H 00H 00H 02H</td>
</tr>
<tr>
<td>POWER OFF</td>
<td>02H 01H 00H 00H 03H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI</td>
<td>02H 03H 00H 00H 02H 01H A1H A9H</td>
</tr>
<tr>
<td>INPUT SELECT DisplayPort</td>
<td>02H 03H 00H 00H 02H 01H A6H AEH</td>
</tr>
<tr>
<td>INPUT SELECT BNC</td>
<td>02H 03H 00H 00H 02H 01H 02H 0AH</td>
</tr>
<tr>
<td>INPUT SELECT BNC(CV)</td>
<td>02H 03H 00H 00H 02H 01H 06H 0EH</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER</td>
<td>02H 03H 00H 00H 02H 01H 08H 13H</td>
</tr>
<tr>
<td>INPUT SELECT HDBaseT</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT SLOT</td>
<td>02H 03H 00H 00H 02H 01H 0BH 13H</td>
</tr>
<tr>
<td>PICTURE MUTE ON</td>
<td>02H 00H 00H 00H 00H 12H</td>
</tr>
<tr>
<td>PICTURE MUTE OFF</td>
<td>02H 11H 00H 00H 00H 13H</td>
</tr>
</tbody>
</table>

**NOTE:** Contact your local dealer for a full list of the PC Control Codes if needed.

#### Cable Connection

**Communication Protocol**

- Baud rate: 38400 bps
- Data length: 8 bits
- Parity: No parity
- Stop bit: One bit
- X on/off: None
- Communications procedure: Full duplex

**NOTE:** Depending on the equipment, a lower baud rate may be recommended for long cable runs.

#### PC Control Terminal (D-SUB 9P)

![Diagram of PC Control Terminal (D-SUB 9P)]

**NOTE 1:** Pins 1, 4, 6 and 9 are no used.

**NOTE 2:** Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

**NOTE 3:** For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.
# Appendices

## Troubleshooting Check List

Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem more efficiently.

* Print this page and the next page for your check.

### Frequency of occurrence

- □ always
- □ sometimes (How often? ______________________)  □ other (______________)

### Power

- □ No power (POWER indicator does not light blue). See also “Status Indicator (STATUS)”.
  - □ Power cord’s plug is fully inserted into the wall outlet.
  - □ The main power switch is in the “ON (I)” position.

- □ Shut down during operation.
  - □ Power cord’s plug is fully inserted into the wall outlet.
  - □ [AUTO POWER OFF] is turned off (only models with the [AUTO POWER OFF] function).
  - □ [OFF TIMER] is turned off (only models with the [OFF TIMER] function).

### Video and Audio

- □ No image is displayed from your PC or video equipment to the projector.
  - □ Still no image even though you connect the projector to the PC first, then start the PC.
  - □ Enabling your notebook PC’s signal output to the projector.
    - □ A combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys turns the external display on or off.
  - □ No image (blue or black background, no display).
  - □ Still no image even though you press the AUTO ADJUST button.
  - □ Still no image even though you carry out [RESET] in the projector’s menu.
  - □ Signal cable’s plug is fully inserted into the input terminal
  - □ A message appears on the screen.
    - □ The source connected to the projector is active and available.
  - □ Input source’s resolution and frequency are supported by the projector.
  - □ Image is too dark.
  - □ Remains unchanged even though you adjust the brightness and/or the contrast.
  - □ Image is distorted.
  - □ Image appears to be trapezoidal (unchanged even though you carry out the [KEYSTONE] adjustment).

- □ Parts of the image are lost.
  - □ Still unchanged even though you press the AUTO ADJUST button.
  - □ Still unchanged even though you carry out [RESET] in the projector’s menu.

- □ Image is shifted in the vertical or horizontal direction.
  - □ Horizontal and vertical positions are correctly adjusted on a computer signal.
  - □ Input source’s resolution and frequency are supported by the projector.
  - □ Some pixels are lost.
  - □ Image is flickering.
  - □ Still unchanged even though you press the AUTO ADJUST button.

- □ Still unchanged even though you checked the signal’s resolution on PC and changed it to projector’s native resolution.
  - □ Still unchanged even though you adjusted the focus.

- □ Image is too dark.
  - □ Remains unchanged even though you adjust the brightness and/or the contrast.

- □ Image is distorted.
  - □ Image appears to be trapezoidal (unchanged even though you carry out the [KEYSTONE] adjustment).

### Other

- □ Remote control does not work.
  - □ No obstacles between the sensor of the projector and the remote control.
  - □ Projector is placed near a fluorescent light that can disturb the infrared remote controls.
  - □ Batteries are new and are not reversed in installation.

- □ Buttons on the projector cabinet do not work (only models with the [CONTROL PANEL LOCK] function)
  - □ [CONTROL PANEL LOCK] is not turned on or is disabled in the menu.
  - □ Still unchanged even though you press and hold the SOURCE button for a minimum of 10 seconds.
In the space below please describe your problem in detail.

Information on application and environment where your projector is used

**Projector**
- Model number:
- Serial No.:
- Date of purchase:
- Light module operating time (hours):
- Eco Mode: □ OFF □ ON

**Information on input signal:**
- Horizontal sync frequency [ ] kHz
- Vertical sync frequency [ ] Hz
- Sync polarity H □ (+) □ (−)
- V □ (+) □ (−)
- Sync type □ Separate □ Composite □ Sync on Green

**STATUS Indicator:**
- Steady light □ Orange □ Green
- Flashing light [ ] cycles

**Remote control model number:**

---

**Installation environment**
- Screen size: inch
- Screen type: □ White matte □ Beads □ Polarization □ Wide angle □ High contrast
- Throw distance: feet/inch/m
- Orientation: □ Ceiling mount □ Desktop
- Power outlet connection:
  □ Connected directly to wall outlet
  □ Connected to power cord extender or other (the number of connected equipment
  □ Connected to a power cord reel or other (the number of connected equipment

**Computer**
- Manufacturer:
- Model number:
- Notebook PC □ / Desktop □
- Native resolution:
- Refresh rate:
- Video adapter:
- Other:

**Video equipment**
- VCR, Blu-ray player, Video camera, Video game or other
- Manufacturer:
- Model number: